Software Distribution Reference
ZENworks. 11 Support Pack 3

July 2014

Novell



Legal Notices

Novell, Inc., makes no representations or warranties with respect to the contents or use of this documentation, and specifically
disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc.,
reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any
person or entity of such revisions or changes.

Further, Novell, Inc., makes no representations or warranties with respect to any software, and specifically disclaims any
express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., reserves the right
to make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of
such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the trade
laws of other countries. You agree to comply with all export control regulations and to obtain any required licenses or
classification to export, re-export or import deliverables. You agree not to export or re-export to entities on the current U.S.
export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use
deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. See the Novell International Trade
Services Web page (http://www.novell.com/info/exports/) for more information on exporting Novell software. Novell assumes
no responsibility for your failure to obtain any necessary export approvals.

Copyright © 2007 - 2014 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored
on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc.

1800 South Novell Place
Provo, UT 84606

U.S.A.

www.novell.com

Online Documentation: To access the latest online documentation for this and other Novell products, see the Novell
Documentation Web page (http://www.novell.com/documentation).

Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/
tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.


http://www.novell.com/info/exports/
http://www.novell.com/info/exports/
http://www.novell.com/documentation
http://www.novell.com/documentation
http://www.novell.com/company/legal/trademarks/tmlist.html

Contents

About This Guide 9
1 Basic Concepts 11
1.1 BUNAIES . . 11
1.2 BUNAIE GrOUP . . o ottt et e e e e e e e 12
1.3 ROlder. o 12
L4 ACHONS . .o o 12
1.5 ACHON SOl . . oot 13
151 DIstribUte . . .o 13

152 INStall . . 13

153 LaUNCN . . 15

154 VerifY .o 16

155 Uninstall. . ..o 16

156 TeIMINAle. . . ..ottt e 18

157  Preboot . ... 21

1.6 Assigning Bundles . . .. ... 22
1.7  Packaging ConsSiderations . . . . ... ottt e 22
1.7.1  Time Required for Packaging: . . . . ...t e e e e 22

1.7.2 Space Required for Packaging: . . .. ... .o 23

1.8 CONEN. . . o 24
181 Content RepliCation . . . . ... .t 24

1.8.2 Content DeliVery . . ... . 24

2 Creating Bundles 25
2.1  Creating LInUX BUNAIES . . . . ..o 25
2.2 Creating Macintosh Bundles . . ... ... .. 25
2.3 Creating Preboot Bundles . . .. ... . 30
2.4 Creating Windows Bundles . . . ... ... 30
2.5 Creating Bundles by Using the zman Command Line Utility . .. ............ .. ... .. ... ...... 43
251 Creatinga Simple Bundle . . ... 44

252 Creating a Bundle with Content and Dependency on AnotherBundle ................ 45

253 Understanding the zman Bundle XML File Format . . ........ ... ... ... ... .. ... .... 47

3 Viewing the Bundle Information 51
3.1 Understanding the Bundle Page . . ... ... .. 51
3.2  Bundle Summary Page . . ... 51
3.21 GeNEraAl . .. 52

3.2.2 Bundle Status . ... ... 55

3.2.3 MESSAgE LOG . ..ottt 56

3.24 Upcoming EVENtS. . . ..o 57

4 Managing Bundle Groups 59
4.1  Creating Bundle GroUPS. . . . ...ttt e e e e e e 59
4.2  Renaming or Moving Bundle GroUPS . . . . . ..ottt 60
4.3  Copying the System RequirementsofaBundle Group . .. .. ... ... . i i 61
4.4  Deleting @aBundle GroUp . . .. ..ottt 61

Contents 3



4

45 AddingaBundle to a GroUp. . . . ..ot e 61

4.6 Copying a Bundle Group to a CoNtent SEIVEN . . .. ..ttt e e e 62
Managing Folders 65
5.1 Creating Folders. . ... e 65
5.2  Renaming or Moving FOIdErS . . . ... oo 66
5.3 Deleting a Folder . ... ... 66
Actions 67
6.1  Action - Apply Personality . ... ... 68
6.1.1 GENeral . . 69
6.1.2 ReqUITEMENES . . . o 70
6.2 ACHON - COPY DIFECIONY . . . oot e e e 70
6.2.1 GeNEraAl . .. 71
6.2.2 ReQUIrEMENTS . . . e 73
6.3  AcCtion - Copy Files. . . ..o 73
6.3.1 General . ... 74
6.3.2 ReqUIrEMENTS . . . o 76
6.4  Action - Create/Delete DIreCLOry . . .. ... ..t e e e e 77
6.4.1 General ... 78
6.4.2 REQUINEMENES . . . e e 79
6.5  ACHON - Delay. . ...t 79
6.5.1 GENeral . . 79
6.5.2 ReqUITEMENES . . . o 80
6.6  Action - Display MeSSage. . . . . . ottt 80
6.6.1 GeNEraAl . .. 81
6.6.2 ReQUIrEMENTS . . . e 82
6.7  Action - Distribute Files . .. ... ... e 82
6.8 Action- Edit INIFile . .. ... . 82
6.8.1 GeNEral . .. 82
6.8.2 AdVanCed . ... 86
6.8.3 ReqUIrEMENTS . . .o e 87
6.9  Action - Edit TexXt File. . . ..o 87
6.9.1 GeNEraAl . .. 88
6.9.2 REQUINEMENES . . . e 89
6.10 ACHON - ENA PrOCESS . . . .ottt e e 89
6.10.1  GeNEral . ..ot e 90
6.10.2 REQUITEMENIS . . . .ttt et e e e e e 920
6.11 Action - File Removal. . . ... ... 91
B.11.1  General .. ... e 92
6.11.2 ReqUITEMENTS . . . .ot e 92
6.12 Action - Install Bundle . ... ... ... e 93
6.12.1  General . ... ... 93
6.12.2  ReqUIFEMENTS . . . .ottt e e 94
6.13 Action - InStall DireCtOry . . . . ot e 94
B.13.1  General .. ... . 95
6.13.2  REQUITEMENTS . ..ttt 98
6.14 Action - Install Files . . . ... .. 98
B.14.1  General ... e 99
6.14.2  ReQUITEMENTS . . ..ttt e e 102
6.15 Action - Install MSI . . . ... 102
B.15.1  General .. ... 104
6.15.2  ReqUITEMENTS . . . .ottt e e 106
6.16 Action - InStall MSP . . . ... 106
6.16.1  General . ... ... 107

ZENworks 11 SP3 Software Distribution Reference



6.17

6.18

6.19

6.20

6.21

6.22

6.23

6.24

6.25

6.26

6.27

6.28

6.29

6.30

6.31

6.32
6.33

6.34

6.35
6.36

6.16.2 ReqUIFEMENTS . . . ..t e 108

Action - Install Network MSI. . ... 109
6.17.1  General . ... e 110
6.17.2  ReqUIFEMENTS . . . .ot e e e 112
Action - Launch Bundle . ... ... e e e 112
6.18.1  General . ... e 113
6.18.2 REQUITEMENTS . ..ttt e 113
Action - Launch Java Application. . . . ... .. . 113
6.19.1  General . ... ..t e 114
6.19.2  REQUITEMENTS . ...ttt e 116
Action - Launch URL . .. ... e 116
6.20.1 General . ... e 117
6.20.2  REQUITEMENIS . . . .ttt e e e e 117
Action - Launch Executable . . . ... ... 117
6.21.1 General . ... e 118
6.21.2  AAVANCEA. . . . e 119
6.21.3  Launch OptioNS . . . ..t 120
6.21.4  REQUITEMENTS . ...ttt e 121
Action - Launch Macintosh Executable . .. ... ... ... . . . . i 121
6.22.1  GeNEral . ... 122
6.22.2  REQUITEMENIS . . . .ttt e e e e e 124
Action - Launch Windows Thin Client Application .. .......... ... 124
6.23.1  General . ... e 125
6.23.2  ReqUITEMENTS . . . .ottt e e 127
ACtioN - Prompt USer . . . oo 127
B.24.1 General . ... 128
6.24.2  ReqUITEMENTS . . . . ittt e e 129
Action - RebOOt/ShUutdOWN . . . . .. e e 129
6.25.1  General . ... e 130
6.25.2  REQUITEMENTS . ...ttt e e 131
Action - Registry Edit . . ... . e 131
B.26.1  GeNEral . . ... e 132
6.26.2  AAVANCEA . ... e 134
6.26.3  REQUITEMENIS . . . .ttt e e e e e 136
ACiON - RUN SCHIPt . . . e 136
B.27.1  General . ... e 136
6.27.2  ReqQUITEMENTS . . . .o e 142
ACHION - STart/Stop SEIVICE . . . . ..o e 142
B.28.1 General . ... 143
6.28.2  ReQUITEMENTS . . . .ot 143
Action - Store Personality. . . ... . 143
6.29.1  General ... e 144
6.29.2  REQUITEMENTS . ..ttt e e 145
Action - Terminate Application . . . . . ... 145
6.30.1  General . ... ... 145
6.30.2 REQUITEMENIS . . ..ttt e e e e e 146
Action - Terminate Application Prompt. . . . ... . e 146
B6.31.1 General . ... 147
6.31.2 ReqUIFEMENTS . . . .t e e e 148
Action - Undo Install ACHIONS . . . ... e 148
Action - Uninstall Bundle . ... e e 148
6.33.1  General . ... ... 149
6.33.2  ReQUITEMENTS . . . .ttt e e e 149
Action - Verify Bundle. . . ... . 149
B6.34.1  General . ... ... 150
6.34.2  REQUITEMENTS . ...ttt 150
Action - Verify Install ACHONS . . . ... .o 150
REQUITEMENES. . . .t e e e e e e 151

Contents

5



6

6.36.1 Filter ConditioNS. . . . . ..ot
6.36.2  Filter LOQIC . . . . ..ottt
6.36.3 Fail the action if these requirementsfail ............ ... ... ... . . . . . ..
7 Understanding Bundle Change Management
8 Managing Bundles
8.1 Bundle QUICK TasKS . . . ... e
8.1.1 Installinga Bundle . .. ... e
8.1.2 Launchinga Bundle. . ... ..
8.1.3 Uninstallinga Bundle. . ... ...
8.2  BUNAIE TaSKS . . . .ttt
8.2.1 Renaming, Copying, or Moving Bundles . .. ......... ...
8.2.2 Deletinga Bundle . .. ... .. ...
8.2.3 Preventing a Bundle from Being Deployed . . . ... . . . i
8.2.4 Enabling a Bundle to Be Deployed . . ... ...
8.2.5 Enabling Bundle Ordering . . . ...t e
8.2.6  Blocking a Bundle thatis AssignedtoaDevice. ... ...,
8.2.7  Blocking a Bundle thatis AssignedtoalUser ............ ...,
8.2.8 Uninstalling aBlocked Bundle . . .. .. ... ..
8.2.9 Unblocking a Bundle That has been Blocked fora Device . .......................
8.2.10 Unblocking a Bundle That has been Blocked foraUser..........................
8.3 Editing Bundle S. ... ... e
8.4 Bundle Change Management . . ... ...t e e
84.1 Understanding Bundle Versions . . ... e
8.4.2 Managing Bundle Versions . . ... i e e
8.4.3 Publishing Sandbox . .. ... .
8.5 Copying aBundle to a Content SEIVEr. . . ... ..ot
8.6  Bundle Behavior Based on Content Replication Settings . .............. ...
8.7 Dependency BUNIES. . . ... .
8.7.1 Primary Applications vs. Dependent Applications . .. ........... .. ... . ...
8.7.2 Bundle Chains . . .. ... e
8.7.3 Distributing, Installing, and Launching a Bundle That Has Dependencies ............
9 Managing Bundle Assignments
9.1 Assigning Existing Bundles to DeviCes . .. ... ... e
9.2  Assigning Existing Bundles to USers . . . ... ... e
9.3  Assigning a Bundle Group to DeVICES . . . ... ..ot
9.4  Assigning a Bundle Group to USErS. . . ... .t
9.5 Copying the Relationships of a Device to Other Devices, Folders, and Groups .. .............
10 Managing System Requirements
10.1 Adding System RequirementsforaBundle. .. ......... .. .
10.1.1  Filter ConditioNnS. . . .. oottt
10.1.2  FIter LOQIC . . . . .ot e e e
10.2 Copying a Bundle’s System RequUIrements . . ... ... ..ttt e
10.3 Copying a Bundle Group’s System Requirements. . . .. ... ...t
11 Managing Bundle Settings
11.1 Managing System Variables . ... ... ... e
11.2  Primary Server Replication . ... ... ..
11.3 Satellite Server Replication . . . . ... .. e

ZENworks 11 SP3 Software Distribution Reference

157

159

159
159
160
161
162
162
163
163
163
164
165
165
166
166
166
166
167
167
168
169
171
173
175
175
176
176

179

179
184
187
188
190

193

193

193
198
199

200



11.4 SandboX Settings. . . . ..o 203

11.5 End Point Throttle . .. ... e e e 204
11.6 Image Bundle Flag Settings. . . . . ..ottt 204

12 Managing Action and Action Sets 205
12,1 Managing ACHIONS. . . . ottt e 205
12.2  Modifying ACtION Set OPLIONS . . . . .o\t 207
12.2.1 Install Action Set OptioNS. . .. ..o i i e e 207

12.2.2  Launch Action SEt OPLIONS . .. ..t it 208

12.2.3  Uninstall Action SEt OptioNS . . ... ottt 209

12.2.4 Terminate Action Set OptionNs . . . ... ... e 211

13 Accessing Bundles on a Managed Device 213
13.1 Bundles vs. AppliCations . . . . ... . 213
13.2 User-Assigned vs. Device-Assigned Bundles . . ... ... .. e 214
13.3  Accessing BUNAIES. . . ... e 214
13.3.1  ZENWOrkS WINAOW . . . ..o e 214

13.3.2  ZENWOIKS EXPIOrer . . ..o e 217

13.3.3  ZENWOIKS ICON . . oo e 218

13.4 Understanding Bundle ICONS . . .. .. .. 218
13,5 Launchinga Bundle . .. ... e e 219
13.6 Postponing a Bundle Download. . . . ... ... . 220
13.7 Verifying a Bundle . .. ... 220
13.8 Viewing a Bundle’s Properties . . . .. ... 220
13.9 Uninstalling a Bundle . . . ... .. 221

A Install, Uninstall, and Repair MSI Bundle Parameters 223
Al Install Parameters . .. ... .. e 223
ALl Restart OptioNS . . ... e 224

A12  Display OpltioNS . . . ...t e 224

AL3  Install OplioNS . . . .. e 225

Al4 Command Line Parameters. . .. ...ttt e 225

A2 Uninstall Parameters . .. ... 225
A2.1 ReStart OptioNS . ... e 226

A2.2  Display OpLioNS . . ..o ot 226

A.2.3 Command Line Parameters. . . ........... ..t e 227

A3 Repair Parameters. . . ... 227
A3l Restart OptioNS . .. ... e 228

A.3.2  Display OplioNS . . . ...t e 228

A.3.3  Repair OptioNS. . .. e 228

A3.4 Command Line Parameters. . .. ...ttt e 229

B Authentication Hook 231
C How Bundle Versions Affect an Install Action Set 233
C.1 Triggers that Cause an Install Action SettoRun . . ... ... . . . i 233
C.2  SAmPIE SCENAIIO . . . . v oottt e e e e e 233
C.3  Additional SCENAIIOS . . ..ottt 234

D Best Practices 237
D.1  Changing the Look and Feel of the Start Menu on a Windows Vista Device.................. 237

Contents 7



8

D.2
D.3
D.4
D.5
D.6

Pinning Applications to the Start Menu on a Windows VistaDevice . .......................
Assigning Bundlesto a Device Or USEr . .. ... .t
ZENworks Explorer Folder Naming CONVENtioN. . ... ...ttt e e
Creating Bundles with Large Content . . ...t e
Enabling the Loading of Application Data in to the Device Memory on Demand. . .............

E Troubleshooting

F Novell ZENworks File Upload Plug-in

F.1

F.2

F.3

Installing the Novell ZENworks File Upload Plug-in. . .......... .. i e
F.LL1 OnWINAOWS DEVICES. . . . v vt ittt e ettt e e e e e e
F.1.2 ON LINUX DEVICES. . . . oo e e
F.1.3  Supported Features. . . ... ..
F.1.4  Browser Configurations . . . .. ... .. e
Uninstalling the Novell ZENworks File Upload plug-in . .......... ... i
F.2.1 ON WINAOWS . . ..ot e e
F.2.2 ON LINUX .« ottt e e e e
Reinstalling the Novell ZENworks File Upload plug-in. . ........... ... . ..

G Documentation Updates

ZENworks 11 SP3 Software Distribution Reference

239

249

249
249
250
250
250
252
252
252
252

253



About This Guide

This ZENworks 11 SP3 Software Distribution Reference includes conceptual and task-based information
to help you effectively manage software distribution in your Novell ZENworks 11 SP3 system. This
guide is organized as follows:

¢ Chapter 1, “Basic Concepts,” on page 11

¢ Chapter 2, “Creating Bundles,” on page 25

¢ Chapter 3, “Viewing the Bundle Information,” on page 51

¢ Chapter 4, “Managing Bundle Groups,” on page 59

¢ Chapter 5, “Managing Folders,” on page 65

¢ Chapter 6, “Actions,” on page 67

¢ Chapter 7, “Understanding Bundle Change Management,” on page 157

¢ Chapter 8, “Managing Bundles,” on page 159

¢ Chapter 9, “Managing Bundle Assignments,” on page 179

¢ Chapter 10, “Managing System Requirements,” on page 193

¢ Chapter 11, “Managing Bundle Settings,” on page 201

¢ Chapter 12, “Managing Action and Action Sets,” on page 205

¢ Chapter 13, “Accessing Bundles on a Managed Device,” on page 213

¢ Appendix A, “Install, Uninstall, and Repair MSI Bundle Parameters,” on page 223

¢ Appendix B, “Authentication Hook,” on page 231

¢ Appendix C, “How Bundle Versions Affect an Install Action Set,” on page 233

¢ Appendix D, “Best Practices,” on page 237

¢ Appendix E, “Troubleshooting,” on page 239

¢ Appendix F, “Novell ZENworks File Upload Plug-in,” on page 249

¢ Appendix G, “Documentation Updates,” on page 253

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Additional Documentation
ZENworks 11 SP3 is supported by other documentation (in both PDF and HTML formats) that you

can use to learn about and implement the product. For additional documentation, see the ZENworks
11 SP3 documentation Web site (http://www.novell.com/documentation/zenworks113)
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1.1

Basic Concepts

Novell ZENworks provides great flexibility in distributing software. You can distribute applications
and individual files, or simply make modifications to existing files on a device.

The following sections contain additional information that is important as you begin creating and
managing bundles to distribute software:

¢ Section 1.1, “Bundles,” on page 11

¢ Section 1.2, “Bundle Group,” on page 12

¢ Section 1.3, “Folder,” on page 12

¢ Section 1.4, “Actions,” on page 12

¢ Section 1.5, “Action Sets,” on page 13

¢ Section 1.6, “Assigning Bundles,” on page 22

¢ Section 1.7, “Packaging Considerations,” on page 22

¢ Section 1.8, “Content,” on page 24

Bundles

Bundles are used to configure and manage applications and to distribute software. A bundle consists
of all the files, configuration settings, installation instructions, and so forth required to deploy and
manage the application or files on a device.

Bundles are categorized into various types based on the device operating system and the
functionality required.

You can use ZENworks Control Center or the zman command line utility to create the following
bundles:
¢ Linux Bundle: Allows you to configure and manage applications on Linux devices.

¢ Linux Dependency Bundle: Allows the software packages to be available on Linux devices to
resolve package dependencies.

¢ Macintosh Bundle: Allows you to configure and manage applications on Macintosh devices.

¢ Preboot Bundle: Allows you to perform a set of tasks on a managed or unmanaged device
before the operating system boots up on the device.

¢+ Windows Bundle: Allows you to configure and manage applications on Windows devices.
ZENworks also supports the following bundles:

¢ Patch Bundle: Allows you to deploy the patches on Windows devices. This bundle type is
created by the ZENworks Patch Management product.

¢ Linux Patch Bundle: Allows you to deploy the patches on Linux devices. This bundle type is
created by the ZENworks Patch Management product.

Basic Concepts 11
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1.2

1.3

1.4

To create a software bundle, you use the Create New Bundle Wizard in ZENworks Control Center or
you use the zman command line utility. For more information on using ZENworks Control Center,
see Chapter 2, “Creating Bundles,” on page 25 and for information on using the zman command line
utility, see “ZENworks Command Line Utilities” in the ZENworks 11 SP3 Command Line Utilities
Reference.

The sections in this guide provide conceptual and task-based information to help you effectively
manage software distribution in your ZENworks system. You can also use the online Help system for
information about creating bundles.

Bundle Group

A bundle group lets you logically group the bundles. You can add bundles as members of a bundle
group. Creating bundle groups eases administration efforts by letting you assign the group, rather
than each individual bundle, to devices and users. For more information on bundle groups, see
Chapter 4, “Managing Bundle Groups,” on page 59.

Folder

A folder is an organizational object. You can use folders to structure your bundles and bundle groups
into a manageable hierarchy. For example, you might want a folder for each type of bundle (Linux
Bundles folder, Windows Bundles folder, Preboot Bundles folder, and so forth). Or, if applications are
department- specific, you might want a folder for each department (Accounting Department folder,
Payroll Department folder, and so forth).

Actions

An action is a part of an activity that is carried out during application management. Actions enable
you to perform tasks such as copying files, creating directories, and installing files on managed
devices. For more information, see “Actions” on page 67.

To Create an action during the bundle creation process: In the Bundle Creation Wizard, select the
bundle category based on the action that you want to add to the bundle. For more information, see
“Creating Bundles” on page 25.

To Create an action after a bundle is created:

1 On the Bundles page, click the Actions tab

2 Click the relevant action set tab (Distribute, Install, Launch, Verify, Uninstall, Terminate, or
Preboot).

3 Click the Add drop-down list, and then select the action you want. For more information, see
“Actions” on page 67

ZENworks 11 SP3 Software Distribution Reference
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1.5.2

Action Sets

Action sets help users manage the application, based on the operations performed during application
lifecycle management.You can group actions under various action sets.

The Actions panel displays the action sets available for the selected bundle.You can use the following
action sets, based on the bundle type:

¢ Section 1.5.1, “Distribute,” on page 13

¢ Section 1.5.2, “Install,” on page 13

¢ Section 1.5.3, “Launch,” on page 15

¢ Section 1.5.4, “Verify,” on page 16

*

Section 1.5.5, “Uninstall,” on page 16
¢ Section 1.5.6, “Terminate,” on page 18
¢ Section 1.5.7, “Preboot,” on page 21
The Distribution, Install, and Launch action sets run in sequence, when a bundle runs.The order of

execution is as follows: Distribute, Install and Launch. The Verify, Uninstall, and Terminate action
sets are performed based on user requests through bundle options.

Distribute

The Distribute action set distributes the content associated with all bundle actions. Within this action
set, the default action of Distribute Files distributes the content. The actions that can have content are
Install MS], Install MSP, Install RPM, Install Files, Install Directory, and Run Script.

You can add actions to this action set, in addition to the default action of Distribute Files. The added
actions are executed only after the default action is executed.

When you create or modify a bundle, you can click Add on the Distribute page to configure actions to
be performed after the distribution of content. Some of the available actions include Launch
Executable, Launch Java Application, Prompt User, and Run Script.

The distribution of the content for each assignment is managed through the distribution . For
information about the distribution , see Step 5 on page 181.

Install

The Install action set installs the application associated with the bundle. When you create or modify a
bundle, you can click Add on the Install page to configure actions associated with the installation
activities of an application. Some of the frequently used actions associated with installation activities
include Install MSI, Install MSP, Install Network MSI, Launch Executable, Run Script, and Install
RPM.

Some of the additional actions you can use during installation include Install Files, Install Directory,
Registry Edit, Edit INI File, Edit Text File, Start/Stop Service, End Process, and Reboot/Shutdown.

For more information about the Install actions, see Chapter 6, “Actions,” on page 67.
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Install Options

The Install Options dialog box allows you to specify how often the install actions associated with the
bundle are performed on the managed devices. If the install action set or its options are modified and
the bundle is re-published, then when the bundle is installed or launched, the install action set is
invoked again, even if it has been set to install only once.

1 When you create or modify a bundle, click Options on the Install page.

Install Options

—Install Frequency

@ Install once per device
O Install once per user per device
O Install always

—User Download Options

Actions allowed when content is being downloaded:

O always allow postpones

O Mever allow postpones

=]
® Limit postpones to [EI

OK | | Cancel

2 Select the Install Frequency, based on the number of times you want to execute the Install action
set:

Install once per device: Executes the Install action set only once on the managed device.
Configuration changes in the action set result in re-execution of this action set.

Install once per user per device: Executes the Install action sets once for each user on each
managed device. This option is applicable only for Windows devices.

Install always: Executes the Install action set each time the bundle runs.

3 Select Download Options to specify whether to allow users to postpone performing the Install
actions of the bundle and to specify the number of allowed postponements:

¢ Always allow postpones: Allows the user to postpone the installation any number of
times.

¢ Never allow postpones: Prevents the user from postponing the installation.

¢ Limit postpones to: Specify the number of times that the user can postpone the installation.

You manage the execution of the Install action set for each assignment through the Install Immediately
after Distribution option in the Bundle Distribution dialog box.

.For information about the distribution, see “Distribution Schedule:” on page 181.
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1.5.3

Launch

You use the Launch action set to launch an application that is associated with the bundle. When you
create or modify a bundle, you can click Add on the Launch page to configure actions that launch the
application. Some of the most frequently used actions associated with the launch activities include
Launch Executable, Run Script, Launch Java Application, and Launch Thin Client Application.

Launch Options

The Launch Options dialog box allows you to specify how often the Launch actions associated with
the bundle are performed on the managed devices. By default, the Launch actions occur based on the
bundle’s or when the user launches the bundle by using its shortcut from the application window,
desktop, and so forth). If the launch action set or its options are modified and the bundle is re-
published, then when the bundle is launched, the launch action set will be invoked again even if it
has been set to launch once.

1 When you create or modify a bundle, click Options on the Launch page to navigate to the Launch
Options dialog box.

| Launch Options

| C1 Run once:
for each device
for the first user that logs in
for every user that logs in

QK Cancel

2 Select the Run once check box to specify the bundle’s Launch actions. If you do not select this
option, the Launch actions are performed each time a user launches the application contained in
the bundle.

When you select the Run once check box, other Launch options are enabled.
Select the relevant Launch options:

¢ For each device: Select this option to launch the bundle’s actions once on each managed
device.

¢ For the first user that logs in: Select this option to launch the bundle’s actions once on each
managed device, when the first user logs in to that device. If subsequent users log in to the
device, the action set is not launched. When you select this option, the bundle’s icon is
removed from the device’s application window, desktop, and so forth.

This option is applicable only for Windows devices.

¢ For every user that logs in: Select this option to launch the bundle’s actions once for every
user that logs in to the device.

This option is applicable only for Windows devices.
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1.5.5

You manage the execution of the Launch action set for each assignment through the Launch or
through the Launch Immediately after Installation option in the bundle distribution . For information
about the Distribution , see “Distribution Schedule:” on page 181.

Verify

You use the Verify action set to verify the installation of a specific application. When you execute this
action set, the default action of Verify Install Actions triggers the execution of the Install and Launch
action sets.

You can add actions such asVerify Bundle to this action set in addition to the default Verify Install
Actions. The added actions are executed only after the default action is executed.

NOTE: The Verify action set has no options.

Uninstall

You use the Uninstall action set to un install an application. When you execute this action set, the
install operations of the Install action set are reversed by the default uninstall action of Undo Install
Actions.

You can add actions such as Uninstall Bundle to this action set, apart from the default action Undo
Install Actions. The added actions are executed only after the default action is executed.

Uninstall Options

You can enable the user on the managed device to uninstall the application.You specify the details in
the Uninstall Options dialog box:

1 When you create or modify a bundle, click Options on the Uninstall Page to navigate to the
Uninstall Options dialog box.
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| Uninstall Options

L] Enable Uninstall

— User Options

Allowy user to perform uninstall
Display message to the user before uninstalling the application
Allowy user to cancel the uninstallation of the application

—Blocked Assignment Options

Uninstall application

— Other Options

. e s [ danys
Uninstall application if not used within il
lgnore chained dependencies
Do not uninstall application on unassignment
0K | | Cancel

2 Select the Enable Uninstall check box to enable the uninstallation of the application from the
device.

For example, if a bundle is already installed on a device, you can select Enable Uninstall to
uninstall the bundle from the device.

The other uninstall options are enabled only when you select the Enable Uninstall check box.
3 Select the Uninstall options:

1. Select one of the following options to specify if the user should be allowed to uninstall or
cancel the uninstallation of an application on a device by choosing one of the following:

¢ Allow user to perform uninstall: Enables users to remove the application from their
devices.

¢ Display message to the user before uninstalling the application: displays a message
to the warn the user that the application will be uninstalled from the device.

This option is applicable only on Windows devices.

¢ Allow user to cancel the uninstallation of the application: Enables the user to cancel
the uninstallation of the application.

You can enable this option only if the Display message to the user before uninstalling the
application option is enabled. This option is applicable only on Windows device.

2. Under Blocked Assignment Options select Uninstall application to uninstall a blocked
application from the device.
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1.5.6

3. Select any additional uninstallation options that you want:

¢ Uninstall application if not used within _days :Automatically removes the
application, if it is not used within the specified number of days (the default period is

30 days).

¢ Ignore chained dependencies: Enables uninstallation of a dependent application that

is referenced by two or more applications.

For example, assume that there are three applications - A, B, and C- where C is the
dependent application, A installs application C, and application B uninstalls
application C. Application C is uninstalled only if Ignore Chained Dependencies is

selected.

¢ Do not uninstall application on unassignment: Prevents an application from being

uninstalled after it is unassigned from the device or user.

The Undo Install Actions option is available, only after you select Enable Uninstall in the Uninstall
Options dialog box. Click Undo Install Actions on the Uninstall page to go to the Undo Install Actions

dialog box.

| View Action - Undo Install Actions

Action Name: * I ; |
This task will unde all operations that are performed in the install action set. These
are the operations which will be reversed:
Hame Type State
Install GroupWWise2012beta Install Bundle Enabled
Install LibreOffice Install Bundle Enabled
Ciose |
Terminate

You use this action set to stop the execution of an application that is running because of actions in the
Launch action set. When you execute this action set, the launch operations are reversed by the default

Terminate Application action.

You can add actions to this action set, in addition to the default Terminate Application action. The

added actions are executed only after the default action.
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Terminate Options

The Terminate Options dialog box allows you to enable or disable the Terminate action set.

1 When you create or modify a bundle click Options on the Terminate page to go to the Terminate
Options dialog box.

| Terminate Options

Enable Terminate

| QK | | Cancel

2 Select the Enable Terminate check box to terminate the actions of the bundle.

The Terminate action set is applicable only for Windows bundles. This action set is enabled by
default.

The Terminate Application option is available only after you select the Enable Terminate check box
in the Terminate Options dialog box.
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| Edit Action - Terminate Application

Action Name: * [Tefrnhate Application |

General Requirements

This task will undo all operations that are performed in

the launch action set. These are the operations which
will be reversed:

Hame Type State
Launch LibreOffice Launch Bundle Enzbled
Launch Groupwise Launch Bundle Enabled

Notify the user of termination

Locale Prompt
No iems auailable.

{4n exanple of @ prompt might be: The machkine will reboot in 10 seconds. Please sowe your work
and close any open gpplications.)

Mate: Before performing the action, the message ahove will be disployed on devices to users that

are logged in. If @ message for @ spedi fic locale is not entered, a default English message will be
used.

Fields marked with an asterisk are required

Cancel

1. Click OK to undo all operations that are performed in the Launch action set.
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2. If you want to display a message to users before terminating an application, click Terminate

Application Prompt on the Terminate page to go to the Terminate Application Prompt dialog
box.

3. Specify the information you want users to see before terminating the application, then click
OK.

Edit Action - Terminate Application Prompt

Action Mame: * |Taminate Application Prompt

General Requirements
Seconds to be Displayed: |B0 g

I
; i =
Mumber of Ratries Allowed: ![I &

Prompt the user to save any unsaved data

Locale Prompt

Mo items available.

(4n example of ¢ prompt might ber The mackine will redoot in 10 seconds. Aegse Saue your work
& close any open applications.)

Note: Sefore performing the acion, the message ahove will be displaved on devices to wsers that

are logged in. ! f o message for o spedi fic locale iz not entered, o defouls Enalizh message will de
wsEd.

Fields marked with an asterisk are requirad.

1.5.7 Preboot

This action set is associated only with Preboot bundles and is not applicable for Windows or Linux
bundles. If you select a Preboot bundle, Preboot is the only action set available in the action panel.
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Bundles > Preboot oe -

¥ Preboot
Displayed version: | 0 (Published) ~
Summary Relationships Actions Settings

Preboot
fdd ~
Hame Type State Continue on Failure

Mo ifems selected, click add fo select items

1 When you create or modify a bundle, click Add on the Preboot page to configure the actions
associated with the Preboot bundle.

Some of the frequently used actions associated with the Preboot action set include AutoYaST Bundle,
DellDTK Configuration, Imaging Script, Kickstart, Linked Application Bundle, Multicast Image Set,
Third Party Image, and ZENworks Image. For more information about the Preboot actions, see
“Preboot Actions” in the Preboot Services and Imaging Reference guide.

1.6 Assigning Bundles

You can assign bundles to users and devices.When you assign a bundle to users, the bundle is
available to all assigned users regardless of the device they log on to. When you assign a bundle to a
device, the bundle is available to all users who log in to the assigned device.

For more information on assigning bundles and bundle groups to users and devices, see Chapter 9,
“Managing Bundle Assignments,” on page 179.

1.7 Packaging Considerations

Because of the way that ZENworks handles bundle packaging, be aware of the following
considerations when you create bundles:

¢ Section 1.7.1, “Time Required for Packaging:,” on page 22
¢ Section 1.7.2, “Space Required for Packaging:,” on page 23

1.7.1  Time Required for Packaging:

Large MSI and MSP bundles might take several hours to package before they are available on
ZENworks content servers (ZENworks Servers and Content Distribution Points) in your
Management Zone.

Large application files are compressed and encrypted, resulting in smaller bundles that reduce
bandwidth during transmission and provide greater security during transmission and on the content
server. The encrypted bundles cannot be removed from the content server and inappropriately used.
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1.7.2

Space Required for Packaging:

Creating bundles that contain content temporarily requires up to twice the amount of disk space as
the original files. The bundle creation process uploads copies of the original files from the local
machine to a temporary directory on the ZENworks content server. The process then packages those
files as encrypted, compressed ZENworks content files. After the ZENworks content files are created,
the original uploaded files are automatically deleted.

If you are using ZENworks Control Center to create the bundle, and if you do not log out correctly
(for example, if you close your browser before completing the Create New Bundle Wizard, you
browse to somewhere else, or your machine crashes), the temporary directory is automatically
cleared after the session time-out is reached. The default time out is 30 minutes.

In some circumstances (for example, if the ZENworks Server goes down during processing), the
bundle creation process is unable to delete these temporary files. You can manually delete them as
necessary.

Depending on the operating system and the utility used to create the bundle, the temporary files are
located in the following directories:

Table 1-1 Location of Temporary Files for Windows

Utility Used to Create the Location of the Temporary Files
Bundle

ZENworks Control Center zenworks home\share\tomcat\temp
zman (command line utility) zenworks home\work\content-repo\tmp

ZENworks Migration Utility =~ zenworks home\work\collection\datamodel

Table 1-2  Location of Temporary Files for Linux

Utility Used to Create Location of Temporary Files
Bundle

ZENworks Control Center /var/tmp/
zman (command line utility) /var/opt/novell/zenworks/content-repo/tmp/

ZENworks Migration Utility = /var/opt/novell/zenworks/collection/datamodel/

If the space on the temporary location is insufficient, you can specify a different disk drive to be the
location of temporary files.

For more information on changing the location of temporary files on a Windows device, see
“Changing the Location of the Temporary Location on a Windows Server” in the ZENworks 11 SP3
Primary Server and Satellite Reference.

For more information on changing the location of temporary files on a Linux device, see “Changing
the Location of the Temporary Location on a Linux Server” in the ZENworks 11 SP3 Primary Server and
Satellite Reference.
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1.8

1.8.1

1.8.2

Content

When you create bundles containing content, the content is copied to content servers (ZENworks
Servers or Content Distribution Points), replicated to other content servers, and delivered to
managed devices.

¢ Section 1.8.1, “Content Replication,” on page 24
¢ Section 1.8.2, “Content Delivery,” on page 24

Content Replication

Content replication lets you determine how often content (bundle and policy files) is updated on the
ZENworks (primary) Servers and Content Distribution Points. ZENworks Servers and Content
Distribution Points are collectively referred to as content servers when discussing them in their roles
of hosting content.

When a bundle or policy that contains content is added to the Management Zone, the ZENworks
database is updated to reflect the addition of the content. Content servers are responsible for
periodically reading the ZENworks database to discover new content. Each content server that does
not have the content then retrieves the content from the server where it resides.

If content has been removed from the Management Zone, each content server also removes obsolete
content during the update.

Content replication for a bundle can be configured through the Primary Server replication settings or
Satellite Server replication settings. For more information on the settings, see Chapter 11, “Managing
Bundle Settings,” on page 201.

For more information, see “Content Replication” in the ZENworks 11 SP3 Primary Server and Satellite
Reference.

Content Delivery

Content delivery, or distribution, refers to the process of transferring bundle and policy content from
a content server (ZENworks Server or Content Distribution Point) to a managed device.

There are a variety of settings you can use to determine how content is delivered to managed devices:
¢ You can set up Closest Server rules that determine from which content server a managed device
downloads its content.

¢ You can times, referred to as delivery blackout dates, when content cannot be downloaded by
managed devices.

* You can decide how often you want managed devices to look for new content to download.

For information about performing these tasks, see “Content Delivery” in the ZENworks 11 SP3
Primary Server and Satellite Reference.
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2.1

2.2

Creating Bundles

A bundle consists of all the files, configuration settings, installation instructions, and so forth
required to deploy and manage the application or files on a device.

Novell ZENworks lets you create bundles by using ZENworks Control Center or by using the zman
command line utility.

The following sections contain step-by-step instructions about creating bundles by using ZENworks
Control Center:

¢ Section 2.1, “Creating Linux Bundles,” on page 25

¢ Section 2.2, “Creating Macintosh Bundles,” on page 25
¢ Section 2.3, “Creating Preboot Bundles,” on page 30

¢ Section 2.4, “Creating Windows Bundles,” on page 30

The following section explains how to create bundles by using the zman command line utility:

¢ Section 2.5, “Creating Bundles by Using the zman Command Line Utility,” on page 43

Creating Linux Bundles

You can create two types of bundles on Linux devices - Linux bundles and Linux Dependency
bundles. Linux bundles allow you to configure, manage applications, and store the package updates
on Linux devices. Linux Dependency bundles allow you to distribute software to Linux devices and
provide the dependent packages.

For more information on how to create these bundles, see “Using Bundles for Linux Devices” in the
ZENworks 11 SP3 Linux Package Management Reference.

Creating Macintosh Bundles

Macintosh bundles allow you to configure, manage applications, and store the package updates on
Macintosh devices.

You can use ZENworks Control Center or the zman command line utility to create bundles. The
following procedure explains how to create a bundle using ZENworks Control Center. If you prefer
the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

To create a Macintosh bundle:

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
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Create New Bundle
<N Step 1: Select Bundle type

Select the type of Bundle you wish to create from the list of options.

Mew Bundle Type: Description:

Linux Bundle Macintosh Bundle - This allows yvou to canfigure and manage applications on
Linux Dependency Bundle tAacintosh devices,

hacintosh Bundle
Preboot Bundle
Windows Bundle

Hext > Cancel

3 Select Macintosh Bundle, then click Next to display the Select Bundle Category page.

Create New Macintosh Bundle
N Step 2: Select Bundle category

Select the category of Bundle wou wish to create from the list of options.

Mew Bundle Category: Description:
(Empty Bundle) - Select this option to create a bundle with no initial tasks.

Creat;’DeIete Directory
Install Directory
Install File(s)

<< Back Hext > Cancel

4 Select the desired bundle category:

Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create a
bundle without performing all of tasks in the Create New Bundle Wizard. After you create the
empty bundle, you can edit its details to add assignments, actions, and so forth, at a later time.

Create/Delete Directory: Creates or Deletes a directory on the managed device.

Install Directory: Uploads the contents of a directory and its sub-directories to the ZENworks
content system and then installs them to the specified destination path on the managed device.
By default, the content is replicated to all primary servers.

Install Files: Uploads the files to the ZENworks content system and then installs them to the
specified destination path on the managed device. By default, the content is replicated to all
primary servers.

Click Next to display the Define Details page, then fill in the fields:

Bundle Name: Provide a name for the bundle. The bundle name must be different than the
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The
name you provide displays in ZENworks Control Center and the ZENworks Adaptive Agent
(on managed devices).
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For more information, see “Naming Objects in ZENworks Control Center” in the ZENworks 11
SP3 ZENworks Control Center Reference.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the bundle to reside. The default path is the context from where the bundle creation wizard
is invoked. For example, if you choose to create a new bundle from the bundles page, the default
folder path is /bundles. However, if you choose to create a bundle from with a bundle folder
named folderl, the default folder path is /bundles/folderl. You can also create additional
folders to organize your bundles.

Icon: ZENworks Configuration Management lets you select an icon that users see during
installation of a particular bundle. This icon applies only to the icon displayed by ZENworks
Adaptive Agent on the managed device. ZCC uses default icons to represent the different
bundles (Linux, Macintosh, Preboot, and Windows).

To select an icon, click Browse, then browse to and select the icon you want to display on
managed devices.

If the desired icon is embedded in a .exe, .dl11, or .ico file that has multiple icons from which
to choose, you must install additional items before you can browse to and select the desired icon.

For Mozilla Firefox, if you have not already installed the Novell ZENworks File Upload plug-in
on this device, you must do so before you can download and install the download plugin or
browse to and upload the icon. For more information, see section Novell ZENworks File Upload
plug-in .

After you install the Novell ZENworks File Upload plug-in, you must also install the download
plugin. To do so, click the Click here to download plugin message box that displays in the Select
Icon dialog box (if you have already installed the plugin on this device, the plugin box does not
display), click Manual Install, then click Install Now.

For Microsoft Internet Explorer, you must install the Novell ZENworks File Upload ActiveX
control only; there is no download plugin for Internet Explorer. For more information, see
“Novell ZENworks File Upload Plug-in” on page 249.

After you have downloaded and installed the necessary extensions and plugin, click || to
browse to and select the icon you want ZENworks Adaptive Agent to display to represent the
bundle. If the icon in embedded in a .exe, .d11, or .ico file that contains multiple icons, an
additional dialog box displays to let you select the desired icon.

If you do not specify an icon, a default icon is used.

Description: Provide a short description of the bundle's contents. This description displays in
ZENworks Control Center and in the ZENworks Adaptive Agent.

Click Next, then skip to the appropriate step, depending on which bundle category you chose in
Step 4:

¢ Empty Bundle: Continue with Step 10 on page 30.

¢ Create/Delete Directory: Continue with Step 7 on page 27.
¢ Install Directory: Continue with Step 8 on page 28.

¢ Install Files: Continue with Step 9 on page 29.

(Conditional) If you are creating an Create/Delete Directory bundle, follow the wizard prompts
until you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field Details

Select Directory page > Select one of the following:

Action Type field + Create Directory: Creates a directory on the managed device

when the action is performed.

+ Delete Directory: Deletes a directory on the managed device
when the action is performed.

Select Directory page > Specify the complete path of the directory you want to create or delete
Directory Name field on the managed device.This path must be resolved by the device on
which the bundle is run.

8 (Conditional) If you are creating an Install Directory bundle, follow the wizard prompts until
you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Directory page > Click [@] to display the Select Directory dialog box. Browse to and
Source Directory field select the file to upload.

The Status field displays each file’s upload status.

Select the Upload all files within the source directory as a single
package option to enable all the files within the specified source
directory to be uploaded as a single content.

If the Novell ZENworks File Upload plug-in is not installed on this
device, it must be installed before you can browse to and upload files to
be copied. For more information, seeSection F.1, “Installing the Novell
ZENworks File Upload Plug-in,” on page 249.

Select Directory page > Specifies whether the content has been uploaded as a single content
Upload Files As field or multiple contents to the ZENworks content repository.

If the Upload all files within the source directory as a single package
option in the Select Directory dialog box is not selected, then the files
are uploaded by packaging in to multiple contents and the value of
Upload Files As option is displayed as Multiple Content.

If the Upload all files within the source directory as a single package
option in the Select Directory dialog box is selected, then the files are
uploaded by packaging in to single content and the value of Upload
Files As option is displayed as Single Content.

Select Directory page > Specify the destination path on the device where you want to install the
Destination Directory field directory.

Select Directory page > You can configure permissions and set the access for the directory that
Permissions field you have installed.

Mode: Select this option and enter a 3 digit octal number to specify the
permissions for owner, group, and others.

Owner: Select this option and set the access for Owner, Group, and
Others.
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Wizard Page and Field

Details

Select Directory page >
Ownership field

Select Directory page >
Copy Option

You can configure permissions and set the access for the directory that
you have installed.

Root: Select this option to provide the ownership for the root user.

User: Select this option to provide the ownership for a particular user.
You can also specify the group of the user.

Select a copy option from the list. For more information on the options,
click Help.

(Conditional) If you are creating an Install Files bundle, follow the wizard prompts until you

reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field

Details

Select Files page > File
field

Select Files page >
Destination Directory field

Select Directory page >
Permissions field

Select Directory page >
Ownership field

Select Files page >
Unpack field

Select Files page > Delete
After Unpack field

Select Files page > Copy
Option

Click Add to display the Select Files dialog box, specify the files you
want to install on the device, then click Open. Repeat this step as many
times as necessary to copy the desired files.

Click OK to upload the files to the server. The File option lists all the
uploaded files, the size of the files, and how the content is packaged.

If the Novell ZENworks File Upload plug-in is not installed on this
device, you must install it before you can browse for file paths. For
more information, see Section F.1, “Installing the Novell ZENworks File
Upload Plug-in,” on page 249.

Specify the destination directory on the device in which you want to
install the file.

You can configure permissions and set the access for the directory that
you have installed.

Mode: Select this option and enter a 3 digit octal number to specify the
permissions for owner, group, and others.

Owner: Select this option and set the access for Owner, Group, and
Others.

You can configure permissions and set the access for the directory that
you have installed.

Root: Select this option to provide the ownership for the root user.

User: Select this option to provide the ownership for a particular user.
You can also specify the group of the user.

Select this option to indicate that the files that are compressed in gzip,
bzip2, or zip formats should be decompressed and extracted on to the
device where you want to install them.

Select this option to indicate that the gzip, bzip2 or zip files should be
deleted after extracting them on to the device where you want to install
them.

Select a copy option from the list. For more information on the options,
click Help.
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2.3

2.4

10

11
12

13

14

1
2

Review the information on the Summary page, making any changes to the bundle settings by
using the Back button as necessary.

Skip to Step 13 to create the published version of the bundle.
(Conditional) Select the Create as Sandbox option to create a sandbox-only version of the bundle.

A sandbox-only version of a bundle enables you to test the bundle on your device before
actually deploying it. For more information on a sandbox-only bundle, see Chapter 7,
“Understanding Bundle Change Management,” on page 157.

(Conditional) Select the Define Additional Properties option to display the bundle’s Action page
after the wizard completes. You can use the various tabs to edit the bundle’s assignments,
system requirements, actions, settings, and content replication settings.

Click Finish to create the bundle as configured per settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, s,
and group membership. At some point in the future, you need to configure additional options
for the bundle by continuing with Section 9.1, “Assigning Existing Bundles to Devices,” on
page 179 or Section 9.2, “Assigning Existing Bundles to Users,” on page 184.

For information on the viewing the bundle information, see Chapter 3, “Viewing the Bundle
Information,” on page 51.

Creating Preboot Bundles

Preboot bundles let you performs operations before the operating system boots. The various Imaging
bundle types let you install images on one or more devices, or run ZENworks scripts containing any
commands that you can issue from the imaging bash prompt.

For more information about Imaging bundles, see the ZENworks 11 SP3 Preboot Services and Imaging
Reference.

Creating Windows Bundles

A Windows bundle lets you distribute a Microsoft* Windows Installer (MSI) package, Microsoft
Windows Software Patch (MSP) package, thin-client application, or other Windows-based
applications to a Windows device.

You can use ZENworks Control Center or the zman command line utility to create bundles. The
following procedure explains how to create a bundle using ZENworks Control Center. If you prefer
the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

To create a Windows bundle:

In ZENworks Control Center, click the Bundles tab.
In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
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Create New Bundle
% Step 1: Select Bundle type

Select the type of Bundle vou wish to create from the list of options.

New Bundle Type: Description:
Linux Bundle Windows Bundle - This allows you to configure and manage applications on
Linux Dependency Bundle Wiindows devices,

Macintosh Bundle
Freboot Bundle

Hext >> Cancel

3 Select Windows Bundle, then click Next to display the Select Bundle Category page.

Create New Windows Bundle
&N Step 2: Select Bundle category

Selact the category of Bundle you wish to create from the list of options.

Description:
(Empty Bundle)- Selact this option to create a bundle with no initial tasks.

|[Apply Personality

||Copy Directory

|[Copy File(s)
||[Create/Delete Directory
Install Directory

Install File(s)

|(MS! Application

[MSP Application

|[Simple Application

| Store Personality >l

[ ==Back | [ met> | [ _camcel |

4 Select the desired bundle category:

Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create a
bundle without performing all of tasks in the Create New Bundle Wizard. After you create the
empty bundle, you can edit its details to add assignments, actions, and so forth, at a later time.

Apply Personality: Applies the personality of one or more users on the managed device from a
personality file located on a local or network path.

Copy Directory: Copies a source directory to the specified location on the managed device.
Copy Files: Copies files to the specified location on the managed device.
Create/Delete Directory: Creates or Deletes a directory on the managed device.

Install Directory: Uploads the contents of a directory and its sub-directories to the ZENworks
content system and then installs them to the specified destination path on the managed device.
By default, the content is replicated to all primary servers.

Install Files: Uploads the files to the ZENworks content system and then installs them to the
specified destination path on the managed device. By default, the content is replicated to all
primary servers.
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MSI Application: An application that is packaged as a .ms1 file so that it can be installed by the
Microsoft Windows Installer program.

For important information about creating MSI Application bundles, see Section 1.7, “Packaging
Considerations,” on page 22.

If you have a non-MSI application that is more complex than this, we recommend that you use
ZENworks Software Packaging, powered by AdminStudio ZENworks Edition, to create an MSI
package for the application and then use the MSI Application option to create a bundle. For
more information on installing AdminStudio, see AdminStudiol0 SP2 ZENworks Edition
Installation Guide (https://svn.provo.novell.com/svn/documentation/zenworks/zenworks113/
frame/manuals/zz_3rdparty/AdminStudio_pdf/AS12InstallGuide.pdf).

MSP Application: An application patch that is packaged as a .msp file so that it can be applied
by the Microsoft Windows Installer program.

For important information about creating MSP Application bundles, see Section 1.7, “Packaging
Considerations,” on page 22.

Simple Application: An example of a Simple Application would be launching Windows Note
pad. Typically, Simple Applications requires ZENworks Adaptive Agent to copy a few files to
the workstation or make a few changes to the workstations registry, INI files, environment
variables, and so forth.

If you have a non-MSI application that is more complex than this, we recommend that you use
ZENworks Software Packaging, powered by AdminStudio ZENworks Edition, to create an MSI
package for the application and then use the MSI Application option to create a bundle. For
more information on installing AdminStudio, see AdminStudio 10 SP2 ZENworks Edition
Installation Guide (https://svn.provo.novell.com/svn/documentation/zenworks/zenworks113/
frame/manuals/zz_3rdparty/AdminStudio_pdf/AS12InstallGuide.pdf).

Store Personality: Stores the personality of one or more users on the managed device to a local
or network path.The personality files are not uploaded to the ZENworks content system.

Thin-Client Application: An application, running on a terminal server, that is accessed through
a terminal server client session (either RDP or ICA).

Web Application: An application that is launched by using a URL in a Web browser.
Click Next to display the Define Details page, then fill in the fields:

Bundle Name: Provide a name for the bundle. The bundle name must be different than the
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The
name you provide displays in ZENworks Control Center and the ZENworks Adaptive Agent
(on managed devices).

For more information, see “Naming Objects in ZENworks Control Center” in the ZENworks 11
SP3 ZENworks Control Center Reference.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the bundle to reside. The default path is the context from where the bundle creation wizard
is invoked. For example, if you choose to create a new bundle from the bundles page, the default
folder path is /bundles. However, if you choose to create a bundle from with a bundle folder
named folderl, the default folder path is /bundles/folderl. You can also create additional
folders to organize your bundles.

Icon: ZENworks Configuration Management lets you select an icon that users see during
installation of a particular bundle. This icon applies only to the icon displayed by ZENworks
Adaptive Agent on the managed device. ZCC uses default icons to represent the different
bundles (Linux, Preboot, and Windows).

To select an icon, click Browse, then browse to and select the icon you want to display on
managed devices.
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If the desired icon is embedded in a .exe, .dl11, or .ico file that has multiple icons from which
to choose, you must install additional items before you can browse to and select the desired icon.

For Mozilla Firefox, if you have not already installed the Novell ZENworks File Upload plug-in
on this device, you must do so before you can download and install the download plugin or
browse to and upload the icon. For more information, see Section F.1, “Installing the Novell
ZENworks File Upload Plug-in,” on page 249. After you install the Novell ZENworks File
Upload plug-in, you must also install the download plugin. To do so, click the Click here to
download plugin message box that displays in the Select Icon dialog box (if you have already
installed the plugin on this device, the plugin box does not display), click Manual Install, then
click Install Now.

For Microsoft Internet Explorer, you must install the Novell File Upload ActiveX control only;
there is no download plugin for Internet Explorer. For more information, see “Novell ZENworks
File Upload Plug-in” on page 249.

After you have downloaded and installed the necessary extensions and plugin, click [&] to
browse to and select the icon you want ZENworks Adaptive Agent to display to represent the
bundle. If the icon in embedded in a . exe, .d11, or .ico file that contains multiple icons, an
additional dialog box displays to let you select the desired icon.

If you do not specify an icon, a default icon is used.

NOTE: All icons for bundles need to have a color depth of 256. True color depth for icons is not
supported.

Description: Provide a short description of the bundle's contents. This description displays in
ZENworks Control Center and in the ZENworks Adaptive Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in
Step 4:

¢ Empty Bundle: Continue with Step 19 on page 43.

¢ Apply Personality: Continue with Step 7 on page 33.
¢ Copy Directory: Continue with Step 8 on page 34.

¢ Copy Files: Continue with Step 9 on page 34.

¢ Create/Delete Directory: Continue with Step 10 on page 35.
¢ Install Directory: Continue with Step 11 on page 35.
¢ Install Files: Continue with Step 12 on page 37.

¢ MSI Application: Continue with Step 13 on page 37.
¢ MSP Application: Skip to Step 14 on page 40.

¢ Simple Application: Skip to Step 15 on page 40.

¢ Store Personality: Skip to Step 16 on page 41.

¢ Thin Client Application: Skip to Step 17 on page 42.
+ Web Application: Skip to Step 18 on page 43.

7 (Conditional) If you are creating an Apply Personality bundle, follow the wizard prompts until
you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field

Details

Apply Personality page >
Upload a template from
this device field

Apply Personality page >
Specify a template on the
managed device field

Apply Personality page >
Path from where the PNP
file is to be loaded

Apply Personality page >
Password to decrypt the
PNP file field

Select this option and click |&] to display the Upload content dialog box.
Browse to and select the template to upload.

Select this option to specify the path of personality migration template
file on the managed device. You can also specify the UNC path of the
file.

Specify the path of the PNP file containing the migration settings and
data on the managed device. You can also specify the UNC path of the
file.

Select this check box to enter the password to decrypt the PNP file.

NOTE: If you spanned the PNP file, be sure to keep the spanned files
and the PNP file in the same folder.

8 (Conditional) If you are creating an Copy Directory bundle, follow the wizard prompts until you
reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field

Details

Select Directory page >
Source Directory field

Select Directory page >
Destination Directory field

Select Directory page >
Copy Option

Select Directory page >
Attributes field

If you have not installed the Novell ZENworks File Upload plug-in on
this device, you must do so before you can browse for a directory. For
more information, see Section F.1, “Installing the Novell ZENworks File
Upload Plug-in,” on page 249.

Click Browse to display the Browse for Folder dialog box. Browse to
and select the directory to copy.

Specify the destination path on the device where you want to copy the
directory.

Select a copy option from the list. For more information on the options,
click Help.

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is
hidden after being copied.

Read-only: Select the Read-only check box to specify that the
directory is read-only after being copied.

9 (Conditional) If you are creating an Copy Files bundle, follow the wizard prompts until you
reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field

Details

Select Files page > File
field

Select Files page >
Destination Directory field

Select Files page > Create
Shortcuts for Source Files

Select Files page > Copy
Option

Select Files page >
Attributes field

Click Add to display the Select Files dialog box, specify the files you
want to copy to the device, then click Open. Repeat this step as many
times as necessary to copy the desired files.

If the Novell ZENworks File Upload plug-in is not installed on this
device, you must install it before you can browse for file paths. For
more information, see Installing the Novell ZENworks File Upload Plug-
in.

Specify the destination directory on the device in which you want to
copy the file.

Select the Create Shortcuts for Source Files option to create shortcut
icons for the source file on the destination directory. The source files
are not copied to the destination directory.

Select a copy option from the list. For more information on the options,
click Help.

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the file is hidden
after being copied.

Read-only: Select the Read-only check box to specify that the file is
read-only after being copied.

(Conditional) If you are creating an Create/Delete Directory bundle, follow the wizard prompts
until you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field

Details

Select Directory page >
Action Type field

Select Directory page >
Directory Name field

Select one of the following:

+ Create Directory: Creates a directory on the managed device
when the action is performed.

+ Delete Directory: Deletes a directory on the managed device
when the action is performed.

Specify the complete path of the directory you want to create or delete
on the managed device.This path must be resolved by the device on
which the bundle is run.

(Conditional) If you are creating an Install Directory bundle, follow the wizard prompts until

you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field

Details

Select Directory page >
Source Directory field

Select Directory page >
Upload Files As field

Select Directory page >
Packaging field

Select Directory page >
Destination Directory field

Select Directory page >
Copy Option

Select Directory page >
Attributes field

Click [&] to display the Select Directory dialog box. Browse to and
select the file to upload. By default, the content is encrypted and
compressed before it is distributed to assigned devices. However, If
you do not want to compress or encrypt the content, select the Do not
compress or encrypt uploaded content option.

The Status field displays each file’s upload status.

Select the Upload all files within the source directory as a single
package option to enable all the files within the specified source
directory to be uploaded as a single content.

If the Novell ZENworks File Upload plug-in is not installed on this
device, it must be installed before you can browse to and upload files to
be copied. For more information, see Installing the Novell ZENworks
File Upload Plug-in.

Specifies whether the content has been uploaded as a single content
or multiple contents to the ZENworks content repository.

If the Upload all files within the source directory as a single package
option in the Select Directory dialog box is not selected, then the files
are uploaded by packaging in to multiple contents and the value of
Upload Files As option is displayed as Multiple Content.

If the Upload all files within the source directory as a single package
option in the Select Directory dialog box is selected, then the files are
uploaded by packaging in to single content and the value of Upload
Files As option is displayed as Single Content.

Specifies how the content is packaged before it is distributed to
assigned devices.

If the Do not compress or encrypt uploaded content option in the Select
Directory dialog box is not selected, the value of Packaging option is
initially displayed as Auto as the content is in the process of being
encrypted and compressed. After the content has been encrypted and
compressed, the value of Packaging option changes to Compressed,
Encrypted.

If the Do not compress or encrypt uploaded content option in the Select
Directory dialog box is selected, the value of Packaging option is
displayed as None because the content is neither compressed nor
encrypted.

Specify the destination path on the device where you want to install the
directory.

Select a copy option from the list. For more information on the options,
click Help.

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is
hidden after being copied.

Read-only: Select the Read-only check box to specify that the
directory is read-only after being copied.
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12 (Conditional) If you are creating an Install Files bundle, follow the wizard prompts until you
reach the Summary page, then skip to Step 19 on page 43.

13

Click Help for information about each page or refer to the following table:

Wizard Page and Field

Details

Select Files page > File
field

Select Files page >
Destination Directory field

Select Files page > Copy
Option

Select Files page >
Attributes field

Click Add to display the Select Files dialog box, specify the files you
want to install on the device, then click Open. Repeat this step as many
times as necessary to copy the desired files.

By default, the content is encrypted and compressed. If you do not
want to compress or encrypt the content, select the Do not compress or
encrypt uploaded content option.

Click OK to upload the files to the server. The File option lists all the
uploaded files, the size of the files, and how the content is packaged.

If the Novell ZENworks File Upload plug-in is not installed on this
device, you must install it before you can browse for file paths. For
more information, see Installing the Novell ZENworks File Upload Plug-
in.

Specify the destination directory on the device in which you want to
install the file.

Select a copy option from the list. For more information on the options,
click Help.

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the file is hidden
after being copied.

Read-only: Select the Read-only check box to specify that the file is
read-only after being copied.

(Conditional) If you are creating an MSI Application bundle, follow the wizard prompts until
you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field

Details

Select .msi File page >
Upload .msi file for normal
install field

Select .msi File page >
Enter UNC path of .msi file
for network install field

Select .msi File page >
Install the Novell
ZENworks File Upload
plug-in link

Select .msi File page >
Install Parameters field

Select .msi File page >
Unistall Parameters field

Select .msi File page >
Repair Parameters field

Use this option if you want the .msi file copied to the ZENworks
Server and then distributed from the ZENworks Server to assigned
users and devices. This is referred to a normal install because
ZENworks Adaptive Agent copies the .ms1 file to the managed
device’s local drive and then the Microsoft Windows Installer program
installs the application from the local .ms1 file.

Click [&] to display the Select .msi File dialog box. Click Browse to
select the .msi file to upload. Select the Include all files in and below
the directory of this file option to include all the supporting files that are
within the directory containing the . msi file and the subdirectories
within it.

NOTE: By default, ZENworks Control Center has a 30-minute timeout
value. If you leave ZENworks Control Center idle on your computer for
more than 30 minutes, you are prompted to log in again before
continuing. Because the upload process can take considerable time for
alarge .msi file, the default timeout value does not apply for this page.

Use this option if you want the Microsoft Windows Installer program to
install the application from the .msi file on a network location. You
must specify the complete path to the .msi file to use as the source file
during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive mapping,
you must ensure that all workstations have the same drive mapped to
the source location. For this reason, we recommend that you specify a
UNC path.

After you create the MSI bundle, you cannot change the .msi
filename; however, you can change the path to the .msi file. If you
change the .ms1i filename, the installation fails.

If you have not installed the Novell ZENworks File Upload plug-in on
this device, you must do so before you can browse to and upload files.
For more information, see Appendix F, “Novell ZENworks File Upload
Plug-in,” on page 249.

Click |8 to display the Install Parameters dialog box, then specify the
desired parameters. For more information, click the Help button or see
Section A.1, “Install Parameters,” on page 223.

Click |:&] to display the Uninstall Parameters dialog box, then specify
the desired parameters. For more information, click the Help button or
see Section A.2, “Uninstall Parameters,” on page 225.

Click |i& to display the Repair Parameters dialog box, then specify the
desired parameters. For more information, click the Help button or see
Section A.3, “Repair Parameters,” on page 227.
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Wizard Page and Field

Details

Select .msi File page >
MSI Properties field

Select .msi File page >
Select Transforms File
field

Select Command page >
Executable to run field

The MSI package contains the property values that were defined
during the administrative installation of the application. These property
values determine the way the Microsoft Windows Installer installs the
application to the workstation. In some cases, you might want to
change one or more of the property values. For example, a property
value might define the default location for a user’s work files. By adding
the property to the list and changing the property’s value, you can
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in
the MSI package. When doing so, you should be careful to add only
those properties that are valid for the package.

To override a property value, you change the property value and add
the property to the Properties list so that Application Launcher knows to
use that property value rather than the one defined in the MSI package.
To do so, click Add to display the MSI Properties dialog box. In the
Name field, select the property whose value you want to override,
specify the new value in the Value field, then click OK to add the
property to the MSI Properties list.

To modify a property that is in the MSI Properties list, select the
property, click Edit, modify the value data, then click OK.

To remove a property from the MSI Properties list, select the property,
then click Remove. Deleting the property causes future installations of
the application to use the property value defined in the MSI package.

Click Add to browse to and select the desired transform file. You can
upload the transform file or you can specify its location.

Different groups within an organization often use the same application,
but that doesn’t mean they require the same feature set. One of the
benefits of Windows Installer is that if you have 10 groups needing 10
different feature sets or other alterations for the same application, you
can deploy the same MSI package to all 10 user groups, but with a
different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSl installation.
It contains all modification information, such as whether features are
installed; how they are installed; which files, shortcuts, and registry
entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio
ZENworks Edition to create and manage transforms

The Select Command page lets you specify an optional executable to
run after the .ms1 file installs. Click Browse to browse for and select
the executable to run.

If the executable is installed in the Program Files directory on the
managed device, you must use macros as follows:

¢ On 32-bit managed device: ${ProgramFiles}\filename.

¢ On 64-bit managed device: ${ProgramFiles32}\filename.

If you have not installed the Novell ZENworks File Upload plug-in on
this device, you must do so before you can browse to and upload files.
For more information, see Appendix F, “Novell ZENworks File Upload
Plug-in,” on page 249.
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14 If you are creating an MSP Application bundle, follow the wizard prompts until you reach the
Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select .msp File page > Use this option if you want the .msp file copied to the ZENworks
Upload .msp file for normal Server and then distributed from the ZENworks Server to assigned
install field users and devices. This is referred to a normal install because

ZENworks Adaptive Agent copies the .msp file to the managed
device’s local drive and then it is installed from the local . msp file.

Select .msp File page > Enter Use this option if you want to install from the . msp file on a network
UNC path of .msp file for location. You must specify the complete path to the .msp file to use
network install field as the source file during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive
mapping, you must ensure that all workstations have the same drive
mapped to the source location. For this reason, we recommend that
you specify a UNC path.

After you create the MSP bundle, you cannot change the .msp
filename; however, you can change the path to the .msp file. If you
change the .msp filename, the installation fails.

Select .msp File page > If you have not installed the Novell ZENworks File Upload plug-in on
Install the Novell ZENworks  this device, you must do so before you can browse to and upload
File Upload plug-in link files. For more information, see Appendix F, “Novell ZENworks File

Upload Plug-in,” on page 249.

Select .msp File page > After you select the .msp file, the Command Line Parameters field
Command Line Parameters is automatically populated, for example /p patch_package /gn where
field /p designates a patch file, patch package specifies the . msp file,

and /gn specifies an installation with no user interface (silent
installation). To install a . msp file, you should normally use the /gn
option.

You can, however, specify additional options. For more information,
see the MSDN Web site (http://msdn2.microsoft.com/en-us/library/
aa372866.aspx).

15 If you are creating Simple Application bundle, follow the wizard prompts until you reach the
Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:
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Wizard Page and Field Details

Enter the Command to Run  Specify the command to launch the application. You should include

page > Command field the full path to the executable in case the executable is not in the
device’s search path. This path, whether the application is on the
device’s local drive or a network resource, must be relative to the
device.

For example, if the executable file is on the device’s local drive, you
would specify something like ¢ : \winnt\notepad.exe. If the
executable file is on a network resource, you would specify
something like j : \apps\notepad. exe (if all users will have J:
mapped to the location) or
\\serverl\voll\apps\notepad.exe.

Enter the Command to Run  If you have not installed the Novell ZENworks File Upload plug-in on

page > Install the Novell this device, you must do so before you can browse to and upload
ZENworks File Upload plug- files. For more information, see Appendix F, “Novell ZENworks File
in link Upload Plug-in,” on page 249.

Enter the Command to Run  Specify any command line parameters that need to be passed to the
page > Command Line executable.

Parameters field )
ZENworks Adaptive Agent passes the parameters exactly as they

are specified. Therefore, the parameter syntax you use must exactly
match the syntax the executable requires. For example, if
word.exe has a /£=f1ilepath parameter that requires paths with
spaces to be enclosed in quotation marks, you would specify the
following:

/f="c:\my docs\sample.doc"

Enter the Command to Run  Specify the path to the directory you want the application to use for
page > Working Directory its working files.
field

(Conditional) If you are creating an Store Personality bundle, follow the wizard prompts until
you reach the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Store Personality page > gelect this option and click [&] to display the Upload content dialog box.

Upload a template from  Browse to and select the template to upload.
this device field

Store Personality page >  Select this option to specify the path of personality migration template
Specify a template on the file on the managed device. You can also specify the UNC path of the
managed device field file.

Store Personality page >  Specify the path of the PNP file on the managed device for storing the
Path from where the PNP  migration settings and data. You can also specify the UNC path of the
file is to be created file.

Store Personality page >  Select this check box to enter the password to encrypt the PNP file.

Password to encrypt the . .
PNP file field In the Re-enter the password field, re-enter the password to confirm it.
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Wizard Page and Field Details

Store Personality page >  You can choose to span the personality migration data across multiple
Span to mutilple files field files to enable you to store data in removable media. The available
options are.

* Never span: Select this option to migrate personalities without
spanning the files.

+ Span at the size: Select this option to specify a span size for the
files. The default span size is 650 MB, and the maximum span
size is 2 GB.

17 If you are creating a Thin Client Application bundle, follow the wizard prompts until you reach

the Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field

Details

Configure Thin Client Details
page > ICA Session:
Published Application Name
field

Configure Thin Client Details
page > ICA Session: Servers
Hosting the Application field

Configure Thin Client Details
page > RDP Session:
Terminal Server Address field

Configure Thin Client Details
page > RDP Session: Server
Port field

Configure Thin Client Details
page > RDP Session: Server
Domain field

Configure Thin Client Details
page > RDP Session:
Application Path field

Configure Thin Client Details
page > RDP Session:
Application Working Directory
field

Configure Thin Client Details
page > RDP Session: Color
Depth field

Configure Thin Client Details
page > RDP Session: Screen
Size field

Type the published application name exactly as it is defined in
Citrix*.

Add the Citrix servers that host the application. To add a server,
specify the server’s IP address or hostname, then click Add.

The order in which the servers are listed is the preferred order for
launching. You can use the Move Up and Move Down buttons to
change the order if necessary.

Type the terminal server’s IP address or hostname.

If the terminal server is not using the default port 3389, specify the
correct port number.

If the terminal server is part of a Windows NT* domain or an Active
Directory* domain, enter the domain name. If the user's name and
password in the domain matches the user name and password in
Novell eDirectory, the user is not prompted to log in to the terminal
server when launching the application.

Specify the path to the application’s executable file from the
perspective of the terminal server.

Specify the path to the directory you want the application to use for
its working files.

Select the number of colors for the RDP client session. You can
select 256 Colors, High Color (15 bits), High Color (16 bits), or True
Color (24 bits). The default is True Color (24 bits).

If you want the RDP client session to use the entire desktop area,
select Operate in full screen mode. Otherwise, select Use specified
screen size and manually set the width and height (in pixels).
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Wizard Page and Field Details

Configure Thin Client Details ~Select the settings such as drivers, printers, serial ports, and smart
page > RDP Session: cards that you want to map to the remote desktop machine.
Advanced Settings for

redirection field

18 If you are creating a Web Application bundle, follow the wizard prompts until you reach the
Summary page, then skip to Step 19 on page 43.

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Enter URL page > URL field  Specify the location (URL) of the Web application. The URL should
point to the primary file for the Web application or to a Web page
that allows access to the Web application.

Click the Test URL button to test the URL.

19 Review the information on the Summary page, making any changes to the bundle settings by
using the Back button as necessary.

20 Skip to Step 22to create the published version of the bundle.
21 (Conditional) Select the Create as Sandbox option to create a sandbox-only version of the bundle.

A sandbox-only version of a bundle enables you to test the bundle on your device before
actually deploying it. For more information on a sandbox-only bundle, see Chapter 7,
“Understanding Bundle Change Management,” on page 157.

22 (Conditional) Select the Define Additional Properties option to display the bundle’s Action page
after the wizard completes. You can use the various tabs to edit the bundle’s assignments,
system requirements, actions, settings, and content replication settings.

23 Click Finish to create the bundle as configured per settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, s,
and group membership. At some point in the future, you need to configure additional options
for the bundle by continuing with Section 9.1, “Assigning Existing Bundles to Devices,” on
page 179 or Section 9.2, “Assigning Existing Bundles to Users,” on page 184.

For information on the viewing the bundle information, see Chapter 3, “Viewing the Bundle
Information,” on page 51.

Creating Bundles by Using the zman Command Line Utility

ZENworks Configuration Management allows you to create different types of bundles, such as
Windows bundle and Preboot bundle. Each bundle has its own set of data and configuration settings.
Because it is complex to pass the data as arguments in the command line, the zman utility takes XML
files as an input to create bundles. To use the zman command line utility to create a bundle, you must
have a bundle of the same type already created through ZENworks Control Center and export it to
XML. For more information on creating bundles by using ZENworks Control Center, see Chapter 2,
“Creating Bundles,” on page 25. You can use the exported XML file as a template to create bundles by
using zman.

For example, you can export a Windows bundle already created through ZENworks Control Center
into an XML file, then use it to create another Windows bundle with zman.
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A bundle can have file content associated with it. For example, an MSI file to be installed is a file
content associated with a Windows MSI Bundle.

Bundles can also have dependencies on other bundles.

NOTE: If you use the zman bundle-create command to create a Linux bundle with the Install
RPM) action or a Linux Dependency bundle with the Distribute RPM action, ensure that you run the
command within a working directory, so the path of the RPM files in the ActionInfo XML can be
resolved.

For example, assume that you use the zman bundle-export-to-file command to export a Linux bundle
with the Install RPM action, along with its content. If you want to create a new bundle from the
exported bundle XML file and content, you need to ensure that you are running the zman bundle-
create command within the directory that contains the ActionInfo XML file. You need to do this
because the exported ActionInfo XML file contains the relative path of the RPMs, and the path
resolves correctly only if you are running the command from the directory that contains the
ActionInfo XML file.

Review the following sections to create a bundle by using the zman command line utility:

¢ Section 2.5.1, “Creating a Simple Bundle,” on page 44

¢ Section 2.5.2, “Creating a Bundle with Content and Dependency on Another Bundle,” on
page 45

¢ Section 2.5.3, “Understanding the zman Bundle XML File Format,” on page 47

Creating a Simple Bundle

To create a bundle that has no content or dependency on another bundle:

1 Create a bundle in ZENworks Control Center.

For example, use ZENworks Control Center to create a Web Application bundle called google,
which launches the Google Web site (http://www.google.com).

2 Export the bundle to an XML file by using the following command:
zman bundle-export-to-file bundle name bundle filename.xml

For example, export the google bundle to google.xml by using the zman bundle-export-to-
file google google.xml command.

If you want to create a new bundle with new data, continue with Step 3. If you want to create a
new bundle with the same data as the google bundle, skip to Step 4.

3 Modify the XML file according to your requirements.

For example, change the value of <URL> from http://www.google.comto http://
www . yahoo.com in the Launch URL Action section of Launch ActionSet in the XML file as
shown below.

<ns2:ActionSets>
<Id>104e5d74804052eb7ddc4a2f54358d97</1d>
<TypesLaunch</Type>
<Version>1l</Versions>
<Modified>false</Modified>

<Data>
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<nsl:Launch/>
</Data>
<Actionss>
<Id>2ef5c645774759e9868ba2¢157301949</Id>
<Type>Launch URL Action</Type>
<Data>
<nsl:LaunchUrlActionDatax>
<URL>http://www.yahoo.com</URL>
<WaitForExits>false</WaitForExits>
</nsl:LaunchUrlActionDatas
</Datas>
<ContinueOnFailures>false</ContinueOnFailures>
<Enableds>true</Enableds>
<Properties />
</Actions>
</ns2:ActionSets>
4 Create a new bundle by using the following command:

zman bundle-create new bundle name bundle xml filename.xml

For example, to create the yahoo bundle, enter the zman bundle-create yahoo google.xml
command at the console prompt.

2.5.2 Creating a Bundle with Content and Dependency on Another Bundle

1 Create two bundles in ZENworks Control Center.

For example, use ZENworks Control Cener to create two MSI application bundles called
officeXP and officeXPSP1. The officeXP bundle installs Microsoft Office XP through an MSI. The
officeXPSP1 bundle installs the Service Pack 1 for Microsoft Office XP. In the officeXP bundle,
add an Install Bundle action to install officeXPSP1.

2 Export the bundle, which has the dependency on another bundle, to an XML file by using the
following command:

zman bundle-export-to-file bundle name bundle filename.xml
This creates bundle filename.xml and bundle filename ActionContentInfo.xml files.

For example, export the officeXP bundle to of ficeXP.xml by using the zman bundle-export-
to-file officeXP officeXP.xml command. The officeXP.xml and
officeXP ActionContentInfo.xml files are created.

Sample xml format templates, WindowsMSIBundle.xml and ActionInfo.xml, are available at /
opt/novell/zenworks/share/zman/samples/bundles on a Linux server and in

"% ZENWORKS HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.
For more information about ActionContentInfo.xml, see Section 2.5.3, “Understanding the
zman Bundle XML File Format,” on page 47.

If you want to create a new bundle with new data, continue with Step 3. If you want to create a
new bundle with the same data as the officeXP bundle, skip to Step 4.
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3 Modify the officeXP.xml and officeXP ActionContentInfo.xml files according to your
requirements.

For example, to create a new bundle to install ApplicationX and its support pack, do the
following:

¢ Change all references of of ficeXP.msi to ApplicationX.msi in the
officeXP ActionContentInfo.xml file.

¢ Create another bundle called as ApplicationX-SP1 that installs the support pack for
Application X.

¢ Change the path of the dependent OfficeXPSP1 bundle to ApplicationX-SP1 in the
officeXP_ ActionContentInfo.xml to install both ApplicationX and its support pack.

A sample of ficeXP ActionContentInfo.xml is as follows:
<ActionInformations
<ActionSet type="Install"s>
<Action name="Install MSI" index="1">
<Content>
<ContentFilePath includeAllFilesinFolder="false"

includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>

</Content>
</Action>
<Action name="Install Bundle" index="2">

<DependentBundlePaths>bundlefolder/ApplicationX-SP1l</
DependentBundlePath>

</Action>
</ActionSet>
<ActionSet type="Uninstall"s>
<Action name="Undo Install Actions" index="1">
<Content>
<ContentFilePath includeAllFilesinFolder="false"
includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>
</Content>
</Action>
</ActionSet>
</ActionInformations>
4 Create a bundle by using the following command:

zman bundle-create new bundle name bundle xml filename.xml bundle location --
actioninfo bundle name ActionContentInfo.xml

If you do not specify the location of the bundle creation, the bundle is created in the root folder
(/Bundles) by default.

For example, use the following command to create a bundle called ApplicationX in the root
folder (/Bundles):
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zman bundle-create ApplicationX officeXP.xml --actioninfo
officeXP ActionContentInfo.xml

You can also specify the folder in which the bundle should be created.

For example, use the following command to create a bundle called ApplicationY in the Software
folder under the root folder (/Bundles/Software):

zman bundle-create ApplicationY officeXP.xml /Bundles/Software --actioninfo
officeXP ActionContentInfo.xml

Understanding the zman Bundle XML File Format

The bundle-export-to-file command serializes the bundle information, which is stored in the
database, into an XML file. Each bundle contains actions that are grouped into action sets such as
Install and Launch. An exported bundle XML file contains information for the bundle, such as UID,
Name, Path, PrimaryType, SubType, Category, System Requirements, and information on all
ActionSets and their actions. The file does not include information about assignment of the bundle to
devices or users, and add-on images for the bundle.

A sample XML format template, WindowsMSIBundle.xml, is available at /opt /novell/zenworks/
share/zman/samples/bundles on a Linux server and in
"% ZENWORKS HOME$%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.

NOTE: If the exported XML file contains extended ASCII characters, you must open it in an editor by
using UTF-8 encoding instead of ANSI encoding, because ANSI encoding displays the extended
ASCII characters as garbled.

When you create a bundle from the XMLfile, zman uses the information specified in the
<Descriptions, <SubType>,<Categorys, <ActionSets>, and <SysRegs> elements of the file. The
values for the Name and Parent Folder are taken from the command line. For the remaining
elements, the default value is used.

Follow the guidelines listed below to work with the XML file:

¢ If you want to create a bundle without file content or dependency on another bundle, you need
only the bundle XML file to create a bundle.

¢ If you want to create a bundle with content or dependency on another bundle, you must provide
an additional XML file, which contains the path of the content file or the dependent bundle, as
an argument to the --actioninfo option of the bundle-create command.

A sample XML format template, ActionInfo.xml, is available at /opt/novell/zenworks/
share/zman/samples/bundles on a Linux server and in
"% ZENWORKS HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.

¢ If you want to modify the <Data> element of actions in the exported XMLfile, ensure that the
new data is correct and that it conforms to the schema. The zman utility does a minimal
validation of the data and does not check for the errors in the data. Hence, the bundle might be
successfully created, but with invalid data. Such a bundle fails when deployed on a managed
device.

+ File content or bundle dependencies are associated with a particular action in <ActionSet>. The
Action Content Information XML file should contain the path of the file to which the file content
is to be associated and the index of the action in the <ActionSets.

For example, the MSI file to be installed when you create the Windows MSI Bundle is associated
to the first Install MSI action in the Install action set of the created Windows MSI Bundle.

¢ The <ActionSet> is specified by the type attribute. It should be the same as the Action Set type
of the bundle XML file.
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The <Action> element has a name attribute, which is optional, for user readability.

The index attribute is mandatory. It specifies the action to which the content or dependency
should be associated. The index value of the first action in <ActionSets> is 1.

Each action can have multiple <Content > elements, each containing a <ContentFilePath>
element. The <ContentFilePath> element contains the path of the file content to be associated
with the Action. Ensure that the filename is the same as the filename specified in the bundle
XML file in <Datas> for that action.

Ensure that the order of the <Content > elements is in accordance with the order in the bundle
XML file. For example, the Windows MSI bundle should have the MSI file in the first <Content >
element, followed by <Content> elements with the path to the MST files in the order specified
in <Data> for that action.

For creating Windows MSI bundles, you can include all the files in the folder or subfolders by
setting the includeAllFilesinFolder and includeAllFilesinSubFolders attributes to True.
The dependency to another bundle can be specified by giving the bundle path as a value of the
<DependentBundlePath> element. The path of the bundle specified should be relative to /
Bundles as shown below.

<ActionSet type="Install"s

<Action name="Install MSI" index="1">

<Contents>

<ContentFilePath includeAllFilesinFolder="false"
includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>

</Content>

<Contents>

<ContentFilePath includeAllFilesinFolder="false"

includeAllFilesinSubFolders="false">E:\files\ApplicationX MST1.mst</
ContentFilePath>

</Content>

</Action>

<Action name="Install Bundle" index="2">
<DependentBundlePath>bundlefolder/ApplicationX-SP1l</DependentBundlePath>
</Actions>

</ActionSet>

¢ To get the UID of an object, use the object-get-GUID command. You must manually edit the

object UIDs in the bundle XML file in the following scenarios:

¢ In the Bundle Installed system requirement, the path and the UID of the bundle must be
changed in the <BundleInstalledReqg> element under the <SysRegs> element.

¢ In the Imaging bundle, the UID of the server containing the . img file must be manually
changed in the ZENworks Image and Multicast Image Set actions. Also, the UID of the
linked application bundle must be manually changed in the Linked Application Bundle
and Multicast Image Set actions. Ensure that the linked bundle already has an add-on
image that was created manually, because it is not automatically created when the bundle is
linked to the image bundle.
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NOTE: If you export a bundle which has a with string values into an XML file, the string value in it
will be in Base 64 encoding format. You cannot use this XML file as a template to create another
bundle using zman, because the string value which is in Base 64 format in this XML file cannot be

changed.

Creating Bundles 49



50 ZENworks 11 SP3 Software Distribution Reference



Viewing the Bundle Information

When you create a bundle, the bundle is listed on the Bundles page of the ZENworks Control Center.
For more information on the created bundle, review the following sections:
¢ Section 3.1, “Understanding the Bundle Page,” on page 51

¢ Section 3.2, “Bundle Summary Page,” on page 51

3.1 Understanding the Bundle Page

The Bundles page displays the following information:

¢ Status: Gives a quick indication of message logging and enforcement status of the bundle. The
status icons are:

m= .

“& - No warning or error messages; bundle enforcement succeeded
- .

“x - Warning messages; bundle enforcement succeeded
& - Error messages; bundle enforcement failed

¢ Name: Displays the object’s (bundle, bundle group, or the bundle folder) name. Click the name
to view or edit the object’s information.

¢ Type: Displays the type of the object. For example, a Folder, Bundle Group, Windows Bundle,
Linux Bundle, or Preboot Bundle.

¢ Category: Displays the bundle category selected during the creation of the bundle.For example,
Copy Directory.

¢ Enabled: Displays whether the bundle is enabled to be deployed on a device or not. The possible
values are Yes and No.

¢ Version: Displays the latest published version of the bundle. However, if the bundle is a
sandbox-only bundle, it displays Sandbox.

¢ Has Sandbox: Displays whether the bundle has a sandbox or not. The possible values are Yes
and No.

3.2 Bundle Summary Page

The Summary page of a bundle displays the following panels:

¢ Section 3.2.1, “General,” on page 52

¢ Section 3.2.2, “Bundle Status,” on page 55

¢ Section 3.2.3, “Message Log,” on page 56

¢ Section 3.2.4, “Upcoming Events,” on page 57
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3.2.1

General

The General panel provides a summary of the bundle’s general settings.

Bundle Type

Displays the type of bundle.

Size

Click Compute to display the size of the content associated with the bundle.To view the correct size of
the bundle, check for the bundle size information in the bundle summary page after the content
import is complete.

When you create a bundle, the bundle's files are imported to the ZENworks content repository. The
import is a server process that can take a while. Until the import is complete, the size of the bundle is
displayed as 0 (zero).

Version

Displays the latest published version of the bundle. However, if the bundle is a sandbox-only bundle
or has a sandbox, it displays Sandbox.

Enabled

Displays whether or not the bundle can be deployed to managed devices.
If a bundle is enabled, it can be deployed to managed devices.

When you disable a bundle that has already been deployed to a managed device, the bundle icon is
removed from all the shortcut locations of the device. However, all the actions performed on the
device prior to the disabling of the bundle remain unchanged.

If this bundle is assigned to a new device, the bundle shortcut icons are not placed in the device's
shortcut locations.

If the bundle is disabled, click Enable to allow it to be deployed.

Number of Errors Not Acknowledged

An error is anything that causes the deployment or installation of the bundle to fail. The number
displayed indicates the number of unacknowledged errors, which are any errors that you have not
specifically marked as acknowledged. Unacknowledged errors are displayed in the Message Log
section.

Number of Warnings Not Acknowledged

A warning is anything that does not cause the deployment or installation of the bundle to fail, but
indicates minor problems with the bundle. The number displayed indicates the number of
unacknowledged warnings, which are any warnings that you have not specifically marked as
acknowledged. Unacknowledged warnings are displayed in the Message Log section.
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GUID

Displays the bundle’s GUID (global unique identifier), a randomly generated string that provides a
unique identifier for the bundle. You cannot edit the GUID.

Display Name

Displays the bundle’s name as it appears in ZENworks Control Center (ZCC) and the ZENworks
Adaptive Agent (on managed devices). Click Edit to change the name. Changing the name does not
cause the bundle to be redeployed.

Description

Displays the bundle’s description, if one was provided when the bundle was created. The description
appears in ZCC and the ZENworks Adaptive Agent (on managed devices). Click Edit to change the
description.

Icon

Determines the shortcut icon that ZENworks Adaptive Agent displays on managed devices. During
creation of the bundle, if you specified a custom icon rather than using the standard ZENworks
bundle icon, this field displays the image and name of the custom icon. If you did not specify a
custom icon, this field is empty and the standard icon is used.

Click Edit to change the icon, delete the icon, or add an icon if one is not specified.
To select an icon, click @], then browse to and select the icon you want to display on managed devices.

If the desired icon is embedded in a .exe, .d11, or .ico file that has multiple icons from which to
choose, you must install additional items before you can browse to and select the desired icon.

For Mozilla Firefox, if you have not already installed the Novell ZENworks File Upload plug-in on
this device, you must do so before you can download and install the download plug-in or browse to
and upload the icon. After you install the Novell ZENworks File Upload plug-in, you must also
install the download plug-in. To do so, click the Click here to download plug-in message box that
displays in the Select Icon dialog box (if you have already installed the plug-in on this device, the
plug-in box does not display), click Manual Install, then click Install Now.

For Microsoft Internet Explorer, you must install the Novell File Upload ActiveX control only; there is
no download plug-in for Internet Explorer. For more information, see Novell ZENworks File Upload
plug-in.

After you have downloaded and installed the necessary extensions and plug-in, click @ to browse to
and select the icon you want ZENworks Adaptive Agent to display to represent the bundle. If the
icon in embedded in a .exe, .d11, or .ico file that contains multiple icons, an additional dialog box
displays to let you select the desired icon.

NOTE: For Linux bundles, only the PNG and JPEG formats are supported.
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Contacts

Displays the contact information (names, phone numbers, and e-mail addresses) of the people who
you want users to contact with problems or questions about the bundle. The contact information is
displayed by ZENworks Adaptive Agent on managed devices.

Click Edit to change the contact information, delete contact information, or add contact information.

Administrator Notes

Displays any information that has been added specifically for ZENworks administrators to view. The
notes are displayed only in ZCC.

Click Edit to change the notes, add notes, or delete notes. Editing the note does not create a sandbox.
You can edit the administrator notes for any version of a bundle.

ZENworks Explorer Folder Path

Displays the folder path used by ZENworks Adaptive Agent when displaying the bundle on the Start
menu.

For example, if you specify Applications/Accounting as the path and choose to display the bundle
on the Start menu, ZENworks Adaptive Agent creates an Applications/Accounting folder on the
Start menu and adds the bundle to it.

You can place multiple bundles in a single folder by specifying the same folder path for each of the
bundles.

Click Edit to change the folder path, add a folder path, or delete the folder path.

Add-On Image File

You can create an image file for the bundle to use as an add-on image to a base image. If you have
already created an image file for the bundle, this field displays the name of the image file. Otherwise,
click Create to create the image file and assign it to image servers.

If the bundle includes any dependent bundles, you can also create and assign an add-on image for
the dependent bundles.

Show Bundle Activity

Click Yes to display the bundle activity indicator window during the distribution, installation,
verification, and uninstallation of a bundle on the managed device. The user on the managed device
cannot close this bundle activity indicator window.

On Windows 2000 devices, the control that indicates the progress of the bundle execution on the
managed device is not displayed in the bundle activity indicator window.
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Dependency Bundles

Displays None if there are no bundle dependencies for this bundle. If there are dependencies for this
bundle, click Display Bundle Dependencies to display a list of additional bundles that are required by
this bundle.

The list is for viewing only. To change a bundle dependency, switch to the Actions tab, click the
appropriate action (for example, Install or Launch), then locate the Linked Application Bundle or Linked
Preboot Bundle. Select the entry and perform the action you want (for example, edit or delete it).

For more information, see “Dependency Bundles” on page 175.

Severity

This field is available only for Linux bundles. It indicates the severity, such as Security,
Recommended or Optional.

YUM Service

This field is available only for Linux bundles and Linux Dependency bundles.

Click Create to create a YUM service and assign it to ZENworks Servers in a Management Zone. You
can create a YUM service for a bundle and use it on devices that are not managed by ZENworks.
Click Help for more information on how to create a YUM service.

When you create the YUM service, the bundle’s Summary page is displayed. The YUM Service field
displays the relative path of the repository. The InProgress icon indicates the progress. Click the

[=]

Summary tab to refresh the page. The ©* icon indicates that the service is hosted on the Primary
Server. The relative path of the YUM repository is displayed in the YUM Service field.

A yellow icon is displayed when the repository is not updated with the packages in the bundle.

Click Edit to edit the YUM service details. You can edit the YUM service to add or remove Primary
Servers.

Bundle Status

The Bundle Status panel displays a summary of the bundle’s assignment, deployment, and launch
status. The User row displays the status of the bundle through assignment to users; the Device row
displays the status of the bundle through assignment to devices. A bundle can be directly assigned or
assigned through membership in a folder or group. You can click an underlined link in any column to
view the status of the individual users and devices to which the bundle is assigned, retry a failed
bundle, or export the data to a CSV file.

A bundle’s status is calculated using the status of many events. For example, a device might indicate
that the bundle failed when the distribution was successful, but the installation failed. The numbers
in the various columns represent an overall view of the bundle’s status.

NOTE: The Bundle Status panel on the bundle’s sandbox or the older versions page does not display
the status. However, the Bundle Status panel on the bundle’s published version page displays the
status of the bundle’s published version, sandbox, and the older versions.

The bundle status information is separated into the follow groups listed below, which are
independent of each other. For example, it is possible for an installation to be successful, but the
launch to be unsuccessful.
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Assignment Status

The following status information is available:
Targeted: Displays the number of users and devices to which the bundle is assigned.

Devices Effective: Displays the number of devices on which the bundle is effective through a user or
device assignment. A bundle is effective for a device if the device meets the system requirements of
the bundle. The number of users or devices in the Devices Effective column might be less than the
number in the Targeted column because the bundle might be assigned to a device that does not meet
the bundle’s system requirements. For example, you might have a Windows bundle assigned to a
Linux device, but the bundle is not effective for that device.

Devices Not Effective: Displays the number of devices on which the bundle is not effective through
a user or device assignment. If a bundle is not effective for the device, it means that the device does
not meet the bundle’s system requirements.

Pending: The pending status for the device displays the number of devices on which the bundle is
not yet distributed or executed, such as devices that are switched off. Click the underlined link to
display the list of such devices.

Blocked/Targeted: Displays the number of users or devices on which the bundle is blocked from
being used out of the targeted number of the users or devices. Click the underlined link to display the
list of such users or devices.

Deployment Status

The following status information is available:

Devices Pending: Displays the number of devices on which the bundle is pending. A bundle’s status
is pending if the bundle has met the device’s system requirements, but the bundle has not been
distributed to the device or the bundle has been distributed to the device but the bundle has not been
installed.

Devices Succeeded: Displays the number of devices on which the bundle was successfully
distributed and installed.

Devices Failed: Displays the number of devices on which the bundle’s distribution or installation
failed.

Launch Status

The following status information is available:

Succeeded: Displays the number of devices on which the application in the bundle was successfully
launched.

Failed: Displays the number of devices on which the application in the bundle was not successfully
launched.

Message Log

The Message Log panel displays all unacknowledged messages generated for the object. An
unacknowledged message is one that you have not yet reviewed and marked as acknowledged.

¢ Status: Displays an icon indicating the type of message: */ critical, ¢/ warning, and @ normal.

¢ Message: Displays a brief description of the event that occurred.
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¢ Date: Displays the date and time the event occurred.

NOTE: The Message Log panel on the bundle’s sandbox or the older versions page does not display
any messages. However, the Message Log panel on the bundle’s published version page displays the
messages of the bundle’s published version, sandbox, and the older versions.

A message remains in the Message Log list until you acknowledge it. You can acknowledge
individual messages, acknowledge all messages at one time, or view more information about both

acknowledged and unacknowledged messages. The following table explains how to do these tasks:

Additional Details

Task Steps

Acknowledge a

message Message Detail Information dialog
box.

2. Click Acknowledge.

Acknowledge all 1. Inthe Tasks list located in the left
messages navigation pane, click Acknowledge

All Messages.

View all 1. Click the Advanced button to display
the Edit Message Log page.

acknowledged or
unacknowledged
messages

Delete a message

2. Click Delete.

1. Click the message to display the

1. Click the message to display the
Message Detail Log dialog box.

If you decide that you don’t want to
acknowledge the message, click Finished
to dismiss the dialog box. This causes the
message to remain in the Message Log
list.

In addition to viewing all acknowledged
and unacknowledged messages, you can
also view only those messages with a
specific status or date, view more details
about messages, and acknowledge
messages.

Click the Help button on the Edit Message
Log page for specific information about
performing tasks on that page.

Deleting a message completely removes

the message from your ZENworks system.

Upcoming Events

The Upcoming Events panel lists all bundles d to deploy or launch today on all managed devices in
your ZENworks Management Zone. To view the events for another day, click the & icon to select a
specific day or use the 1, 7, and 31 arrows to view events for the previous or next day, week, or

month.

Click a bundle to display or edit its details such as summary, relationship, requirement, actions, or

settings.

Click a time to view the bundle’s details, including the time the event is d to fire, its type (Date
Specific, Event, Recurring, etc.), the dates on which the event is d to be performed, and the event’s

start and end time.

Click 5 to view the bundle’s assignment details, including the bundle’s folder and its assignments

(devices or workstations).

Viewing the Bundle Information
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Managing Bundle Groups

A bundle group lets you group bundles to ease administration and to provide easier assigning and
scheduling of the bundles in the bundle group.

You can use ZENworks Control Center or the zman command line utility to create bundle groups.
This section explains how to perform this task using the ZENworks Control Center. If you prefer the
zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

For information on assigning a bundle group to a user or device, see Chapter 9, “Managing Bundle
Assignments,” on page 179.

The following sections contain more information:

¢ Section 4.1, “Creating Bundle Groups,” on page 59

¢ Section 4.2, “Renaming or Moving Bundle Groups,” on page 60

*

Section 4.3, “Copying the System Requirements of a Bundle Group,” on page 61

*

Section 4.4, “Deleting a Bundle Group,” on page 61

*

Section 4.5, “Adding a Bundle to a Group,” on page 61

*

Section 4.6, “Copying a Bundle Group to a Content Server,” on page 62

Creating Bundle Groups

1 In ZENworks Control Center, click the Bundles tab.
2 Click New > Bundle Group.

Bundles

[] status i Type Category Enabled Version Has Sandbox

0| & Windows Bundle Simple Application Yes 1 Mo

([ é?a r§ notepad Windows Bundle Simple Application Yes 5 No

Fl| £ & wordpad Windows Bundle Simple Application Yes 1 Yes

4| »|1-3083 show 25 v items

3 Fill in the fields:

Group Name: Provide a name for the bundle group. The name must be different than the name
of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name
you provide displays in ZENworks Control Center.

For more information, see “Naming Objects in ZENworks Control Center” in the ZENworks 11
SP3 ZENworks Control Center Reference.
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4.2

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the bundle to reside. The default is /bundles, but you can create additional folders to
organize your bundles.

If you want to create the group in another folder, browse to and select the folder. By default, the
group is created in the current folder.

Description: Provide a short description of the bundle group's contents. This description
displays in ZENworks Control Center.

4 Click Next to display the Add Group Members page, then specify bundles to be members for the
group.
You can add any number of bundles to the group. You cannot add other bundle groups to the
group.
4a Click Add to display the Select Members dialog box.

Because you are adding bundles to the group, the Select Members dialog box opens with
the Bundles folder displayed.

4b Browse for and select the bundles you want to add to the group. To do so:
4b1 Click " next to a folder to navigate the folders until you find the bundle you want to
select.

If you know the name of the bundle you are looking for, you can also use the Itern name
box to search for the bundle.

4b2 Click the underlined link in the Name column to select the bundle and display its name
in the Selected list.

4b3 (Optional) Repeat Step 4a and Step 4b to add additional bundles to the Selected list.
4b4 Click OK to add the selected bundles to the group.

5 Click Next to display the Summary page, review the information and, if necessary, use the Back
button to make changes to the information.

6 (Optional) Select the Define Additional Properties option to display the group’s properties page
after the group is created. You can then configure additional bundle properties.

7 Click Finish to create the group.

Before the bundle group’s contents are distributed to devices or users, you must continue with
Section 9.3, “Assigning a Bundle Group to Devices,” on page 187 or Section 9.4, “Assigning a Bundle
Group to Users,” on page 188.

Renaming or Moving Bundle Groups

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the option
is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is
selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the bundle group’s name, click Edit, then click an option:
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4.4

4.5

Rename: Click Rename, provide a new name for the folder, then click OK.

Move: Click Move, select a destination folder for the selected objects, then click OK.

Copying the System Requirements of a Bundle Group

For more information, see Section 4.3, “Copying the System Requirements of a Bundle Group,” on
page 61.

Deleting a Bundle Group

Deleting a bundle group does not delete its bundles. It also does not uninstall the bundles from
devices where they have already been installed. To uninstall the bundles from devices, you should
use the Uninstall option for each bundle before deleting the bundle group.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Delete.

NOTE: Deleting a bundle group does not immediately remove the YUM service that was created for
the bundle group. The YUM service is removed when the next YUM Services Refresh is configured.
Click the Click here to Update YUM Service Now link in YUM Service Settings to remove the YUM
service immediately.

Adding a Bundle to a Group

You can add the bundle to any bundle groups that already exist or you can create a new bundle
group as part of the assignment process. The bundle inherits the group’s assignments and s, which
means that you save time by managing one bundle group rather than each individual bundle.
Adding a bundle to a group is not the same as assigning a bundle to a group (user or device). For
more information on assigning bundles to devices, see Assigning Existing Bundles to Devices and
assigning bundles to users, see Assigning Existing Bundles to Users.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Action > Add to Group.

Bundles

Assign to Device...

|:| Status Mame = Assign to User... Category Enabled Version Has Sandbox
O %E. & ini_edit .. Bundle Simple Application Yes 1 No
Specify Content Server...
i @ notepad E:';D;Z & Bundle Simple Application Yes 5 No
El| Eg & wordpad Pubkish Bundes)... E Bundle simple Application Yes 1 Yes
4| b |1-3083 show 25 v items

4 Select Add selected items to an existing group if the group to which you want to add the objects
already exists.

or
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Select Create a new group to contain the selected items if you need to create a new group for the
selected objects.

(Conditional) If you chose Add selected items to an existing group in Step 4, click Next to display the
Targets page.

The Targets page lets you select the groups to which you want to add the objects (users, devices,
bundles, policies).

5a Click Add to display the Select Groups dialog box.
5b Browse for and select the groups to which you want to add the objects. To do so:
5b1 Click ¥ next to a folder to navigate the folders until you find the group you want to
select.

If you know the name of the group you are looking for, you can also use the Item name
box to search for the group.

5b2 Click the underlined link in the Name column to select the group and display its name
in the Selected list.

5b3 Repeat Step 5b1 and Step 5b2 to add additional groups to the Selected list.
5b4 When you are finished selecting groups, click OK.

(Conditional) If you chose Create a new group to contain the selected items in Step 4, click Next to
display the Basic Information page, then fill in the fields:

Name: Provide a name for the group. The group name must be different than the name of any
other object (group, folder, device, user, bundle, policy, and so forth) that resides in the same
folder and must conform to the ZENworks object naming conventions.

For more information, see “Naming Objects in ZENworks Control Center” in the ZENworks 11
SP3 ZENworks Control Center Reference.

Folder: By default, the group is created in the current folder. If you want to create the group in
another folder, browse to and select the folder.

Description: Provide a short description of the group’s purpose or contents.

Click Next to display the Summary page, review the information and, if necessary, use the Back
button to make changes to the information.

Click Finish to add the selected objects to the group.

4.6 Copying a Bundle Group to a Content Server

By default, a bundle is copied to each content server. If you specify certain content servers as hosts,
the bundle is hosted on only those content servers; it is not copied to all content servers.

A W N P

In ZENworks Control Center, click the Bundles tab.
In the Bundles list, select the check box next to the bundle group (or bundle groups).
Click Action > Specify Content Server.

On the Content Servers/Distribution Points Where Content Will Be Specifically Included page,
select the content servers.

This page lets you identify the content servers (ZENworks Servers and Distribution Points) that
you want to host the previously selected content (bundles and policies). The content is hosted
only on the content servers you select; it is excluded from all other content servers.
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The relationships between content and content servers that you create using this wizard
override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and
Server 2 and you use this wizard to include it on Server 1 only, Bundle A is no longer available
on Server 2.

4a In the Available list, select the desired ZENworks Servers and Distribution Points.
You can use Shift+click and Ctrl+click to select multiple bundles or policies.
You cannot include content on a Distribution Point without including it on the Distribution
Point’s parent ZENworks Server. You must select both the Distribution Point and its parent.
4b Click the b4 button to move the selected content servers to the Selected list.

Click Next to display the Finish page, then review the information and, if necessary, use the Back
button to make changes to the information.

Click Finish to create the relationships between the content and the content servers. Depending
on the relationships created, the content is replicated to or removed from content servers during
the next d replication.
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Managing Folders

A folder is an organizational object. You can use folders to structure your bundles and bundle groups
into a manageable hierarchy for your ZENworks system. For example, you might want a folder for
each type of bundle (Windows Bundles folder, Preboot Bundles folder, and so forth), or, if
applications are department-specific, you might want a folder for each department (Accounting
Department folder, Payroll Department folder, and so forth).

The following sections contain additional information:

¢ Section 5.1, “Creating Folders,” on page 65
¢ Section 5.2, “Renaming or Moving Folders,” on page 66

¢ Section 5.3, “Deleting a Folder,” on page 66

Creating Folders

1 In ZENworks Control Center, click the Bundles tab.
2 Click New > Folder.

Bundles
.

D Status Bunde. Tvpe Category Enabled Version Has Sandbox
H Bundle Group... Bundle Group

Fo
O é'n & ini_edit Windows Bundle Simple Application Yes 1 No
O &% : : i

s & notepad Windows Bundle Simple Application Yes 5 No
El|Eg & wordpad Windows Bundle Simple Application Yes 1 Yes
4] b[1-404 shaw 25 ¥ items

3 Provide a unique name for your folder. This is a required field.

When you name an object in ZENworks Control Center (folders, bundles, bundle groups,
catalogs, and so forth), ensure that the name adheres to the naming conventions not all
characters are supported. For more information on naming conventions, see “Naming Objects in
ZENworks Control Center” in the ZENworks 11 SP3 ZENworks Control Center Reference.

4 Type the name or browse to and select the folder that contains this folder in the ZENworks
Control Center interface. This is a required field.

5 Provide a short description of the folder's contents.
6 Click OK.
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5.2 Renaming or Moving Folders

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a
Folder object, you can rename or move the Folder object, but not copy it. If the option is dimmed, that
option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is
selected, the Rename option is not available from the Edif menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the folder’s name, then click Edit.

Bundles

n Requirements...

[] status Hame = R‘fﬂame
0 fold Move )
O % @ iniedit
O % ® notepad
O % & wordpad

4| b |1-5of5

3 Select an option:

Type

Folder

Bundle Group
Windows Bundle
Windows Bundle

Windows Bundle

Category Enabled Version Has Sandbox
Simple Application Yes 1 No
Simple Application Yes 5 Ho
Simple Application Yes 1 Yes

show 25 - items

¢ Rename: Click Rename, provide a new name for the folder, then click OK.

¢ Move: Click Move, choose a destination folder for the selected objects, then click OK.

5.3 Deleting a Folder

Deleting a folder also deletes all of its contents (bundles, bundle groups, subfolders).

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the folder (or folders).

3 Click Delete.
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The Actions panel displays the action sets available for the bundle. Depending on the bundle type, the
possible action sets are Distribute, Install, Launch, Verify, Uninstall, Terminate, and Preboot. For
example, if you select a Windows bundle, six actions sets (Distribute, Install, Launch, Verify,
Uninstall, Terminate) are available. If you select a Preboot bundle, Preboot is the only available action
set available.

You can choose to modify the action sets. For more information on modifying the action set options,
see Section 12.2, “Modifying Action Set Options,” on page 207.

The bundle category that you select during bundle creation is listed as an action in the actions page.
For example, if you selected Copy Directory category during the bundle creation, Copy Directory
action is listed in the Install tab of the actions page.You can also add an action to any of the available
action sets. When you do so, that action is also performed whenever the action set is applicable. For
example, when you add an action to the Install action set, that action is performed whenever the
bundle is installed.

For information on managing the actions, see Section 12.1, “Managing Actions,” on page 205.
You can access the action dialog box as follows:

1 In ZENworks Control Center, click the Bundles tab.

2 Click the underlined link of a bundle in the Name column of the Bundles list.

3 Click the Actions tab.

4 Click one of the action set tabs (Distribute, Install, Launch, Verify, Uninstall, Terminate, or

Preboot), click the Add drop-down list, then select an available action.

The following sections contain information about the actions you can configure for the Distribute,
Install, Launch, Verify, and Terminate action sets.

For more information about the actions you can configure for the Preboot action set, see the
ZENworks 11 SP3 Preboot Services and Imaging Reference.

¢ Section 6.1, “Action - Apply Personality,” on page 68

¢ Section 6.2, “Action - Copy Directory,” on page 70

¢ Section 6.3, “Action - Copy Files,” on page 73

¢ Section 6.4, “Action - Create/Delete Directory,” on page 77

¢ Section 6.5, “Action - Delay,” on page 79

¢ Section 6.6, “Action - Display Message,” on page 80

¢ Section 6.7, “Action - Distribute Files,” on page 82

¢ Section 6.8, “Action - Edit INI File,” on page 82

¢ Section 6.9, “Action - Edit Text File,” on page 87

¢ Section 6.10, “Action - End Process,” on page 89

¢ Section 6.11, “Action - File Removal,” on page 91
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¢ Section 6.12, “Action - Install Bundle,” on page 93

¢ Section 6.13, “Action - Install Directory,” on page 94

¢ Section 6.14, “Action - Install Files,” on page 98

¢ Section 6.15, “Action - Install MSI,” on page 102

¢ Section 6.16, “Action - Install MSP,” on page 106

¢ Section 6.17, “Action - Install Network MSI,” on page 109

¢ Section 6.18, “Action - Launch Bundle,” on page 112

¢ Section 6.19, “Action - Launch Java Application,” on page 113

¢ Section 6.20, “Action - Launch URL,” on page 116

¢ Section 6.21, “Action - Launch Executable,” on page 117

¢ Section 6.22, “Action - Launch Macintosh Executable,” on page 121
¢ Section 6.23, “Action - Launch Windows Thin Client Application,” on page 124
¢ Section 6.24, “Action - Prompt User,” on page 127

¢ Section 6.25, “Action - Reboot/Shutdown,” on page 129

¢ Section 6.26, “Action - Registry Edit,” on page 131

¢ Section 6.27, “Action - Run Script,” on page 136

¢ Section 6.28, “Action - Start/Stop Service,” on page 142

¢ Section 6.29, “Action - Store Personality,” on page 143

¢ Section 6.30, “Action - Terminate Application,” on page 145

¢ Section 6.31, “Action - Terminate Application Prompt,” on page 146
¢ Section 6.32, “Action - Undo Install Actions,” on page 148

¢ Section 6.33, “Action - Uninstall Bundle,” on page 148

¢ Section 6.34, “Action - Verify Bundle,” on page 149

¢ Section 6.35, “Action - Verify Install Actions,” on page 150

¢ Section 6.36, “Requirements,” on page 151

6.1 Action - Apply Personality

The Apply Personality page lets you specify the personality migration template and the Platform
Neutral Package (PNP) file to be used for the migration. You can also specify the specific
requirements that a device must meet for the action to be executed on the device

For more information on personality migration template, see ZENworks 11SP3 Personality Migration
Reference.
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6.1.1

Figure 6-1 Action - Apply Personality Dialog Box

Add Action - Apply Personality

Action Name: * |Apply Personality |

General Requirements

Specify the template to be used for migration *

{2}t Upload a template from this device:

|

O specify a template on the managed device:

(e.g. C:\Templates\PersonalityMigrationTemplate.xml)

Path from where the PNP file is to be loaded *

(e.g. Ciwuserpersonalibp\EUSERNAME. pnp)

[ password to decrypt the PNP file
Enter password

Fields marked with an asterisk are required.

oK | [ cancel

You can access this information by using the following methods:

¢ As part of the process of creating a Window bundle by using the Apply Personality bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click the Add drop-down list, then select
the Apply Personality action.

The following sections contains additional information:

¢ Section 6.1.1, “General,” on page 69

¢ Section 6.1.2, “Requirements,” on page 70

General

The General page lets you specify the personality migration template and the Platform Neutral
Package (PNP) file to be used for the migration.

Upload a template from this device

Select this option and click |4/ to display the Upload content dialog box. Browse to and select the
template to upload.
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6.1.2

6.2

Specify a template on the managed device

Select this option to specify the path of personality migration template file on the managed device.
You can also specify the UNC path of the file.

Path from where the PNP file is to be loaded

Specify the path of the PNP file containing the migration settings and data on the managed device.
You can also specify the UNC path of the file.

Password to decrypt the PNP file

Select this check box to enter the password to decrypt the PNP file.

NOTE: If you spanned the PNP file, be sure to keep the spanned files and the PNP file in the same
folder.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Copy Directory

The Action - Copy Directory dialog box lets you specify the directory to be copied and its destination
directory. You can also specify the executable security level and the specific requirements that a
device must meet for the action to be executed on the device.

NOTE: Copying a file or directory copies the file or directory from one location to another without
uploading the files into the ZENworks content repository. Copying a file or directory is described as
copying without using content. When copying a file or directory, the managed device performs the
copy operation and must be able to resolve both the source and destination paths. Also, when
copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it
is distributed to assigned devices. Installing a file or directory is described as copying using content.
When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must
add a launch executable action (Launch Windows Executable, Launch Java Application, and so forth)
to the bundle.
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Figure 6-2 Action - Copy Directory Dialog Box

Add Action - Copy Directory
Action Mame: * | Copy Directory |
General Requirements

Source Directory: *
Install the Novell File Upload extension to browse for a directory

The path must be resolved by the device on which the bundle is rum.

Destination Directory: * |

The path must be resolved by the device on which the bundle is run.

Copy Option: |Cop3.r Always hd
attributes: Cwidden
[ read-only

Executable security level
@ Run as logged in user
O Run as secure system user (Don't allow system to interact with desktop)

O Run as dynamic administrator

Select credential for network access: |

Fields marked with an asterisk are required.

[ oK [ Cancel ]

You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the Copy Directory bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundies list, click the Actions tab, click one of the action set tabs (Distribute
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.2.1, “General,” on page 71

¢ Section 6.2.2, “Requirements,” on page 73

General

The General page lets you specify the source directory, destination directory, copy option, and the
executable security level.

Actions
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Source Directory

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse for a directory. For more information, see Section F.1, “Installing the Novell
ZENworks File Upload Plug-in,” on page 249.

Click Browse to display the Browse for Folder dialog box. Browse to and select the directory to copy.

Destination Directory

Specify the destination path on the device where you want to copy the directory.

Copy Option
Select a copy option from the list:

Copy Always: Copies the content of the directory regardless of whether the files currently exist on
the workstation.

Copy If Exists: Copies the content of the directory only if the files currently exist on the workstation.

Copy If Does Not Exist: Copies the content of the directory only if the files does not currently exist
on the workstation.

Copy If Newer: Copies the content of the directory only if the modified date and time of the file is
newer than the existing file’s date and time, or if the files do not currently exist on the workstation.

Copy If Newer and Exists: Copies the content of the directory only if it already exists on the
workstation and the existing file has an older modification date or time.

Copy if Newer Version: Copies the content of the directory only if the internal version of the file is
newer than the existing file’s version (if version information is present).

Request Confirmation: Prompts the user to confirm that the content of the directory should be
copied when the directory already exists on the workstation.

Copy If Different: Copies the content of the directory if the creation date, creation time, or size of the
file is different than the existing file’s date, time, or size.

Attributes

Select one or more of the following attributes:
Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.

Read-only: Select the Read-only check box to specify that the directory is read-only after being copied.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:
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6.3

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has
the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don't allow system to interact with desktop): The application is run
under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to Secure,
the application's interface is not displayed to the user and the application is only visible in the Task
Manager. This option is useful when running applications that require full access to the workstation
but require no user intervention. If you use mapped network drives to specify files and directories,
the action fails because system users do not have access to user mapped drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is created
on the fly to perform certain procedures, such as installing applications. Using a dynamic
administrator is helpful when installing applications (some MSI applications, for example) that
cannot be installed in the system space. When you select this action, the dynamic administrator is
created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the
UNC path or network share that can be accessed only through credentials, then browse through the
credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS) share.

For more information on Credential Vault and adding credential to the Credential Vault, see “Using
the Credential Vault” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Copy Files

The Action - Copy Files dialog box lets you specify files to copy to the device and the specific
requirements that a device must meet for the action to be executed on the device.
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Figure 6-3 Action - Copy Files Dialog Box

Add Action - Copy File(s) x

fction Mame: * |C|:upy Fileis) |

General Require ments

File Details

D File Hame =« Read Only Hidden Copy Option
[ iexplore.exe falze falze Copy Always

Executable security level
® Run a= logged in user

' Run as secure system user [(Don't allow system to interact with desktop)

O Run a= dvnamic administrator

Select credential for network access:

Fieldz marked with an azterzk are reguired.

DK | | Cancel

You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the Copy Files bundle category. For
more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute,
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.3.1, “General,” on page 74

¢ Section 6.3.2, “Requirements,” on page 76

6.3.1 General

The General page lets you specify the files to copy to the device and the executable security level.
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File Details

Click Add to display the Select Files dialog box. Click the Help button for more information.

Edit File Details

The Edit File Details dialog box page lets you specify a copy option, the complete path of the source
file to be copied, the path of the destination file, and whether the file is hidden or read-only after
being copied to the device. Click any of the file names in the File Details dialog box to go to the Edit
File Details dialog box.

Figure 6-4 Action - Edit File Details Dialog Box

Edit File Details - iexplorer.exe
Source File Mame:™ |C:"-,F"r|:|gram Files\internet Explareniexplarer.exel |
Destination File Name: ™ |D:"-,MyApplicatiu:una'\,lnternet Explurer’\,ie.exe'\,iexplure|

The path must be resolved by the device on which the bundle is run,

[l create shortcut for the source file(s)

Copy Option: |CDpyAIways V|
Attributes: [ Hidden
Ll read-only

OK | | Cancel

Renaming the source file: To copy the source file to the destination directory with a different name,
specify the new name along with the destination path in the Destination File Name field in the Edit File
Details dialog box.

For example, to copy run.exe from C:\Program Files\Internet Explorer) toD:\My
Applications\Internet Explorer\ie.exe,use ie.exe asthe new name you specify in the
Destination File Name field in the Edit File Details dialog box.

Copy Option: Select a copy option from the list. For details, see Copy Option in the Action - Copy
Directory section.

Attributes: Select one or more of the following attributes:

¢ Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.

¢ Read-only: Select the Read-only check box to specify that the directory is read-only after being
copied.
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6.3.2

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has
the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don't allow system to interact with desktop): The application is run
under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to Secure,
the application's interface is not displayed to the user and the application is only visible in the Task
Manager. This option is useful when running applications that require full access to the workstation
but require no user intervention. If you use mapped network drives to specify files and directories,
the action fails because system users do not have access to user mapped drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is created
on the fly to perform certain procedures, such as installing applications. Using a dynamic
administrator is helpful when installing applications (some MSI applications, for example) that
cannot be installed in the system space. When you select this action, the dynamic administrator is
created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the
UNC path or network share that can be accessed only through credentials, then browse through the
credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS) share.

For more information on Credential Vault and adding credential to the Credential Vault, see “Using
the Credential Vault” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.
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6.4

Action - Create/Delete Directory

The Action - Create/Delete Directory dialog box lets you create or delete a directory on the managed
device and define the specific requirements that a device must meet for the action to be executed on
the device.

The Delete Directory action deletes the entire folder along with its inner files and folders; it also deletes
the folders that are in the hidden mode.

Figure 6-5 Action - Create/Delete Directory Dialog Box

Add Action - Create/Delete Directory

Action Mame: *  |Create/Delete Directory

General Requirements

Action Type: ® Create directory

O Delete directory

Install the Movell File Upload extension to browse for a directory

Directory Mame: *

The path must be resolved by the device on which the bundle is run.
Executable security level
& Run as logged in user
 Run as secure system user (Don't allow system to interact with desktop)

C Run as dynamic administrator

Select credential for network access:

Fields marked with an asterisk are required.

[ oK | [ cancel |

You can access this information by using the following methods:
¢ As part of the process of creating a Windows bundle by using the Create/Delete Directory bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundies list, click the Actions tab, click one of the action set tabs (Distribute,
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.4.1, “General,” on page 78

¢ Section 6.4.2, “Requirements,” on page 79
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6.4.1

General

The General page lets you specify the name of the directory to create or delete from the managed
device and the executable security level.

Create Directory

Creates a directory on the managed device when the action is performed.

Delete Directory

Deletes a directory on the managed device when the action is performed.

Directory Name

Specify the complete path of the directory you want to create or delete on the managed device.This
path must be resolved by the device on which the bundle is run.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The action uses the logged-in user’s credentials. For example, the action

has the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don't allow system to interact with desktop): The application is
run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention.If you use mapped network drives to specify
files and directories, the action fails because system users do not have access to user mapped
drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is
created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. When you select this action, the dynamic
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of
the UNC path or network share that can be accessed only through credentials, then browse
through the credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DES) share.
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6.4.2

6.5

6.5.1

For more information on Credential Vault and adding credential to the Credential Vault, see
“Using the Credential Vault” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Delay
The Action - Delay dialog box lets you specify a system delay between two actions in the action set
and the specific requirements that a device must meet for the action to be executed on the device.

Figure 6-6 Action - Delay Dialog Box

Add Action - Delay X|

Action Name: * |Delay

General Requirements
To configure the time delay
@ Delay for a specific time
Time Delay: |5 % {in Seconds )

To configure maximum time delay and Processess Services to start

O Wwait for processes or services to start

List of Processes & Services:

Edit...

Remove

taximurn Time to Wait: % [in Seconds )

Fields marked with an asterisk are required.

oK | [ cancel

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.5.1, “General,” on page 79

¢ Section 6.5.2, “Requirements,” on page 80

General

The General page lets you specify a system delay between two actions in the action set.
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6.5.2

80

6.6

Delay for a Specific Time

Specify the desired time delay, in seconds. After completing the action, the system delays for the
specified amount of time before performing the next action.

Wait for Processes or Services to Start

Specify the processes or services that must start before the next action in the action set is performed.
To add a process or service to the list:

1 Click Add to display the Add Service/Process dialog box.

2 Select Process, specify the process that must start before performing the next action, then click
OK. You can specify either the name of the process or its full path. For example, you can specify
notepad.exe Or ${SystemRoot } \system32\notepad.exe.

or
Select Service, specify the service that must start before performing the next action, then click OK.
3 Repeat Step 2 as needed.

4 Specify the maximum amount of time to wait for the process or service to start before
performing the next action in the action set. If the process or service does not start in the
specified amount of time, the next action is performed.

5 Click OK.

Click Edit to change a process or service, or click Remove to delete a process or service.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Display Message

The Action - Display Message dialog box lets you specify a message to display on devices when the
action is performed and the specific requirements that a device must meet for the action to be
executed on the device.
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Figure 6-7 Action - Display Message Dialog Box
Add Action - Display Message X

Action MName: *  Display Message

General Requirements

Define Promitisl

Locale Prompt

No items available.

*Required

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.6.1, “General,” on page 81

¢ Section 6.6.2, “Requirements,” on page 82

General

The General page lets you specify a message to display on devices when the action is performed.

Define Prompts

Define the prompt that you want to display on the device. Additionally, you can specify different
locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the
prompt defined in the same locale as the operating system locale. However, if the operating system
locale does not match any of the specified locales, then ZENworks displays the prompt defined by
the first locale in the list.
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6.6.2

6.7

6.8

6.8.1

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the
specified locale. You can create different messages, each with its own locale setting.

3 Specify the text you want to display on the device.

NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a
message on a new line, you must use a <br> tag before the message.

You can include {0} in your text to provide a running counter that counts down the number of
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the
following text:

Please save your work and close any open applications.
The message displays for the number of seconds specified in the Seconds to be Displayed field.
4 Click OK.

Click Edit to change the prompt, or click Remove to delete the prompt.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Distribute Files

The Distribute Files Action distributes the content of the bundle from the ZENworks Server to the
managed device or user. There are no configuration tasks that you need to perform for this action.

Action - Edit INI File

The Action - Edit INI File dialog box lets you specify a configuration file and configure the list of
changes to be performed on the file. You can also create a file, if one does not exist. You can also
specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contain additional information:

¢ Section 6.8.1, “General,” on page 82
¢ Section 6.8.2, “Advanced,” on page 86

¢ Section 6.8.3, “Requirements,” on page 87

General

The General page lets you specify a configuration file and configure the list of changes to be
performed on the file. You can also create a file, if one does not exist.
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Filename

Specify the file that you want to change. For example, C: \Program Files\OpenOffice.org
2.0\program\setup.ini.

Encoding

Specify the encoding that you want to use:

Auto detect: Use the encoding used in the original file that you specified in the Filename field. This
is the default option.

ASCII: Use ASCII encoding.
Unicode: Use Unicode encoding.

UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

Create File, If Does Not Exist

Specify whether you want to create the file specified in the Filename field, if it does not exist. The file
is created with the same name and the extension as specified in File Path. If the file specified in File
Path does not have an extension, then the created file also does not have any extension.

If this option is selected and Encoding is set to Auto detect, the file is created in UTF-8 format with the
same name and the extension as specified in File Path.

INI Changes

The INI Changes page lets you specify the INI file to change, add sections to the file, add keys to a
section in the file, and import changes from another INI file.
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Figure 6-8 Action - Edit INI File Dialog Box - General Tab

Add Action - Edit INI File

Action Name: = |EditINI File] |

General Advanced Requirements

Specify a configuration file and configure the changes to be performed on the file.

File path: * | |

[e.g. C:\Program Files\OpenOffice.org 3wprogramisetup.ini]

Encoding: Auto detect

[ create file, if does not exist

Add = Edit -~ Import

5 I Changes

Fields marked with an asterisk are required.

OK | | Cancel

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs

(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following table lists the tasks you can perform to manage INI changes.

Table 6-1 INI Tasks

Task Steps Additional Details

Specify the INI file to 1. Specify the file that you want to For example, C:\Program
change change. Files\OpenOffice.org
2.0\program\setup.ini.
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Task

Steps

Additional Details

Add a section

Add keys to a
section

Edit an INI Change

Remove a section or
keys

Import INI changes
from another file

Change the order of
items

Select all the objects
of a parent folder

Deselect all the
objects of a parent
folder

Clear Selection

1. Click Add, then click New Section

Change to open the Add a Change
dialog box.

. Fill in the fields, then click OK.

Click the Help button for additional
information.

. Click the section to which you want

to add the keys.

. Specify the keys to be added to the

section in the INI file. Type the key,
such as key1 or keyl=valuel, then
click Add to move the key to the
list.

You can edit or remove an entry, or
you can use the Move Up and
Move Down buttons to order the
list. The changes to the file are
made in the order listed.

. Click the desired item you want to

edit. The Add a Change dialog box
is displayed.

. Select the check box next to the

desired item, then click Delete.

. Click Import to display the Import

INI Changes from File dialog box.

. Specify the file from which you

want to import changes, then click
OK.

. Select the check box next to an

item, click Edit, then select an
option (Sort, Move Up, Move
Down).

. Select the check box next to the

parent folder, then click Edit >
Select All Children.

. Select the check box next to the

parent folder, then click Edit >
Deselect All Children.

. Click Edit > Clear Selection.

If you specify an existing section and
add new keys to the list, then the
existing section is updated with the
newly added keys. For example, if a
section sectl with k1=v1 already exists
and if you specify a new section sectl
with k1=v1, k2=v2, then the newly
added key k2=v2 is added to sectl.

The Section Change Type configured
for the section is displayed by default in
the Add Change dialog box.

Run Action As: Specify System (the default) or User from the Run Action As list. Specify System if
removing files requires access to all areas of the device’s file system. If you use mapped network

drives to specify files and directories, you must run the action as User.
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6.8.2

Advanced

The Advanced page lets you create the file (if it does not exist), specify the number of backup files to
retain, and specify key-value separators and comment characters.

Figure 6-9 Action - Edit INI File Dialog Box - Advanced Tab

Add Action - Edit INI File

Action Name: * | EdlitINI File |

General Advanced Requirements

File Backup(s) to Retain: % [1 ta 25]

Key-Walue Separator: |=

Walue Separator: |<spac:e>

K [« [«

Comment Character; |,'

Ol append key-value separator to the key when value is not available

Run Action As:

Mote: To edit IMI files on mapped drives, run the action as User.

Fields marked with an asterisk are required.

OK | | Cancel

Create File, If Does Not Exist: Specify whether you want to create the file specified in the Filename
field, if it does not exist.

Number of File Backup(s) to Retain: Specify the number of backups of the INI file to retain. The
default is 5 backup copies, but you can specify any number between 1 and 25. When the number of
backup copies of the file exceeds the number specified here, the oldest backup file is overwritten.

Key-Value Separator: Specify the character you want to separate key values. You can use an equals
sign (=) or a colon (:).

Value Separator: Specify the character you want to separate the multiple values. You can use
characters such as equals sign (=), comma(,), space( ), hash (#), semicolon (;) or a colon (:).

Comment Character: Specify the character you want precede comments in the INI file. You can use a
semicolon (;) or a pound sign (#).
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6.9

Append key-value separator to the key when value is not available: Select this option to append
the key-value separator to the key even if the value is not available. For example, in the setup.ini file

used by Acrobat Reader®, the CmdLine key does not have a value but requires a key-value separator.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Edit Text File

The Action - Edit Text File dialog box lets you specify a file and configure the list of changes to be

performed on the file. You can also create a file, if one does not exist. You can also specify the specific
requirements that a device must meet for the action to be executed on the device.

Figure 6-10 Action - Edit Text File Dialog Box

Add Action - Edit Text File

Action Mame: * | Edit Text File|

General Requirements

File Mame: *

File Backupis) to Retain: 5 = [1 10 25]
Encoding: Auto detect W

File Operation: Specify contents of the file |

{e.g. HiystemOrive]P rogram Filesimyfile txt)

Impart content from the File:

Contents of the File: *

Dcreate file, if does not exist

RUR Action As: Spstem W

Mote: To edit filez on mapped drives, run the action as User.

Figlds marked with an asterizk are required.

T el

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs

(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,

then select an available action.
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6.9.1

The following sections contains additional information:

¢ Section 6.9.1, “General,” on page 88

¢ Section 6.9.2, “Requirements,” on page 89

General

The General page lets you specify a file and configure the list of changes to be performed on the file.
You can also create a file, if one does not exist.

Filename

Specify the file that you want to change. For example, ${SystemDrive}\Program
Files\myfile.txt.

File Backup(s) to Retain

Specify the number of backups of the text file to retain. The default is 5 backup copies, but you can
specify any number between 1 and 25. When the number of backup copies of the file exceeds the
number specified here, the oldest backup file is overwritten.

Encoding

Specify the encoding that you want to use:
¢ Auto detect: Use the encoding used in the original file that you specified in the Filename field.
This is the default option.
¢ ASCII: Use ASCII encoding.
¢ Unicode: Use Unicode* encoding.
¢ UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

File Operation > Specify Contents of the File

Use this option to specify the contents of the text file.
¢ Import Contents from an Existing File on this Device: Browse to and select the text file from
which you want to import its contents.
¢ Contents of the File: Specify the contents of the newly created file.

¢ Create File, If Does Not Exist: Specify whether you want to create the file specified in the
Filename field, if it does not exist. If this option is selected and Encoding is set to Auto detect, the
file is created in UTF-8 format with the same name and the extension as specified in File Path.

File Operation > Specify Changes to the File

Use this option to specify the changes to the text file.

¢ Change List: Specify the changes that you want to make to the text file. Click Add to open the
Add a Change dialog box, fill in the fields, then click OK. Click the Help button for additional
information.
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You can edit or remove an entry, or you can use the Move Up and Move Down buttons to order the
list. The changes to the file are made in the order listed.

¢ Create File, If Does Not Exist: Specify whether you want to create the file specified in the
Filename field, if it does not exist.

+ Contents of the File: If you selected the Create File, If Does Not Exist check box, specify the
contents of the newly created file that is created if the specified file does not exist.

¢ Apply Changes Configured in the Change List: Specify whether you want to apply the
changes that you added to the Change List box to the newly created file.

Run Action As

On Windows, specify System (the default) or User from the Run Action As list. Specify System if
removing files requires access to all areas of the device’s file system. If you use mapped network
drives to specify files and directories, you must run the action as User.

On Linux, specify root (the default) or User from the list. Specify root only if the managed devices are
run by the root user.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - End Process

The Action - End Process dialog box lets you specify the executable name of the process that you
want to stop (for example, notepad, mspaint, winword, and so forth). If the process is not running on
the device, the End Process task completes. You can also specify the specific requirements that a
device must meet for the action to be executed on the device.
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6.10.2

Figure 6-11 Action - End Process Dialog Box
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Process to Stop: ™© |
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OK | | Cancel

To access this information in ZENworks Control Center, click the Bundles tab. Click the underlined
link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set
tabs (Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down
list, then select an available action.

The following sections contains additional information:

¢ Section 6.10.1, “General,” on page 90

¢ Section 6.10.2, “Requirements,” on page 90

General
The General page lets you specify the executable name of the process that you want to stop (for

example, notepad, mspaint, winword, and so forth). If the process is not running on the device, the
End Process task completes.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.
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6.11 Action - File Removal

The Action - File Removal dialog box lets you specify files or directories to remove from the device
and the specific requirements that a device must meet for the action to be executed on the device.

Figure 6-12 Action - File Removal Dialog Box
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To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

You can use this action to perform an automated system cleanup. For example, you can specify that
the c:\windows\Temp\Temporary Internet Files directory and all files matching
c:\windows\Temp\*.log in are removed from the device.

On a Windows managed device, you cannot remove read-only files. If you specify a directory that
contains several files (including some read-only files), the directory and the read-only files are not
removed when the File Removal action runs. The files that are not read-only, however, are removed
from the Windows device.

Actions 91



6.11.1

6.11.2

The following sections contains additional information:

¢ Section 6.11.1, “General,” on page 92

¢ Section 6.11.2, “Requirements,” on page 92

General

The General page lets you specify files or directories to remove from the device.

Full Path to Source Files/Directories

Specify the full path to the file or directory that you want to remove, then click Add to add the file or
directory to the list. You can use wildcard characters. If you use a mapped network drive to specify
the path, you must select User from the Run Action As list.

Include System Files

Select this option to remove system files. If you specify a directory for removal that includes both
system and non-system files, only non-system files are deleted, unless you specify this option.

Delete Folder Only if Empty

Select this option if you want to remove the specified folders only if they are empty.

When a File is Locked, Retry _ Times, Every _ Seconds

If a file is locked when the action is performed, the file cannot be removed. Select the check box and
then specify the number of retry attempts and the time interval between attempts. By default, the
action is retried 3 times with 5 seconds between each attempt.

Run Action As

On Windows, specify System (the default) or User from the Run Action As list. Specify System if
removing files requires access to all areas of the device’s file system. If you use mapped network
drives to specify files and directories, you must run the action as User, else the action fails because
system users do not have access to user mapped drive.

On Linux, specify root (the default) or User from the list. Specify root only if the managed devices are
run by the root user.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.
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6.12

6.12.1

Action - Install Bundle

The Action - Install Bundle dialog box lets you browse to and select the bundle to install on the
device. The bundle is installed on the device even if it has not been previously assigned to that
device. You can also specify the specific requirements that a device must meet for the action to be
executed on the device.

Figure 6-13 Action - Install Bundle Dialog Box

Add Action - Install Bundle HE-
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Select the bundle to install:

Bundle: | E

Fields marked with an azterzk are required.

DK | | Cancel

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.12.1, “General,” on page 93

¢ Section 6.12.2, “Requirements,” on page 94

General

The General page lets you browse to and select the bundle to install on the device. The bundle is
installed on the device even if it has not been previously assigned to that device.

Click [&] to browse to and select the bundle to install on the device.
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The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the
down arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types
of bundles are displayed. If you know the name of the bundle you are looking for, you can use the
Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.7,
“Dependency Bundles,” on page 175.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Install Directory

The Action - Install Directory dialog box lets you specify the directory to be installed, specify a
destination path, specify whether the directory is hidden or read-only after being installed on the
device, and specify a copy option. You can also use this page to install the Novell ZENworks File
Upload plug-in, which allows you to browse for directories. You can also specify the specific
requirements that a device must meet for the action to be executed on the device

Copying a file or directory copies the file or directory from one location to another without
uploading the files into the ZENworks content repository. Copying a file or directory is described as
copying without using content. When copying a file or directory, the managed device performs the
copy operation and must be able to resolve both the source and destination paths. Also, when
copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it
is distributed to assigned devices. Installing a file or directory is described as copying using content.
When installing a file or directory, the file or directory is cached on the managed device. If a directory
does not have any content, it is not uploaded to the content repository. This causes any successive
action depending on this empty directory to fail.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must
add a launch executable action (Launch Executable, Launch Java Application, and so forth) to the
bundle.
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Figure 6-14 Action - Install Directory Dialog Box
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You can access this information by using the following methods:
¢ As part of the process of creating a Windows bundle by using the Install Directory bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute,
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.13.1, “General,” on page 95

¢ Section 6.13.2, “Requirements,” on page 98

6.13.1 General

The General page lets you specify the directory to be installed, specify a destination path, specify
whether the directory is hidden or read-only after being installed on the device, and specify a copy
option. You can also use this page to install the Novell ZENworks File Upload plug-in, which allows
you to browse for directories.

Actions 95



96

Source Directory

Click [&] to browse to and select the directory you want to install on the device.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse to and upload directories to be installed. For more information, see Novell
ZENworks File Upload Plug-in.

Select Directory

Source Directory:

| Browse

DDD not compress or encrypt uploaded content

DUpIDad all filez within the source directory az a single package
Thiz selting iz applicable for agends Mat hase ZEMNworks 17 5P or later

Status:

(1] | | Cancel

By default, the content uploaded to the ZENworks content repository is encrypted and compressed
before it is distributed to assigned devices. However, if you do not want the content to be encrypted
and compressed, then select the Do not compress or encrypt uploaded content option.

Select the Upload all files within the source directory as a single package option to enable all the files within
the specified source directory to be uploaded as a single content. This option is helpful in scenarios
where you choose to upload a large number of files. For example, selecting a Microsoft Office
application as a source directory.

Upload Files As

Specifies whether the content has been uploaded as a single content or multiple contents to the
ZENworks content repository.

If the Upload all files within the source directory as a single package option in the Select Directory dialog
box is not selected, then the files are uploaded by packaging in to multiple contents and the value of
Upload Files As option is displayed as Multiple Content.

If the Upload all files within the source directory as a single package option in the Select Directory dialog
box is selected, then the files are uploaded by packaging in to single content and the value of Upload
Files As option is displayed as Single Content.

Packaging
Specifies how the content is packaged before it is distributed to assigned devices.

If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is not
selected, the value of Packaging option is initially displayed as Auto as the content is in the process of
being encrypted and compressed. After the content has been encrypted and compressed, the value of
Packaging option changes to Compressed, Encrypted.

ZENworks 11 SP3 Software Distribution Reference



If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is selected,
the value of Packaging option is displayed as None because the content is neither compressed nor
encrypted.

Destination Directory

Specify the destination directory on the device in which you want to install the directory.

Hidden

Select the Hidden check box to specify that the directory is hidden after installation.

Read-Only

Select the Read-only check box to specify that the directory is read-only after installation.

Copy Option
Select a copy option from the list:

+ Copy Always: Copies the contents of the directory regardless of whether the files currently
exists on the workstation.

+ Copy If Exists: Copies the contents of the directory only if the files currently exists on the
workstation.

¢ Copy If Does Not Exist: Copies the contents of the directory only if the files does not currently
exist on the workstation.

¢ Copy If Newer: Copies the contents of the directory only if the modified date and time of the file
is newer than the existing file’s date and time, or if the files does not currently exist on the
workstation.

¢ Copy If Newer and Exists: Copies the contents of the directory only if it already exists on the
workstation and the date and time of the file is newer than the existing file’s date and time.

¢ Copy if Newer Version: Copies the contents of the directory only if the internal version of the
file is newer than the existing file’s version (if version information is present).

¢ Request Confirmation: Prompts the user to confirm that the content of the directory should be
copied when the directory already exists on the workstation.

¢ Copy If Different: Copies the contents of the directory if the creation date, creation time, or size
is different than the existing file’s date, time, or size.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The action uses the logged-in user’s credentials. For example, the action
has the same rights to the registry and the file system as the logged-in user.
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¢ Run as secure system user (Don't allow system to interact with desktop): The application is

run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention. If you use mapped network drives to specify
files and directories, the action fails because system users do not have access to user mapped
drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is
created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. When you select this action, the dynamic
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of
the UNC path or network share that can be accessed only through credentials, then browse
through the credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS) share.

For more information on Credential Vault and adding credential to the Credential Vault, see
“Using the Credential Vault” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Install Files

The Action - Install Files dialog box lets you specify the file to copy to the content server and from
content server to the device, the destination directory and filename, and the copy options.You can
also specify the specific requirements that a device must meet for the action to be executed on the
device.
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6.14.1

Figure 6-15 Action - Install Files Dialog Box
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You can access this information by using the following methods:
¢ As part of the process of creating a Windows bundle by using the Install Files bundle category.
For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute,
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.14.1, “General,” on page 99

¢ Section 6.14.2, “Requirements,” on page 102

General

The General page lets you specify the file to copy to the content server and from content server to the
device, the destination directory and filename, and the copy options. Click Add to display the Select
Files dialog box.
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Figure 6-16 Select Files Dialog Box

Select Files
File: *
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The Select Files dialog box lets you specify the files to be copied, specify a destination and source
directory, specify whether the files are hidden or read-only after being copied to the device, and
specify a copy option. You can also use this page to install the Novell ZENworks File Upload plug-in,
which must be installed before you can browse for and upload files.

Copying a file or directory copies the file or directory from one location to another without
uploading the files into the ZENworks content repository. Copying a file or directory is described as
copying without using content. When copying a file or directory, the managed device performs the
copy operation and must be able to resolve both the source and destination paths. Also, when
copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it
is distributed to assigned devices. Installing a file or directory is described as copying using content.
When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must

add a launch executable action (Launch Executable, Launch Java Application, and so forth) to the
bundle.

File

Click Add to display the Select Files dialog box, specify the files you want to copy to the device, then
click Open. Repeat this step as many times as necessary to copy the desired files.

If the Novell ZENworks File Upload plug-in is not installed on this device, you must install it before
you can browse for file paths. For more information, see Appendix F, “Novell ZENworks File Upload
Plug-in,” on page 249.
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By default, the content uploaded to the ZENworks content repository is encrypted and compressed
before it is distributed to assigned devices. However, if you do not want the content to be encrypted
and compressed, then select the Do not compress or encrypt uploaded content option.

Destination Directory

Specify the destination directory on the device in which you want to install the file.

Hidden

Select the Hidden check box to specify that the file is hidden after installation.

Read-Only

Select the Read-only check box to specify that the file is read-only after installation.

Copy Option
Select a copy option from the list:

¢ Copy Always: Copies the file regardless of whether the file currently exists on the workstation.
¢ Copy If Exists: Copies the file only if the file currently exists on the workstation.

¢ Copy If Does Not Exist: Copies the file only if the file does not currently exist on the
workstation.

+ Copy If Newer: Copies the file only if its modified date and time is newer than the existing file’s
date and time, or if the file does not currently exist on the workstation.

+ Copy If Newer and Exists: Copies the file only if it already exists on the workstation and the
date and time of the file is newer than the existing file’s date and time.

¢ Copy if Newer Version: Copies the file only if its internal version is newer than the existing
file’s version (if version information is present).

+ Request Confirmation: Prompts the user to confirm that the file should be copied when the file
already exists on the workstation.

+ Copy If Different: Copies the file if its creation date, creation time, or size is different than the
existing file’s date, time, or size.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The action uses the logged-in user’s credentials. For example, the action
has the same rights to the registry and the file system as the logged-in user.

¢ Run as secure system user (Don't allow system to interact with desktop): The application is
run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
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Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention. If you use mapped network drives to specify
files and directories, the action fails because system users do not have access to user mapped
drives.

¢ Run as dynamic administrator: A dynamic administrator is an administrator account that is
created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. When you select this action, the dynamic
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of
the UNC path or network share that can be accessed only through credentials, then browse
through the credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS) share.

For more information on Credential Vault and adding credential to the Credential Vault, see
“Using the Credential Vault” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.14.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

6.15 Action - Install MSI

102

The Action - Install MSI dialog box lets you specify the location of the MSI file; its Install, Uninstall,
and Repair parameters; the transform file; and the executable security level. You can also specify the
specific requirements that a device must meet for the action to be executed on the device.
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Figure 6-17 Action - Install MSI Dialog Box
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You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the MSI Application bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the

Name column of the Bundies list, click the Actions tab, click one of the action set tabs (Distribute,

Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.15.1, “General,” on page 104

¢ Section 6.15.2, “Requirements,” on page 106
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General

The General page lets you specify the location of the MSI file; its Install, Uninstall, and Repair
parameters; the transform file; and the executable security level.

.msi File

Click [4] to display the Select .msi File dialog box. Browse to and select the .ms1 file to install.

Select the Include all files in and below the directory of this file option to include all the supporting files
that are within the directory containing the .ms1 file and the subdirectories within it.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse to and upload files. For more information, see Appendix F, “Novell
ZENworks File Upload Plug-in,” on page 249.

Install Parameters

Click [i& to display the Install Parameters dialog box, then specify the desired parameters. Click the
Help button for additional information.

Uninstall Parameters

Click [i& to display the Uninstall Parameters dialog box, then specify the desired parameters. Click
the Help button for additional information.

Repair Parameters

Click |iE to display the Repair Parameters dialog box, then specify the desired parameters. Click the
Help button for additional information.

Transform File

Click Add to browse to and select the desired transform file. You can upload the transform file or you
can specify its location.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse for a file path. For more information, see “Novell ZENworks File Upload
Plug-in” on page 249.

Different groups within an organization often use the same application, but they might not require
the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 10
different feature sets or other alterations for the same application, you can deploy the same MSI
package to all 10 user groups, but with a different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification
information, such as whether features are installed; how they are installed; which files, shortcuts, and
registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create
and manage transforms.
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MSI Properties

The MSI package contains the property values that were defined during the administrative
installation of the application. These property values determine the way the Microsoft Windows
Installer installs the application to the workstation. In some cases, you might want to change one or
more of the property values. For example, a property value might define the default location for a
user’s work files. By adding the property to the list and changing the property’s value, you can
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing
so, you should be careful to add only those properties that are valid for the package. The following
options are available:

¢ Add: To override a property value, you change the property value and add the property to the
Properties list so that Application Launcher knows to use that property value rather than the one
defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In the
Name field, select the property whose value you want to override, specify the new value in the
Value field, then click OK to add the property to the MSI Properties list.

¢ Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, modify
the value data, then click OK.

¢+ Remove: To remove a property from the MSI Properties list, select the property, then click
Remove. Deleting the property causes future installations of the application to use the property
value defined in the MSI package.

IMPORTANT: The total length of the MSI Properties and the Install Parameters should not exceed 1024
characters.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The MSI application inherits the logged-in user’s credentials. For
example, the application has the same rights to the registry and the file system as the logged-in
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden
mode, the application runs normally without a user interface available. This is useful if you want
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges to
the logged-in user. However, providing administrator privileges to a user might pose security
risks. If this option is selected, the user on the managed device is prompted to enter the
password when the MSI is installed on the device. To install the MSI, the user must log in to the
device with a user account that has a password configured.
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6.16

NOTE: On a Vista device, if the administrator is logged in to the device and the Grant
administrator privilege to user during installation is selected, the action is performed in the quiet
mode.

Run as secure system user (Don't allow system to interact with desktop): The application is
run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention.

Run as dynamic administrator: A dynamic administrator is an administrator account that is
created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. When you select this action, the dynamic
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Install MSP

The Action - Install MSP dialog box lets you specify the location of the MSP file, command line
parameters, and executable security level. You can also specify the specific requirements that a device
must meet for the action to be executed on the device.
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Figure 6-18 Action - Install MSP Dialog Box
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You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the MSP Application bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute,

Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then
select an available action.

The following sections contains additional information:

¢ Section 6.16.1, “General,” on page 107
¢ Section 6.16.2, “Requirements,” on page 108

General

The Action - Install MSP dialog box lets you specify the location of the MSP file, command line
parameters, and executable security level.
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.msp File

Click [&] to display the Select .msp File dialog box. Browse to and select the MSP file. You can also
enter the UNC path of the .msp file for a network install.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse for a file path. For more information, see Appendix F, “Novell ZENworks File
Upload Plug-in,” on page 249.

Command Line Parameters

Specify the command line parameters that you want to run when the MSP file is installed.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The MSI application inherits the logged-in user’s credentials. For

example, the application has the same rights to the registry and the file system as the logged-in
user.

Select the application’s initial window size: Normal, Minimized, Maximized, or Hidden. In Hidden
mode, the application runs normally without a user interface available. This is useful if you want
the application to process something then go away without user intervention.

Run as secure system user (Don't allow system to interact with desktop): The application is
run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention.

Run as dynamic administrator: A dynamic administrator is an administrator account that is
created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. When you select this action, the dynamic
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.
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Action - Install Network MSI

The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install,
Uninstall, and Repair parameters; transform file; and executable security level. You can also specify
the specific requirements that a device must meet for the action to be executed on the device.

Figure 6-19 Action - Install Network MSI Dialog Box
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The following sections contains additional information:

¢ Section 6.17.1, “General,” on page 110

¢ Section 6.17.2, “Requirements,” on page 112

Actions

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,

then select an available action.
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General

The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install,
Uninstall, and Repair parameters; the transform file; and the executable security level.

.msi File

Specify the .msti file to install.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse for a file path. For more information, see “Novell ZENworks File Upload
Plug-in” on page 249.

Install Parameters

Click [i& to display the Install Parameters dialog box, then specify the desired parameters. Click the
Help button for additional information.

Uninstall Parameters

Click & to display the Uninstall Parameters dialog box, then specify the desired parameters. Click
the Help button for additional information.

Repair Parameters

Click [i& to display the Repair Parameters dialog box, then specify the desired parameters. Click the
Help button for additional information.

Transform File

Click Add to browse to and select the desired transform file. You can upload the transform file or you
can specify its location.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you must do so
before you can browse to for a file path. For more information, see Appendix F, “Novell ZENworks
File Upload Plug-in,” on page 249.

Different groups within an organization often use the same application, but that doesn’t mean they
require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups
needing 10 different feature sets or other alterations for the same application, you can deploy the
same MSI package to all 10 user groups, but with a different transform file (MST) applied for each

group.
A transform file is a collection of changes applied to an MSI installation. It contains all modification

information, such as whether features are installed; how they are installed; which files, shortcuts, and
registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create
and manage transforms.
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MSI Properties

The MSI package contains the property values that were defined during the administrative
installation of the application. These property values determine the way the Microsoft Windows
Installer installs the application to the workstation. In some cases, you might want to change one or
more of the property values. For example, a property value might define the default location for a
user’s work files. By adding the property to the list and changing the property’s value, you can
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing
so, you should be careful to add only those properties that are valid for the package. The following
options are available:

¢ Add: To override a property value, you change the property value and add the property to the
Properties list so that Application Launcher knows to use that property value rather than the one
defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In the
Name field, select the property whose value you want to override, specify the new value in the
Value field, then click OK to add the property to the MSI Properties list.

¢ Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, modify
the value data, then click OK.

¢+ Remove: To remove a property from the MSI Properties list, select the property, then click
Remove. Deleting the property causes future installations of the application to use the property
value defined in the MSI package.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable
can run in either the “user” space or the “system” space. By default, the Run normal option is selected,
which causes the application to run in the “user” space and inherit the same workstation security
level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the
application, you can configure the application to run in the “system” space or as a dynamic
administrator, as described below:

¢ Run as logged in user: The MSI application inherits the logged-in user’s credentials. For
example, the application has the same rights to the registry and the file system as the logged-in
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden
mode, the application runs normally without a user interface available. This is useful if you want
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges to
the logged-in user. However, providing administrator privileges to a user might pose security
risks. If this option is selected, the user on the managed device is prompted to enter the
password when the MSI is installed on the device. To install the MSI, the user must log in to the
device with a user account that has a password configured.

NOTE: On a Vista device, if the administrator is logged in to the device and the Grant
administrator privilege to user during installation is selected, the action is performed in the quiet
mode.

¢ Run as secure system user (Don't allow system to interact with desktop): The application is
run under the Local System user and inherits Administrator-level credentials. For example, the
application has full rights to the registry and the file system. Because the security level is set to
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Secure, the application's interface is not displayed to the user and the application is only visible
in the Task Manager. This option is useful when running applications that require full access to
the workstation but require no user intervention.

¢ Run as dynamic administrator: A dynamic administrator is an administrator account that is
locally created on the fly to perform certain procedures, such as installing applications. Using a
dynamic administrator is helpful when installing applications (some MSI applications, for
example) that cannot be installed in the system space. Because the dynamic administrator does
not have access to the network, the network shares on which the MSI is available must be made
publicly accessible. When you select this action, the dynamic administrator is created, it
performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic
administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of
the UNC path or network share that can be accessed only through credentials, then browse
through the credential vault to select a credential that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS) share.

For more information on Credential Vault and adding credential to the Credential Vault, see
“Adding a Credential” in the ZENworks 11 SP3 ZENworks Control Center Reference.

NOTE: Performing this action as a dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.17.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

6.18 Action - Launch Bundle

The Action - Launch Bundle dialog box lets you specify the bundle to launch on the device. You can
also specify the specific requirements that a device must meet for the action to be executed on the
device.

Figure 6-20 Action - Launch Bundle Dialog Box

‘‘‘‘‘
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6.18.1

6.18.2

6.19

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.18.1, “General,” on page 113

¢ Section 6.18.2, “Requirements,” on page 113

General

The General page lets you specify the bundle to launch on the device. Click [&] to display the Select
the Bundle to Launch dialog box.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the
down- arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types
of bundles are displayed (Linux, Preboot, and Windows bundles). Also, if you know the name of the
bundle you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.7,
“Dependency Bundles,” on page 175.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Launch Java Application

The Action - Launch Java Application dialog box lets you configure a Java program to be executed on
the managed device. You can also specify the specific requirements that a device must meet for the
action to be executed on the device.
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Figure 6-21 Action - Launch Java Application Dialog Box
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To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.19.1, “General,” on page 114

¢ Section 6.19.2, “Requirements,” on page 116

General

The General page lets you configure a Java program to be executed on the managed device.

Java Program Name

Specify the Java program name. For example, com.novell.TestProg.

Program Parameters

Specify the program parameters.
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Path to Java Runtime Executable (JRE)

Specify the path to the Java Runtime Executable (JRE).

JRE Parameters

Specify the JRE parameters.

Wait Before Proceeding to Next Action

Specify what happens after the Java application launches:

¢ No wait: The next action in the list is immediately performed.

¢ When launch action is complete: The next action in the list is performed after the launch action
completes.

+ Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

¢ Terminate action if wait period exceeded: If you select the Wait for _ seconds option, this
option is enabled. If the specified number of seconds is exceeded and the action is not
successfully performed, the action is terminated.

Working Directory

Click More Options to specify the Java application’s working directory.

Specify the initial working directory for the application.

Priority
Click More Options to specify the Java application’s priority.

Specify the priority of the process that runs the application. This option lets you configure how much
of the CPU usage the application process consumes. Select from the following priorities: Real Time,
High, Above Normal, Normal, Below Normal, and Low.

Run As

Click More Options to specify the Java application’s Run As settings.

¢ System: Runs the application as the system account (as a service).

¢ Administrator: Runs the application as a dynamic administrator user. A dynamic administrator
is an administrator account that is created on the fly to perform certain procedures, such as
installing applications or running scripts. Using a dynamic administrator is helpful when
installing applications (some MSI applications, for example) that cannot be installed in the
system space. When you select this action, the dynamic administrator is created, it performs the
required tasks, and then the account is deleted.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails
because Microsoft does not allow the use of local administrator accounts on domain controllers.

¢ User: The application runs using the logged-in user’s credentials. For example, the application
has the same rights to the registry and the file system as the logged-in user.
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6.20

The following options are available for Linux:

¢ Root: The application runs only if the root user is logged in to the device.

¢ User: The application runs using the logged-in user’s credentials. For example, the application
has the same rights to the registry and the file system as the logged-in user.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Launch URL

The Action - Launch URL dialog box lets you specify the URL to launch on the device. You can also
specify the specific requirements that a device must meet for the action to be executed on the device.

Figure 6-22 Action - Launch URL Dialog Box

Add Action - Launch URL T

uneh URL
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To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

NOTE: When you create a bundle and select the Launch URL action, then assign the bundle to a
device, each action launches the URL in a new tab in the same window.

In a whitelisted environment, the Launch URL action might not work as expected. By default, the
whitelisting feature is disabled for the Launch URL action. To enable the Launch URL action to work in
a whitelisted environment, you need to add a registry String value named UseShellExecute, to
HKLM\Software\Novell\ZCM\AgentSettings, and set the value data to false. However, when the
whitelisting feature is enabled, the action launches the URL in a new browser window instead of a
new tab.

The following sections contains additional information:

¢ Section 6.20.1, “General,” on page 117

¢ Section 6.20.2, “Requirements,” on page 117
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6.20.1

6.20.2

6.21

General

The General page lets you specify the URL to launch on the device. Click Test URL to open a Web

browser to verify that the URL is correct.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Launch Executable

The Add Actions - Launch Executable dialog box lets you specify the Windows executable, command
line parameters, and additional optional settings. You can also specify the specific requirements that
a device must meet for the action to be executed on the device.

Figure 6-23 Actions - Launch Executable Dialog Box

Add Action - Launch Executable

Action Name: * |Launch Executable

Command; *

Command Line Parameters:
working Directory:

Success Return Codes:

Environment Variables

Hame

No items available.

General Advanced Launch Options Requirements

Install the Novell File Upload extension to browse for a file

path

Codes separated by commas (e.g. 1,2,3)

Value

Fields marked with an asterisk are required.

HE

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs

(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,

then select an available action.

The following sections contains additional information:

¢ Section 6.21.1, “General,” on page 118

¢ Section 6.21.2, “Advanced,” on page 119

¢ Section 6.21.3, “Launch Options,” on page 120

¢ Section 6.21.4, “Requirements,” on page 121
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6.21.1 General

The General page lets you specify the location of the Windows executable, the command line
parameters to run when the executable launches, the working directory for the executable, and the
non-zero success codes that the executable returns.

Field Description

Command Specify the location of the Windows executable, including its filename.

You can specify a local path or a network drive. If you specify the local path, you must
include the executable’s full path, unless the executable is included in the workstation’s
search path. If you specify a network drive, you can use a mapped drive or a UNC path,
if the workstation can resolve the path.

Click Add to browse to and select the desired transform file. You can upload the
transform file or you can specify its location.

If you have not installed the Novell ZENworks File Upload plug-in on this device, you
must do so before you can browse for a file path. For more information, see Novell
ZENworks File Upload Plug-in.

Command Line Specify the command line parameters that you want to run when the executable
Parameters launches.

Working Directory Specify the working directory for the executable.

Success Return Specify the non-zero success codes that the executable returns. You can specify
Codes multiple success codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-zero
success codes while launching the action. For example, explorer.exe in Windows
returns a success code of 1. To successfully launch the Explorer application, you
should add 1 as the success code while launching the action.

If you leave this field blank, zero will be considered as the success code. Specify the
Success Return Code as * to enable any non-zero code returned by a script to be
treated as success.

Environment Lets you add, edit or remove the environment variables as follows:

Variables
+ Add: Click Add to display the Add Environment Variable dialog box. Specify the

name and value of the environment variable you want to add. For example, Name
= JAVA HOME; Value = C:\javal.4\.

NOTE: Add the ZENPREDEF REDIRCTSTANDARDOUTPUT predefined
environment variable and set it to true to redirect the standard output of a variable
or command to the specified file or location. For example, if the command line
parameteris /c echo%var% > c:\temp\test.txt, the standard output of var
will be redirected to c: \temp\test. txt file.

+ Remove: Select the environment variables to remove and click Remove.

+ Edit: Select the environment variable you want to edit, then click Edit. In the Edit
Environment Variable dialog box, specify the new value for the variable. For
example, Name = JAVA HOME; Value = C: \Program
Files\Java\jdkl.6.0_ 06.
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6.21.2

Advanced

The Advanced page lets you specify the Window executable’s security level and the wait time after
launch of windows executable and before proceeding to the next action.

Field Description

Executable Security =~ The executable can run in either the “user” space or the “system” space. By default, the
Level Run normal option is selected, which causes the application to run in the “user” space
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to
run the executable, you can configure the executable to run in the “system” space or as
a dynamic administrator, as described below:

* Run as logged in user: The executable inherits the logged-in user’s credentials.
For example, the executable has the same rights to the registry and the file
system as the logged-in user.

Select the executable’s initial window size: Normal, Minimized, Maximized, or
Hidden. In Hidden mode, the executable runs normally without a user interface
available. This is useful if you want the executable to process something, then go
away without user intervention.

¢ Run as secure system user (Don't allow system to interact with desktop):

The executable is run under the Local System user and inherits Administrator-
level credentials. For example, the executable has full rights to the registry and the
file system. Because the security level is set to Secure, the executable's interface
is not displayed to the user and the executable is only visible in the Task Manager.
This option is useful when running executables that require full access to the
workstation but require no user intervention.

¢ Run as dynamic administrator: A dynamic administrator is an administrator
account that is created on the fly to perform certain procedures, such as installing
applications. Using a dynamic administrator is helpful when installing applications
(some MSI applications, for example) that cannot be installed in the system
space. When you select this action, the dynamic administrator is created, it
performs the required tasks, and then the account is deleted.

When performing actions as a dynamic administrator, ensure that you select the
When action is compete option in the Wait before proceeding to next action group
box. Selecting this option ensures that the action is completed and the process
has terminated and released its resources before ZENworks begins cleaning up
and deleting the dynamic administrator account.

You cannot use mapped network drives to specify files and directories because
dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the
action are a part of the UNC path or network share that can be accessed only
through credentials, then browse through the credential vault to select a credential
that has access to the network.

NOTE: ZENworks does not support Windows Distributed File System (DFS)
share.

For more information on Credential Vault and adding credential to the Credential
Vault, see “Using the Credential Vault” in the ZENworks 11 SP3 ZENworks Control
Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain
controller fails because Microsoft does not allow the use of local administrator
accounts on domain controllers.
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6.21.3

Field

Description

Wait Before
Proceeding to Next
Action

Click More Options to specify how long to wait after launching the Windows executable
and before proceeding to the next action.

Specify what happens after the executable launches:
No wait: The next action in the list is immediately performed.

When launch action is complete: The next action in the list is performed after the
launch action completes. For example, enable this option if you are running the action
as a dynamic administrator and you want the profile cleaned up and deleted
immediately. If you do not enable this option, the profile is cleaned up and deleted at the
device’s next reboot.

Wait for _ seconds: Wait the specified nhumber of seconds before proceeding to the
next action.

+ Terminate action if wait period exceeded: If you select the Wait for _ seconds
option, this option is enabled. If the specified number of seconds is exceeded and
the action is not successfully performed, the action terminates.

Launch Options

The Launch Options page lets you specify the Window executable’s compatibility mode, display
settings, and the input settings.

Field

Description

Compatibility Mode

Display

Click More Options to specify the Window executable’s compatibility mode.

Launches the executable in a contained environment. Some executables cannot run on
workstations with newer versions of Microsoft* Windows because of incompatibility
issues. The drop-down list is available after you select the Compatibility mode option.

Select this option if you successfully ran an executable on a previous Windows version
but you are unable to run the executable on the device’s current Windows version.
Select the desired platform from the list.

Click More Options to specify the Window executable’s display settings.
Select the desired display options:
Run in 256 colors:

Sets the color quality setting to 256 colors while this executable is running. The color
quality setting reverts back to your default setting when you close the executable.

Run in 640 x 480 screen resolution:

Sets the screen resolution setting to 640 x 480 while this executable is running. The
color quality setting reverts back to your default setting when you close the executable.

Disable visual themes:

Disables visual themes from being applied to the executable. If you are experiencing
problems with menus or buttons on the title bar of the executable, this setting might
solve these problems. The theme settings revert back to your default setting when you
close the executable.
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Field Description

Input Settings Click More Options to specify the Window executable’s input settings.

Temporarily turns off handwriting recognition, speech recognition, and some
accessibility features. Turning off text services does not affect multiple languages or
keyboards that you have added.

Use the operating This option is enabled by default and allows the executable specified in the action to be
system shell to start  launched through the operating system shell.

the process ) ] o ) )
Deselect this option to prevent the executable specified in the action from being

launched through the operating system shell. Consequently, the executable can now be
launched only through the applications configured in the system’s list of allowed
applications.

To add applications to the system’s list of the allowed applications:

1. In the ZENworks Control Center, create a new Windows Group Policy.

2. In the Windows Group Policy settings page, select Local Group Policy and click
Configure.

3. In the Group Policy window, navigate to User Configuration > Administrative
Templates > System.

4. Double-click Run only allowed Windows applications.
In the Settings tab, select Enabled and click Show.

6. Inthe Show Contents window, click Add and enter the name of the application as
nalwin.exe and click OK.

7. Click Apply, then OK.

You can now launch the executable only if it is available in the NAL window.

6.21.4 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

6.22 Action - Launch Macintosh Executable

The Add Action - Launch Macintosh Executable dialog box lets you to specify the filename,
parameters, security level, and environment variables. You can also specify the specific requirements
that a device must meet for the action to be executed on the device.
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Figure 6-24 Actions - Launch Macintosh Executable Dialog Box
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To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall), click the Add drop-down list, then select an available
action.

The following sections contains additional information:

¢ Section 6.22.1, “General,” on page 122
¢ Section 6.22.2, “Requirements,” on page 124

6.22.1 General

The General page lets you specify the filename, parameters, security level, and environment
variables.
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Field Description

Executable File Name Specify the filename of the Macintosh executable.

Executable File Parameters Specify the parameters that you want to run while
launching the executable.

Executable Security Level Specify the Macintosh executable’s security level.

You can choose any of the following options and
configure the executable:

Run normal (as logged in user): The executable is
launched only if the user logs in to the device.

Run as root: The executable is launched only if the
root user is logged in to the device.

Wait before proceeding to next action Specify the wait time before proceeding to the next
action after launching the Macintosh executable.

No wait: Select this option to immediately perform the
next action in the list.

When action is complete: Select this option to
perform the next action in the list after the launch
action finishes.

Wait for _ seconds: Select this option to proceed to
the next action after the specified number of seconds.

+ Terminate action if wait period is exceeded:

This check box is enabled only if you select the
Wait for _ seconds option. Select this check box
to terminate the action if the action is not
performed after the wait time exceeds the
specified number of seconds.
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Field

Description

Environment Variables

Lets you to add, edit, or remove the environment
variables as follows:

+ Add: Click Add to display the Add Environment

Variable dialog box. Specify the name and value
of the environment variable you want to add.

Select the Add to existing data check box to
append or prepend the environment variable to
the existing data.

+ Append: Adds the environment variable at
the end of the existing data.

¢ Prepend: Adds the environment variable at
the beginning of the existing data.

¢ Use Separator Character: Specify a
character to separate the appended or
prepended environment variable from the
existing data.

Remove: Select the check box next to the
environment variables you want to remove, then
click Remove.

Edit: Selectthe environment variable you want to
edit, then click Edit. In the Edit Environment
Variable dialog box, specify the new value for the
variable.

6.22.2 Requirements

6.23

124

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Launch Windows Thin Client Application

The Action - Launch Windows Thin Client Application dialog box lets you specify to launch an ICA
(Independent Computing Architecture) or RDP (Remote Desktop Protocol) client session and

configure the appropriate settings.

You can also specify the specific requirements that a device must meet for the action to be executed

on the device.

You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the Thin Client Application bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute,
Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then

select an available action.
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The following sections contain additional information:

¢ Section 6.23.1, “General,” on page 125
¢ Section 6.23.2, “Requirements,” on page 127

6.23.1 General

The General page lets you specify to launch an ICA (Independent Computing Architecture) or RDP
(Remote Desktop Protocol) client session and configure the appropriate settings.

ICA Session

Select this option if the terminal server requires the application to run in an ICA client session. Citrix
MetaFrame requires ICA client sessions.

Figure 6-25 Action - Launch Windows Thin Client Application Dialog Box: ICA Session

Add Action - Launch Windows Thin Client Application E

Launch Windows Thin Client Application |

Action Name: *

General Requirements

® |4 Session [\\)7
Select this option if the thin client requires the application to run in an ICA (Independent
Computing Architecture) client session. Citrix MetaFrame requires [CA client sessions.

C RDP Session
Select this option if the thin client requires the application to run in an RDP (Remote Desktop
Protocol) client session. Microsoft Windows Terminal Server requires RDP client sessions.

Published Application Mame:

Servers Hosting the Application: *

Fields marked with an asterisk are required.

oK Cancel

Published Application Name: Type the published application name exactly as it is defined in Citrix.
Servers Hosting the Application: Add the Citrix servers that host the application.

1 Type the server’s IP address or hostname.
2 Click Add.

The order in which the servers are listed is the preferred order for launching. You can use the Move
Up and Move Down buttons to change the order if necessary.
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RDP Session

Select this option if the terminal server requires the application to run in an RDP client session.
Microsoft Windows Terminal Server requires RDP client sessions.

Figure 6-26 Action - Launch Windows Thin Client Application Dialog Box: RDP Session

Add Action - Launch Windows Thin Client Application B

Action Name: * |Launch Windows Thin Client Application

General Reguirements

O 1ca session
Select this option if the thin client requires the application to run in an ICA (Independent
Computing Architecture) client session. Citrix MetaFrame reguires ICA client sessions.

® RDP Session
Select this option if the thin client requires the application to run in an RDP (Remote Desktop

Protocol) client session. Microsoft Windows Terminal Server requires RDP client sessions.

Terminal Server Address:

Server Port: * 3389 %
Server Domain:
Application Path:
Application Working Directory:
Color Depth: True Color (24 bit) »
O operate in full screen mode
® Use specified screen size 640 % X |480 %
Advanced Settings for redirection:
Corives [serial ports  [printers [smart Cards

Fields marked with an asterisk are required.

(208 Cancel

Terminal Server Address: Specify the terminal server’s IP address or hostname.
Server Port: If the terminal server is not using default port 3389, specify the correct port number.

Server Domain: If the terminal server is part of a Windows NT domain or an Active Directory
domain, specify the domain name. If the user’s name and password in the domain matches the user
name and password in Novell eDirectory, the user is not prompted to log in to the terminal server
when launching the application.

Application Path: Specify the path to the application’s executable file from the perspective of the
terminal server.

Application Working Directory: Specify the path to the directory you want the application to use for
its working files.

Color Depth: Select the number of colors for the RDP client session. You can select 256 Colors, High
Color (15 bits), High Color (16 bits), or True Color (24 bits). The default is True Color (24 bits).

Screen Size: If you want the RDP client session to use the entire desktop area, select Operate in full
screen mode. Otherwise, select Use specified screen size and manually set the width and height (in
pixels).
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6.23.2

6.24

Advanced Settings for redirection: Select the settings, such as drivers, printers, serial ports, and
smart cards, that you want to map to the remote desktop machine.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to

be enforced on it. For information about the requirements, see Requirements.

Action - Prompt User

The Action - Prompt User dialog box lets you specify that a prompt displays on the device and

configure its settings. You can also specify the specific requirements that a device must meet for the

action to be executed on the device.

Figure 6-27 Action - Prompt User Dialog Box

Add Action - Prompt User E
Action Mame: * |F'rumpt User |
General Requirements

User Cancels Allowed: D%

If this iz set to 0, there will be no cancel button on the dialeg. The next normal launch of this set
will trigger the next opportunity te cancel.

Seconds to be Displayed: %

How often to prompt:
® Always
O onca per devica
O once per user

Define Prom pt(si

Locale Prompt

No items available.

{An example of @ prempt might be: The machine will reboot in 10 seconds. Please save your work
and close any open applications. )

Fields marked with an asterisk are required.

oK Cancel

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs

(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,

then select an available action.
The following sections contains additional information:

¢ Section 6.24.1, “General,” on page 128
¢ Section 6.24.2, “Requirements,” on page 129
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6.24.1

General

The General page lets you specify that a prompt displays on the device and configure its settings.

User Cancels Allowed

Specify whether the user can cancel the remaining actions in the action set. For example, if the action
set installs an application that requires a reboot, and you select this option, the user can cancel the
reboot, which, cancels the installation. The install action set is performed again according to its . For
this reason, use this option carefully. There is no Cancel button on the dialog box if you use the default
setting of 0.

Seconds to be Displayed

Specify the number of seconds that the prompt is displayed before the action is performed. For
example, suppose you configure a prompt that appears during an application installation before the
device performs a required reboot. If you specify that the user can cancel the action set and you
specify that the prompt displays for 10 seconds, the prompt displays for 10 seconds and then the
device reboots.

How Often to Prompt

Select the desired option:

¢ Always: Display the prompt every time the action is performed.
¢ Once per device: Display the prompt once on the device, regardless of how many users log in.

¢ Once per user: Display the prompt once per user, regardless of how many devices the user logs
in to.

Define Prompts

Define the prompt that you want to display on the device. Additionally, you can specify different
locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the
prompt defined in the same locale as the operating system locale. However, if the operating system
locale does not match any of the specified locales, then ZENworks displays the prompt defined by
the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a
message on a new line, you must use a <br> tag before the message.

You can include {0} in your text to provide a running counter that counts down the number of
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the
following text:
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6.24.2

6.25

The machine will reboot in {0} seconds. Please save your work and close any
open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.
4 Click OK.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Reboot/Shutdown

The Action - Reboot/Shutdown dialog box lets you specify the reboot or shutdown action for the
device. You can also specify the specific requirements that a device must meet for the action to be
executed on the device.

Figure 6-28 Action - Reboot/Shutdown Dialog Box

Add Action - Reboot/Shutdown E

Action Name: *

Reboot/Shutdown ‘

General Requirements

Configure Reboot/Shutdown action for the device.
Select action:
@ Reboot
O shutdown %
Time to wait before Reboot/Shutdown: |300 % seconds (-1 - 1800)
[ pisplay a warning message before doing Reboot/Shutdown

Allow user to cancel

Define Prom pt(si

Locale Prompt

No items available.

{An exarmple of a prompt might be: The machine will reboot in 10 seconds. Please save your work
and close any open applications.)

Naote: Before performine the action, the message above will be displayed on devices to users that
are logged in. If a message for a specific locale is not entered, a default English message will be

used.

Fields marked with an asterisk are required.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

NOTE: The Reboot action should not normally be used in conjunction with a Recurring launch set to
When a device is refreshed. Although there are some valid use scenarios for this configuration,
scheduling a device to reboot upon refresh can cause a continuous loop.
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6.25.1

The following sections contains additional information:

¢ Section 6.25.1, “General,” on page 130
¢ Section 6.25.2, “Requirements,” on page 131

General

The General page lets you specify the reboot or shutdown action for the device.

Reboot

Reboot the device when this action is performed.

Shutdown

Shut down the device when this action is performed.

Time to Wait Before Reboot/Shutdown

Specify the number of seconds (between -1 and 1800) before the device reboots or shuts down. When
the number of seconds specified passes, the device reboots or shuts down, regardless of whether the
user clicks OK or not. Clicking OK does not cause the device to immediately reboot or shut down.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If you
specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a message
displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If you select
both this option and the Allow user to cancel option, a message displays indefinitely until the user
clicks OK or Cancel.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If you
specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a message
displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If you select
this option and the Allow user to cancel option, a message displays indefinitely until the user clicks OK
or Cancel.

Display a Warning Message Before Doing Reboot/Shutdown

Specify that a message displays on the device, warning the user that the device is going to reboot or
shut down.

For example, you could provide the following prompt:

The machine will reboot in _ seconds. Please save your work and close any open
applications.

Before performing the action, the message displays on the device only if the user is logged in.

Allow User to Cancel

Specify whether the user can cancel the reboot or shutdown procedure.

130 ZENworks 11 SP3 Software Distribution Reference



6.25.2

6.26

Define Prompts

Define the prompt that you want to display on the device. Additionally, you can specify different
locales with different messages. If you do not specify another locale, a default English message
displays.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a
message on a new line, you must use a <br> tag before the message.

You can include {0} in your text to provide a running counter that counts down the number of
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the
following text:

The machine will reboot in {0} seconds. Please save your work and close any
open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.
4 Click OK.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Registry Edit

The Action - Registry Edit dialog box lets you configure the registry file to apply. We recommend that
you back up the registry before applying the specified registry file, and ensure that the file is properly
formatted and well tested. You can also specify the specific requirements that a device must meet for
the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contain additional information:

¢ Section 6.26.1, “General,” on page 132
¢ Section 6.26.2, “Advanced,” on page 134
¢ Section 6.26.3, “Requirements,” on page 136
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6.26.1 General

The General page lets you configure the registry file to apply. You can select hives in the tree to which
you want to add values and keys, rename or remove sections, or import a registry file. We
recommend that you back up the registry before applying the specified registry file, and ensure that
the file is properly formatted and well tested.

Figure 6-29 Action - Registry Edit Dialog Box: General Tab

Add Action - Registry Edit
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Fields rnarked with an asterizk are required.

The following table lists the tasks you can perform to manage registry tree changes:

Task Steps

Add a registry key 1. Select a registry hive, click New, then click Key.
2. Specify the key’s name. For example, Software.

You can also specify multiple levels of keys by separating them with a backslash
(\). For example, Novel\ZENworks\Zfd.

Do not use the forward slash (/) as a separator.
3. Select one of the following registry operations:

+ Create Always: Creates the key regardless of whether the key currently
exists in the workstation’s registry.

+ Create If Does Not Exist: Creates the key only if the key does not currently
exist in the workstation’s registry.

+ Rename: Renames the key if it currently exists in the workstation’s registry.
+ Delete: Deletes the key if it currently exists in the workstation’s registry.

+ Delete and Recreate: Deletes the key if it currently exists in the
workstation’s registry and then recreates the key.

+ Delete if Empty: Deletes the key if it currently exists in the workstation’s
registry and the key is empty.

+ None: Does not perform any registry operation.
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Task Steps

Add a Value 1. Select the check box next to the desired item, then click Value to display the Add
Value To dialog box.

2. Select one of the following options from the Value Type list:
+ Default: Adds a default string value to the selected key.
+ String: Adds a string value to the selected key.

+ Binary: Adds a binary value to the selected key. Most hardware component
information is stored as binary data and is displayed in hexadecimal format.

+ Dword: Adds a DWORD value to the selected key. DWORD values are
represented by a number that is 4 bytes long. Many parameters for device
drivers and services are this type and are displayed in binary, hexadecimal,
or decimal format.

+ Expandable String: Adds an expand string value to the selected key. An
expandable string is a variable-length data string. This data type includes
variables that are resolved when a program or service uses the data.

+ Multiple String: Adds a multi-value string to the selected key. Multiple string
values contain lists or multiple values in a form that people can read. Entries
are separated by spaces, commas, or other marks.

+ Qword: Adds a Qword string to the selected key. A Qword value is data
represented by a number that is a 64-bit integer. This data is displayed in
Registry Editor as a Binary Value.

+ Link: Adds a link string value to the selected key. A link string value is a
Unicode string naming a symbolic link.

+ None: Does not perform any registry operation.

+ Full Resource Descriptor: Adds a full resource descriptor value to the
selected key. A full resource descriptor is a series of nested arrays designed
to store a resource list for a hardware component or driver.

+ Resource List: Adds a resource list to the selected key. A resource listis a
series of nested arrays that is designed to store a resource list that is used
by a hardware device driver or one of the physical devices it controls.

+ Resource Requirement List: Adds a resource requirements list to the
selected key. A resource requirements list is a series of nested arrays
designed to store a device driver's list of possible hardware resources the
driver or one of the physical devices it controls can use.

3. Specify the data. Depending on which value type you selected in the previous
step, the type of data varies.

4. Select one of the following registry operations:

+ Create Always: The setting is always created in the registry, even if it
already exists. If it exists, the setting's current values are overwritten. For
example, if PATH=C:\ already exists, PATH=C: \TEMP replaces it.

+ Create If Exists: The setting is created only if it already exists. The setting's
current values are overwritten. For example, if PATH=C: \ already exists,
PATH=C: \TEMP replaces it.

+ Create If Does Not Exist: The setting is created only if it does not already
exist.
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Task Steps

+ Delete: The setting is deleted. If the registry setting has subordinate settings, the
subordinate settings are also deleted.

* Append If Exists, Otherwise Create: Appends the Value if the value currently
exists in the workstation’s registry. If the Value does not exist, it is created.

* Prepend If Exists, Otherwise Create: Prepends the Value if the value currently
exists in the workstation’s registry. If the Value does not exist, it is created.

Rename an entry 1. Select the check box next to the desired item, then click Edit > Rename.

2. Specify the new name.

Select all the objects 1. Select the check box next to the parent folder, then click Edit > Select All Children.
of a parent folder

Deselect all the 1. Select the check box next to the parent folder, then click Edit > Deselect All
objects of a parent Children.

folder

Clear Selection 1. Click Edit > Clear Selection.

Remove an entry 1. Select the check box next to the desired item, then click Delete.

Import the contents of 1. Click Import, then specify the registry file whose contents you want to import.

a registry file ] ) )
NOTE: A .reg file does not allow you to store the Data Type information of the value

being deleted. For more information, see Deleting Registry Keys and Values at
Microsoft Support Site (http://support.microsoft.com/kb/310516).

Consequently, when you import a registry file that has a value marked for deletion in the
file, the value defaults to a String Data Type. However, this behavior does not affect the
deletion of values from the Windows Registry of the managed device.

Export the contentsto 1. Click Export to export the contents to a registry file named by default as
a registry file bundle name.reg. For example, if the name of the bundle is win, then the
contents are exported to a win. reg file.

You can choose to rename the file.

=

Search for a Value
name, registry key, or
both.

Specify the name of the value or key that you want to search for.

n

Select Registry Key/Value, Registry Value Data, or Both.

3. Select the Search within the selected nodes only check box to limit the search to
the node you selected in the Registry Tree list.

4. Click Search.

6.26.2 Advanced

The Advanced page lets you specify how you want the action to run (as system or user) and to back
up the registry file before applying the modified registry file
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Figure 6-30
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- Registry backup with Run Action As "User” works only on windows xp.
For other windows operating systems, registry backup Action should be Run as "System” user.

Run Action As
@ System
DApph,r HKEY_CURRENT_USER changes to the logged in user’s hive instead of .DEFAULT

" User

*Required

oK | [ Cancel

Backup Registry Before Applying the Changes

Select the check box, then specify the path to the backup file, for example, ¢ : \BackupFile.reg.

If you select this option, the entire registry is backed up before importing the configured registry file.
The backup process is performed every time this action executes. This can be a time-consuming
operation and the backup file can be large.

Before you edit the registry, export the keys in the registry that you plan to edit, or back up the entire
registry by selecting this option. If a problem occurs, you can then restore the registry to its previous
state.

NOTE: On a non-XP Windows device, if you apply a bundle for which Backup registry before applying
changes is selected and Run Action As is set to User, then the following occurs:

¢ The registry backup action fails.

¢ The bundle execution fails.
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6.26.3

6.27

6.27.1

Run Action As

Specify how you want the action to run:

¢ System: The action is run under the Local System user and inherits Administrator-level
credentials. For example, the action has full rights to the HKEY LOCAL MACHINE hive.

Select the Apply HKEY_CURRENT_USER changes to the logged in user’s hive instead of DEFAULT
option to enable the changes to be made in the user’s hive instead of the DEFAULT hive of
HKEY_ USERS.

¢ User: The registry file is applied using the logged-in user’s credentials. For example, the action
has the same rights to the registry and the file system as the logged-in user. If you are changing
keys in the HKEY CURRENT_USER hive, you must run the action as User. Depending on the rights
assigned to the user, the action might or might not have rights to the HKEY LOCAL_MACHINE hive.
If you select User, the user must be logged in to the device or the action fails.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Run Script

The Action - Run Script dialog box lets you configure a script to be executed on the managed device.
For the Run Script action to successfully complete, ensure that the script is silent (requires no user
intervention). You can also specify the specific requirements that a device must meet for the action to
be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.27.1, “General,” on page 136
¢ Section 6.27.2, “Requirements,” on page 142

General

The General page lets you configure a script to be executed on the managed device. For the Run
Script action to successfully complete, ensure that the script is silent (requires no user intervention).

The settings vary, depending on the type of script you select from the Script to run list. The following
options are available:

¢ “Specify a File on a Managed Device” on page 136
¢ “Define Your Own Script” on page 138
¢ “Select From This Device” on page 140

Specify a File on a Managed Device

Select this option to run a script that exists on the managed device.
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Figure 6-31 Action - Run Script Dialog Box with the Specify a File on a Managed Device option selected

Add Action - Run Script 7|

Action Name: * |Run Script %

General Requirements

Configure a script to be executed on the managed device.

Executable Type: Script ¥
Script to Run: Specify a file on managed device (v
Script File Mame: *
(e.g. Ci\sariptsiyz.pl)
Script Parameters:

Path to Script Engine:
Script Engine Parameters:

Wait before proceeding to next action (3 g wait

® when action is complete

O wait for seconds

Terminate action if wait period is exceeded

Success Return Codes:

Codes separated by commas (e.g. 1,2,3)
Working Directory:
Priority: Mormal -

Run As: System 3

Fields marked with an asterisk are required.

oK Cancel

Script Filename: Specify the path to the script file on the target device, for example,
C:\scripts\xyz.pl.

Script Parameters: Specify any additional parameters you want to place on the command line after
the script filename is specified. This results in parameters being passed to your executable script.

Path to Script Engine: Specify the interpreter that launches to run your script. For example,
C:\Program Files\Perl\bin\Perl.exe.

For Windows scripts other than batch scripts (for example, VBScript), the Path to Script Engine field
should specify the path to the Windows Based Script Host, such as
(C:\Windows\System32\wscript .exe)

Script Engine Parameters: Specify any parameters you want included on the command line when
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

¢ No wait: The next action in the list is immediately performed.

¢ When launch action is complete: The next action in the list is performed after the launch action
completes.

+ Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

+ Terminate action if wait period exceeded: If you select the Wait for _ seconds option, this
option is enabled. If the specified number of seconds is exceeded and the action is not
successfully performed, the action is terminated.
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Success Return Codes: Specify the non-zero success codes that the script returns. You can specify
multiple success codes separated by commas.

If a script returns non-zero success codes, you should specify these non-zero success codes while
launching the action. For example, explorer.exe in Windows returns a success code of 1. To
successfully launch the Explorer application, you should add 1 as the success code while launching
the action.

If you leave this field blank, zero will be considered as the success code. Specify the Success Return
Code as * to enable any non-zero code returned by a script to be treated as success.

Working Directory: Click More Options to specify the script’s working directory. Specify the initial
working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that
runs the script. This option lets you configure how much of the CPU usage the script process
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal,
and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

¢ System: Runs the script as the system account (as a service).

¢ Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an
administrator account that is created on the fly to perform certain procedures, such as installing
applications or running scripts. Using a dynamic administrator is helpful when installing
applications (some MSI applications, for example) that cannot be installed in the system space.
When you select this action, the dynamic administrator is created, it performs the required tasks,
and then the account is deleted.

¢ User: The script runs, using the logged-in user’s credentials. For example, the script has the
same rights to the registry and the file system as the logged-in user.

Define Your Own Script

Select this option to type a script in ZENworks Control Center.
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Figure 6-32 Action - Run Script Dialog Box with the Define Your Own Script option selected
Add Action - Run Script 7| X%

Action Name: * |Run Script

General Requirements

Configure a script to be executed on the managed device.

Executable Type: Script v

Script to Run: Define your own script v

Script content: * [Edit

Script file extension: _bat

Path to Script Engine:
Script Engine Parameters:

Wait before proceeding to next action (g wait
@ when action is completa
O wait for seconds
Terminate action if wait period is exceeded
Success Return Codes:
Codes separated by commas (e.g. 1,2,3)

working Directory:
Priority: Normal -
Run As:

System hd

Fields marked with an asterisk are required.

oK Cancel

Script Content: Click Edit to display a text box where you type your script. This script is delivered to
the assigned devices and is executed in the standard device shell environment.

For example, you can automate drive mapping using the script capabilities of bundles. Your bundle’s
script could read:

net use m: \\server\sys
net use w: \\server\voll

If the user is logged in as an eDirectory user with rights, then the mapping works. They can map a
drive to a Windows share using a domain account by putting the username/password on the script
line. If they are a logged in as an Active Directory user and have rights, the username/password is not
required.

Save File with Extension: Specify the extension that you want appended to the script when it is
saved. For example, .bat.

Path to Script Engine: Specify the interpreter that launches to run your script.

Script Engine Parameters: Specify any parameters you want included on the command line when
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

¢ No wait: The next action in the list is immediately performed.

¢ When launch action is complete: The next action in the list is performed after the launch action
completes.
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+ Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

+ Terminate action if wait period exceeded: If you select the Wait for _ seconds option, this
option is enabled. If the specified number of seconds is exceeded and the action is not
successfully performed, the action is terminated.

Working Directory: Click More Options to specify the script’s working directory. Specify the initial
working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that
runs the script. This option lets you configure how much of the CPU usage the script process
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal,
and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

¢ System: Runs the script as the system account (as a service).

¢ Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an
administrator account that is created on the fly to perform certain procedures, such as installing
applications or running scripts. Using a dynamic administrator is helpful when installing
applications (some MSI applications, for example) that cannot be installed in the system space.
When you select this action, the dynamic administrator is created, it performs the required tasks,
and then the account is deleted.

¢ User: The script runs, using the logged-in user’s credentials. For example, the script has the
same rights to the registry and the file system as the logged-in user.

Select From This Device

Select this option to specify a script file that is already on the device on which you are running
ZENworks Control Center.
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Figure 6-33 Action - Run Script Dialog Box with the Select From This Device option selected

Add Action - Run Script X

Action Name: *

Run Script |

General Requirements

Configure a script to be executed on the managed device.

Executable Type:
Script to Run: |Se\ecl from this device b
Select from this device * |

Script Parameters: | |

Path to Script Engine: | |

Script Engine Parameters: | |

Wait before proceeding to next action (3 g wait

@ when action is complete

O wait for l:l seconds

Terminate action if wait period is exceeded

Success Return Codes: | |

Codes separated by commas fe.g. 1,2,3)

Working Directory: | |

iy

Fields marked with an asterisk are required.

oK Cancel

Select From This Device: Browse to and select the script file.

Script Parameters: Specify any additional parameters you want to place on the command line after

the script filename is specified. This results in parameters being passed to your executable script.
Path to Script Engine: Specify the interpreter that launches to run your script.

Script Engine Parameters: Specify any parameters you want included on the command line when

the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

¢ No wait: The next action in the list is immediately performed.

¢ When launch action is complete: The next action in the list is performed after the launch action

completes.

+ Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

¢ Terminate action if wait period exceeded: If you select the Wait for _ seconds option, this
option is enabled. If the specified number of seconds is exceeded and the action is not

successfully performed, the action is terminated.

Working Directory: Click More Options to specify the script’s working directory. Specify the initial

working directory for the script.
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Priority: Click More Options to specify the script’s priority. Specify the priority of the process that
runs the script. This option lets you configure how much of the CPU usage the script process
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal,
and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

¢ System: Runs the script as the system account (as a service).

¢ Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an
administrator account that is created on the fly to perform certain procedures, such as installing
applications or running scripts. Using a dynamic administrator is helpful when installing
applications (some MSI applications, for example) that cannot be installed in the system space.
When you select this action, the dynamic administrator is created, it performs the required tasks,
and then the account is deleted.

¢ User: The script runs, using the logged-in user’s credentials. For example, the script has the
same rights to the registry and the file system as the logged-in user.

The following options are available for Linux:

¢ Root: The script runs by using the credentials of the root user.

¢ User: The script runs by using the logged-in user’s credentials. For example, the script has the
same rights to the registry and the file system as the logged-in user.

6.27.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

6.28 Action - Start/Stop Service

The Action - Start/Stop Service dialog box lets you specify the service that you want to start or stop.
You can also specify the specific requirements that a device must meet for the action to be executed
on the device.

Figure 6-34 Action - Start/Stop Service Dialog Box
Add Action - Start/Stop Service 2|

Action Name: *  |Start/Stop Service

General Requirements
Configure the Start/Stop Service action for the device.
Service Name:

(e.g. dnscache, Spooler, srservice)

Select action: @ start Service

O stop service

Fields marked with an asterisk are required

oK Cancel
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6.28.1

6.28.2

6.29

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.28.1, “General,” on page 143
¢ Section 6.28.2, “Requirements,” on page 143

General

The General page lets you specify the service that you want to start or stop.
Service Name: Specify a service and indicate whether you want to start or stop that service.
Select Action: Select one of the following actions:

¢ Start Service: Starts the specified service. If the service is already running on the device, the
Start Service task completes.

+ Stop Service: Stops the specified service. If the service is not running on the device, the Stop
Service task completes.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Store Personality

The Store Personality page lets you specify the personality migration template and the path where
the Platform Neutral Package (PNP) file is to be created. You can also specify the specific
requirements that a device must meet for the action to be executed on the device.

Figure 6-35 Action - Store Personality Dialog Box

Add Action - Store Personality HE
Action Mame: * | Store Personality

General Requirements

Specity the templa
@) upload a template fr

0 Specify a template on the managed device:

{e.g. £\ TemplatesPessonalityhigration Template. xmi)

Path where the PHP file is to be created
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6.29.1

You can access this information by using the following methods:

¢ As part of the process of creating a Windows bundle by using the Store Personality bundle
category. For more information, see Section 2.4, “Creating Windows Bundles,” on page 30.

+ In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the
Name column of the Bundies list, click the Actions tab, click the Add drop-down list, then select
the Store Personality action.

The following sections contains additional information:

¢ Section 6.29.1, “General,” on page 144
¢ Section 6.29.2, “Requirements,” on page 145

General

The General page lets you specify the personality migration template and the path where the
Platform Neutral Package (PNP) file is to be created.

Upload a template from this device

Select this option and click |4/ to display the Upload content dialog box. Browse to and select the
template to upload.

Specify a template on the managed device

Select this option to specify the path of personality migration template file on the managed device.
You can also specify the UNC path of the file.

Path where the PNP file is to be created

Specify the path of the PNP file on the managed device for storing the migration settings and data.
You can also specify the UNC path of the file.

Password to encrypt the PNP file

Select this check box to enter a password to protect the PNP file.

In the Re-enter the password field, re-enter the password to confirm it.

Span to multiple files

You can choose to span the personality migration data across multiple files to enable you to store data
in removable media. The available options are:
¢ Never span. Select this option to migrate personalities without spanning the files.

¢ Span at the size. Select this option to specify a span size for the files. The default span size is 650
MB.
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6.29.2

6.30

6.30.1

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Terminate Application

The Action - Terminate Application dialog box is displayed when you add a Terminate Application
Prompt action. This dialog box lets you undo all operations that are performed in the launch action
set. You can also configure a prompt to notify users of the termination.You can also specify the
specific requirements that a device must meet for the action to be executed on the device. However,
you are allowed to add the Terminate Application action only if it is not already added.

Figure 6-36 Action - Terminate Application Dialog Box

Add Action - Terminate Application b
Action Name: * |i‘|'ermmale Application |
General Requirements

This task will undo all operations that are performed
in the launch action set. These are the operations
which will be reversed:

Name Type

There is no work to do for this task.

Notify the user of termination

Locale Prompt

No items available.

(An example of @ prompt might be: The machine will reboot in 10 seconds. Please save your work
and close any open applications.)

Note: Before performing the action, the message above will be displayed on devices to users that
are logged in. If a message for a specific locale is not entered, a default English message will be
used.

Fields marked with an asterisk are required.

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined link
of a bundle in the Name column of the Bundies list, click the Actions > Terminate. Click Add > Terminate
Application.

The following sections contains additional information:

¢ Section 6.30.1, “General,” on page 145
¢ Section 6.30.2, “Requirements,” on page 146

General

The General page lets you undo all operations that are performed in the launch action set. You can
also configure a prompt to notify users of the termination.

The name and type of each process that is reversed displays in the list.
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6.30.2

6.31

Notify the User of Termination

Define the prompt that you want to display on the device. You can also specify different locales with
different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the
prompt defined in the same locale as the operating system locale. However, if the operating system
locale does not match any of the specified locales, then ZENworks displays the prompt defined by
the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the
specified locale. You can create different messages, each with its own locale setting.

3 Specify the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the
following text:

The application will terminate in {0} seconds. Please save your work.
The message displays for the number of seconds specified in the Seconds to be Displayed field.
4 Click OK.

To remove a prompt, select the check box, then click Remove.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Terminate Application Prompt

The Action - Terminate Application Prompt dialog box is displayed when you add a Terminate
Application Prompt action. This dialog box lets you configure a prompt to notify users before the
application terminates, including the number of seconds to notify the user, the number of times the
prompt retries, and different messages for different locales.You can also specify the specific
requirements that a device must meet for the action to be executed on the device. However, you are
allowed to add the Terminate Application Prompt action only if it is not already added.
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6.31.1

Figure 6-37 Action - Terminate Application Prompt Dialog Box

Add Action - Terminate Application Prompt B

Action Name: * ‘Termmate Application Prompt |

General Requirements

Seconds to be Displayed: %
Number of Retries Allowed: D%

Prompt the user to save any unsaved data

Locale Prompt

No ftems available.

(An example of a prompt might be: The machine will reboot in 10 seconds. Please save your work
and close any open applications.)

Note: Before performing the action, the message above will be displayed on devices to users that
are logged in. If @ message for a specific locale is not entered, a defoult English message will be
used.

Fields marked with an asterisk are required.

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined link
of a bundle in the Name column of the Bundies list, click the Actions > Terminate. Click Add > Terminate
Application Prompt.

The following sections contains additional information:

¢ Section 6.31.1, “General,” on page 147

¢ Section 6.31.2, “Requirements,” on page 148

General

The Action - Terminate Application Prompt dialog box lets you configure a prompt to notify users
before the application terminates, including the number of seconds to notify the user, the number of
times the prompt retries, and different messages for different locales.

Seconds to be Displayed

Specify the number of seconds that the prompt is displayed before the action is performed. For
example, suppose you configure a prompt to notify the user that an application is in the process of
terminating. If you specify that the prompt display for 10 seconds, the prompt displays for 10
seconds, then the application terminates.

Number of Retries Allowed

Specify the number of times the prompt displays before performing the next action.
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6.31.2

6.32

6.33

Prompt the User to Save Any Unsaved Data

Define the prompt that you want to display on the device. You can also specify different locales with
different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the
prompt defined in the same locale as the operating system locale. However, if the operating system
locale does not match any of the specified locales, then ZENworks displays the prompt defined by
the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a
message on a new line, you must use a <br> tag before the message.

You can include {0} in your text to provide a running counter that counts down the number of
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the
following text:

The application will terminate in {0} seconds. Please save your work.
The message displays for the number of seconds specified in the Seconds to be Displayed field.
4 Click OK.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Undo Install Actions

The Action - Undo Install Actions dialog box lets you undo all operations that are performed in the
install action set. The list displays the name and type of each operation that is reversed. There are no
configuration tasks that you need to perform for this action.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

Action - Uninstall Bundle

The Action - Uninstall Bundle dialog box lets you select a bundle to remove from the device.You can
also specify the specific requirements that a device must meet for the action to be executed on the
device.
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6.33.1

6.33.2

6.34

Figure 6-38 Action - Uninstall Bundle Dialog Box

Ak ction - Urinatall Bundle 2

Action Hame: * | Uninstall Bundie

Ceneval Requirements

Bundla: L]

‘‘‘‘‘

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.33.1, “General,” on page 149
¢ Section 6.33.2, “Requirements,” on page 149

General

The General page lets you select a bundle to remove from the device.Click [&] to browse to and select
the bundle to uninstall from the device.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types
of bundles are displayed (Preboot bundle, Windows bundles). If you know the name of the bundle
you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.7,
“Dependency Bundles,” on page 175.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Verify Bundle

The Action - Verify Bundle dialog box lets you verify a bundle on the device. You can also specify the
specific requirements that a device must meet for the action to be executed on the device.

Verifying a bundle ensures that the specified bundle or bundle group has been properly installed on
the device.

For example, for an MSI bundle, verifying the bundle results in the task running an MSI /repair
process against the bundle.
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6.34.1

6.34.2

6.35

Figure 6-39 Action - Verify Bundle Dialog Box

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.

The following sections contains additional information:

¢ Section 6.34.1, “General,” on page 150
¢ Section 6.34.2, “Requirements,” on page 150

General

The General page lets you verify a bundle on the device. Click [&] to browse to and select the bundle
to verify on the device.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types
of bundles are displayed (Preboot bundles, Windows bundles). If you know the name of the bundle
you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.7,
“Dependency Bundles,” on page 175.

Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to
be enforced on it. For information about the requirements, see Requirements.

Action - Verify Install Actions

The Verify Install Actions action verifies all operations that are performed in the Install action set.
This action does not require any configuration.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link
of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list,
then select an available action.
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6.36

6.36.1

Requirements

The Requirements panel lets you define specific requirements that a device must meet for the action
to be enforced on it.

You define requirements through the use of filters. A filter is a condition that must be met by a device
in order for the bundle to be applied. For example, you can add a filter to specify that the device must
have exactly 512 MB of RAM in order for the bundle to be applied, and you can add another filter to
specify that the hard drive be at least 20 GB in size.

As you construct filters, you need to know the conditions you can use and how to organize the filters
to achieve the desired results. Refer to the following sections for details.

¢ Section 6.36.1, “Filter Conditions,” on page 151
¢ Section 6.36.2, “Filter Logic,” on page 155

¢ Section 6.36.3, “Fail the action if these requirements fail,” on page 156

Filter Conditions

You can choose from any of the following conditions when creating a filter. Place your mouse pointer
over fields that require input to display a tooltip containing example usage.

Architecture: Determines the architecture of Windows running on the device. The condition you use
to set the requirement includes a property, an operator, and a property value. The possible operators
are equals (=) and does not equal (<>). For example, if you set the condition to architecture = 32,
the device’s Windows operating system must be 32-bit to meet the requirement.

Associated On: Determines the number of users or devices to which the bundle is assigned. The
possible operators are equals (=) and does not equal (<>). The possible values are Users and Devices.
For example, if you set the condition to =100 users, the total number of users must be 100 to meet
the requirement.

Bundle Installed: Determines if a specific bundle is installed. After specifying the bundle, the two
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle
must already be installed to meet the requirement. If you select No, the bundle must not be installed.

Connected: Determines if the device is connected to the network. The two conditions you can use to
set the requirement are Yes and No. If you select Yes, the device must be connected to the network to
meet the requirement. If you select No, it must not be connected.

Connection Speed: Determines the speed of the device’s connection to the network. The condition
you use to set the requirement includes an operator and a value. The possible operators are equals
(=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less
than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps),
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to
>= 100 Mbps, the connection speed must be greater than or equal to 100 megabits per second to meet
the requirement.

Disk Space Free: Determines the amount of free disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: >= 80 MB, the free disk space must be greater than or equal to 80
megabytes to meet the requirement.
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Disk Space Total: Determines the amount of total disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: >= 40 GB, the total disk space must be greater than or equal to 40
gigabytes to meet the requirement.

Disk Space Used: Determines the amount of used disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: <= 10 GB, the used disk space must be less than or equal to 10 gigabytes
to meet the requirement.

Environment Variable Exists: Determines if a specific environment variable exists on the device.
After specifying the environment variable, the two conditions you can use to set the requirement are
Yes and No. If you select Yes, the environment variable must exist on the device to meet the
requirement. If you select No, it must not exist.

Environment Variable Value: Determines if an environment variable value exists on the device. The
condition you use to set the requirement includes the environment variable, an operator, and a
variable value. The environment variable can be any operating system supported environment
variable. The possible operators are equal to, not equal to, contains, and does not contain. The possible
variable values are determined by the environment variable. For example, if you set the condition to
Path contains c:\windows\system32, the Path environment variable must contain the
c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the
filename, an operator, and a date. The filename can be any filename supported by the operating
system. The possible operators are on, after, on or after, before, and on or before. The possible dates are
any valid dates. For example, if you set the condition to appl.msi on or after 6/15/07, the
appl.msi file must be dated 6/15/2007 or later to meet the requirement.

File Exists: Determines if a file exists. After specifying the filename, the two conditions you can use to
set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the
requirement. If you select No, the file must not exist.

File Size: Determines the size of a file. The condition you use to set the requirement includes the
filename, an operator, and a size. The filename can be any file name supported by the operating
system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or
equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are designated in
bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the
condition to docl.pdf <= 3 MB, the docl.pdf file must be less than or equal to 3 megabytes to meet
the requirement.

File Version: Determines the version of a file. The condition you use to set the requirement includes
the filename, an operator, and a version. The filename can be any file name supported by the
operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is
greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For
example, the file version for calc.exe might be 5.1.2600.0. Each component is treated independently.
For this reason, the system requirements that you set might not provide your expected results. If you
do not specify all four components, wildcards are assumed.
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For example, if you set the condition to calc.exe <= 5, you are specifying only the first component
of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, the
calc.exe file must be less than or equal to version 5.1 to meet the requirement.

IP Segment: Determines the device’s IP address. After specifying the IP segment name, the two
conditions you can use to set the requirement are Yes and No. If you select Yes, the device’s IP address
must match the IP segment. If you select No, the IP address must not match the IP segment.

Linux Distribution: Determines the platform on which you want to distribute the bundles or the
external services. The condition you use to set the requirement includes an operator and a property
value. The possible properties are server type or desktop type, version, and architecture. The possible
operators are equals (=) and does not equal (<>). For example, if you set the property value to SUSE
Linux Enterprise Desktop 11 - 1586, the distribution will be only on SLED 11 - i586 devices.

Linux Kernel Version: Determines the version of the Linux kernel. The condition you use to set the
requirement includes an operator, and a version. The possible operators are equals (=), does not equal
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=).
For example, if you set the condition as Linux Kernel Version > 2.6, the requirement is met only
on Linux devices that have a kernel version greater than 2.6.

Linux Service Pack: Determines the Linux service pack level running on the device. The condition
you use to set the requirement includes a property and an operator, and a property value. The
possible properties are service pack, server type, and version. The possible operators are equals (=), does
not equal (<), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or
equal to (<=). For example, if you set the condition as Linux Service Pack = SLES 10 SP1, the
requirement is met only on devices that are installed with SLES 10 SP1.

Logged on to Primary Workstation: Determines whether the user is logged on to his or her primary
workstation. The two conditions you can use to set the requirement are Yes and No. If you select Yes,
the user must be logged on to his or her primary workstation to meet the requirement. If you select
No, if no user is logged on to the workstation, the requirement is not met. However, if a user other
than the primary user is logged on to the workstation, the requirement is met.

Memory: Determines the amount of memory on the device. The condition you use to set the
requirement includes an operator and a memory amount. The possible operators are equals (=), does
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or
equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). For
example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of memory to
meet the requirement.

Novell Client Installed: Determines if the device is using the Novell Client for its network
connection. The two conditions you can use to set the requirement are Yes and No. If you select Yes,
the device must be using the Novell Client to meet the requirement. If you select No, it must not be
using the Novell Client.

Operating System - Windows: Determines the service pack level, server type, and version of
Windows running on the device. The condition you use to set the requirement includes a property, an
operator, and a property value. The possible properties are service pack, server type, and version. The
possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to
(>=), is less than (<), and is less than or equal to (<=). The property values vary depending on the
property. For example, if you set the condition to version = Windows XP Versions, the device’s
Windows version must be XP to meet the requirement.

Actions 153



154

NOTE: Be aware that operating system version numbers contain four components: Major, Minor,
Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 5.0.2159.262144.
Each component is treated independently. For this reason, the system requirements that you set
might not provide your expected results.

For example, if you specify Operating System - Windows in the first field, Version in the second field, >
in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only the first two
components of the version number: Major (Windows) and Minor (5.0). As a result, for the
requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is
version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000
SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 5.0.0
to make the requirement evaluate as true because the actual revision component is greater than 0.

When you select the OS version from the drop-down, the Major and Minor components are
populated. The Revision and Build components must be typed in manually.

Primary User Is Logged In: Determines if the device’s primary user is logged in. The two conditions
you can use to set the requirement are Yes and No. If you select Yes, the primary user must be logged
in to meet the requirement. If you select No, the user must not be logged in.

Processor Family: Determines the device’s processor type. The condition you use to set the
requirement includes an operator and a processor family. The possible operators are equals (=) and
does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, Pentium IlI,
Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For example, if you set the
condition to <> Celeron, the device’s processor can be any processor family other than Celeron to
meet the requirement.

Processor Speed: Determines the device’s processor speed. The condition you use to set the
requirement includes an operator and a processor speed. The possible operators are equals (=), does
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or
equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and
gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be at
least 2 gigahertz meet the requirement.

Registry Key Exists: Determines if a registry key exists. After specifying the key name, the two
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified key must
exist to meet the requirement. If you select No, the key must not exist.

Registry Key Value: Determines if a registry key value meets a defined condition. The condition you
use to set the requirement includes the key name, the value name, an operator, a value type, and a
value data. The key and value names must identify the key value you want to check. The possible
operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less
than (<), and is less than or equal to (<=). The possible value types are Integer Type and String Type. The
possible value data is determined by the key, value name, and value type.

If the value type is String Type, ZCM compares only those values in the registry if the actual type in
the registry is REG_STRING or REG_EXPANDED_STRING.

If the value type is Integer, ZCM compares only those values in the registry if the actual type in the
registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no
name and is displayed in regedit as (Default).

If the value type is IP Address, ZCM compares only those values in the registry if the actual type in the
registry is REG_STRING.
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For more details, see Registry Key Value information in the Adding System Requirements for a
Bundle section of this guide.

Registry Key and Value Exists: Determines if a registry key and value exist. After specifying the key
name and value, the two conditions you can use to set the requirement are Yes and No. If you select
Yes, the specified key and value must exist to meet the requirement. If you select No, the key and
value must not exist.

Service Exists: Determines if a service exists. After specifying the service name, the two conditions
you can use to set the requirement are Yes and No. If you select Yes, the service must exist to meet the
requirement. If you select No, the service must not exist.

Specified Devices: Determines if the device is one of the specified devices. After specifying the
devices, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the
device must be included in the specified devices list to meet the requirement (an inclusion list). If you
select No, the device must not be included in the list (an exclusion list).

Version of RPM: Determines the version of the RPM name provided if installed. For example, if you
add a system requirement, Version of RPM cups > 1.0, then the requirement evaluates to true, if
cups rpm is installed and the version of the installed cups rpm is greater than 1.0. If cups rpm is not
installed, the requirement is evaluated to be false. The possible operators are equals (=), does not
equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal
to (<=).

Filter Logic

You can use one or more filters to determine whether the bundle should be distributed to a device. A
device must match the entire filter list (as determined by the logical operators that are explained
below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

¢ Designing a filter structure that is easy to understand

¢ Organizing the filters so that you do not create conflicting filters

Filters, Filter Sets, and Logical Operators

You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine
each filter and filter set. By default, filters are combined using OR (as determined by the Combine
Filters Using field) and filter sets are combined using AND. You can change the default and use AND
to combined filters, in which case filter sets are automatically combined using OR. In other words, the
logical operator that is to combine individual filters (within in a set) must be the opposite of the
operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set
options a few times each to create a few filter sets, then switch between AND and OR in the Combine
Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals,
where filters are contained within parentheses, and sets are separated into a series of parenthetical
groups. Logical operators (AND and OR) separate the filters within the parentheses, and the
operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the
filter list, this looks like:
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u AND
v AND
w

OR

X AND
y AND
z

Nested Filters and Filter Sets

Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter set
to match the device is used. Therefore, the order in which they are listed does not matter. You are
simply looking for a match to cause the bundle to be applied to the device.

6.36.3 Fail the action if these requirements fail

If you check this box, the selected action will be marked as failed if the system requirements fail. As a
result you cannot bypass the action that fails and move to the next action for completing the bundle
execution.

NOTE: However you can bypass the action that fails and move to the next action, only if you have
selected the check box in the Continue on Failure column.
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Understanding Bundle Change
Management

ZENworks 11 SP3 provides a change management capability for bundles allowing you to make
changes to them with minimum disruption to IT services.

A sandbox contains changes made to a bundle and is available only to devices or users that have been
flagged as test. This allows you to test the changes made to the bundle in a testing environment
before rolling out the changes into the production environment. If the test results are satisfactory
then you can publish the sandbox, else discard the changes by reverting the sandbox.

The published version is available to all the assigned devices and users that have been flagged as a
non-test. This ensures that all the devices in the network always receive the same version of a bundle.

You can now create a bundle as a sandbox-only bundle or published version of the bundle. If you
select the Create as Sandbox option on the Summary page of the bundle creation wizard, the bundle is
created as a sandbox-only bundle, else a published version of the bundle is created. For more
information on creating a bundle, see Chapter 2, “Creating Bundles,” on page 25.

If you create a bundle as a sandbox, the bundle content replication schedule is modified for that
bundle, so that the content is excluded from all Primary and Satellite servers and is replicated only on
the Primary server that was used to upload the content. For details, see Publishing Sandbox and
Bundle Behavior Based on Content Replication Settings

Also, any change made to the published version of the bundle creates a sandbox. For more
information on managing the bundles versions, see Section 8.4.2, “Managing Bundle Versions,” on
page 168.

You can choose to publish a sandbox either as a new version or a new bundle.For more information
on publishing a sandbox, see Section 8.4.3, “Publishing Sandbox,” on page 169
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8.1

8.1.1

Managing Bundles

The Novell ZENworks Configuration Management Software Management features let you effectively
manage software and content in your ZENworks system.

For more information about creating Preboot bundles, see the ZENworks 11 SP3 Preboot Services and
Imaging Reference.

The following sections contain information to help you manage existing bundles:

¢ Section 8.1, “Bundle Quick Tasks,” on page 159

¢ Section 8.2, “Bundle Tasks,” on page 162

¢ Section 8.3, “Editing Bundle s,” on page 166

¢ Section 8.4, “Bundle Change Management,” on page 167

¢ Section 8.5, “Copying a Bundle to a Content Server,” on page 171

¢ Section 8.6, “Bundle Behavior Based on Content Replication Settings,” on page 173

¢ Section 8.7, “Dependency Bundles,” on page 175

Bundle Quick Tasks

Review the following sections for the bundle related tasks that you can quickly perform on one or
more devices

¢ Section 8.1.1, “Installing a Bundle,” on page 159

¢ Section 8.1.2, “Launching a Bundle,” on page 160

¢ Section 8.1.3, “Uninstalling a Bundle,” on page 161

Installing a Bundle

The Install Bundle option in the Bundle Tasks list in the left navigation pane of ZENworks Control
Center lets you immediately install a bundle to one or more devices.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 In the Bundle Tasks list in the left navigation pane, select Install Bundle.

Bundle Tasks #

New Folder

Mew Bundle

New Bundle Group
Assign Bundle to Device
Assign Bundle to User
Install Bundle

Specify Content
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4 In the Devices section, click Add to select the devices where you want to install the bundle.

5 In the Select Objects dialog box, browse to and select the objects on which you want to install the
bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the
Servers and Workstations folders are displayed along with any custom folders that you have
created in the Devices folder.

Browse for and select the devices, groups, and folders to which you want to assign the bundle.
To do so:

5a Click " next to a folder (for example, the Workstations folder or Servers folder) to
navigate through the folders until you find the device, user, group, or folder you want to
select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you
can use the Items of type list to limit the types of items that are displayed. If you know the
name of the item you are looking for, you can also use the Name filter box to search for the
item.

5b Click the underlined link in the Name column to select the device, group, or folder and
display its name in the Selected list box.

5¢ Click OK to add the selected devices, folders, and groups to the Devices list.
6 Click OK.

If the bundle has not already been assigned to a device, then the bundle’s icon is placed in the
application window of the device.

8.1.2 Launching a Bundle

160

The Launch Bundle option lets you immediately launch a bundle to one or more devices. If the bundle
is not already installed, it is installed and then launched.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Quick Tasks > Launch Bundle.

Bundles

B3 New~ Edit~

Delete Action ~ Quick Tasks -
Instal Bundle...

D Status MHame = R .. Category Enabled Version Has Sandbox
O E:u (9 ini_edit Simple Application Yes 1 No
Distribute Bundle Mow...
ba & notepad Windows Bundle Simple Application Yes 5 Ha
Ll E:s. § wordpad Windows Bundle Simple Application Yes 1 Yes
4|)[1-30t3 show 25 v items

4 In the Devices section, click Add to select the devices where you want to launch the bundle.

5 In the Select Objects dialog box, browse to and select the objects on which you want to launch
the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the
Servers and Workstations folders are displayed along with any custom folders that you have
created in the Devices folder.
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Browse for and select the devices, groups, and folders to which you want to assign the bundle.
To do so:

5a Click # next to a folder (for example, the Workstations folder or Servers folder) to
navigate through the folders until you find the device, user, group, or folder you want to
select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you
can use the Items of type list to limit the types of items that are displayed. If you know the
name of the item you are looking for, you can also use the Name filter box to search for the
item.

5b Click the underlined link in the Name column to select the device, group, or folder and
display its name in the Selected list box.

5¢ Click OK to add the selected devices, folders, and groups to the Devices list.
6 Click OK.

If the bundle has not earlier been assigned to a device, then the bundle’s icon is placed in the
application window of the device.

Uninstalling a Bundle

The Uninstall Bundle quick task lets you uninstall a bundle from one or more devices. Uninstalling a
bundle does not, however, remove its assignments nor prevent the bundle from being reinstalled.

NOTE: To use the Uninstall Bundle quick task, you must enable the bundle’s uninstall options that is
disabled by default. For more information, see Section 12.2.3, “Uninstall Action Set Options,” on
page 209.

To uninstall a bundle:

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Quick Tasks > Uninstall Bundle.

4 In the Bundles section, click [&] to browse to and select the desired bundle (if necessary).
5 In the Devices section, click Add to select the devices where you want to uninstall the bundle.

6 In the Select Objects dialog box, browse to and select the objects on which you want to uninstall
the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the
Servers and Workstations folders are displayed along with any custom folders that you have
created in the Devices folder.

Browse for and select the devices, groups, and folders to which you want to assign the bundle.
To do so:

6a Click # next to a folder (for example, the Workstations folder or Servers folder) to
navigate through the folders until you find the device, user, group, or folder you want to
select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you
can use the Items of type list to limit the types of items that are displayed. If you know the
name of the item you are looking for, you can also use the Name filter box to search for the
item.
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6b Click the underlined link in the Name column to select the device, group, or folder and
display its name in the Selected list box.

6c Click OK to add the selected devices, folders, and groups to the Devices list.
7 Click OK, then click Apply.

If ZENworks Control Center shows that the uninstall fails, examine the device’s log file for more
information.

8.2 Bundle Tasks

Review the following sections for the tasks that you can perform on one or more bundles.

¢ Section 8.2.1, “Renaming, Copying, or Moving Bundles,” on page 162

¢ Section 8.2.2, “Deleting a Bundle,” on page 163

¢ Section 8.2.3, “Preventing a Bundle from Being Deployed,” on page 163

¢ Section 8.2.4, “Enabling a Bundle to Be Deployed,” on page 163

¢ Section 8.2.5, “Enabling Bundle Ordering,” on page 164

¢ Section 8.2.6, “Blocking a Bundle that is Assigned to a Device,” on page 165

¢ Section 8.2.7, “Blocking a Bundle that is Assigned to a User,” on page 165

¢ Section 8.2.8, “Uninstalling a Blocked Bundle,” on page 166

¢ Section 8.2.9, “Unblocking a Bundle That has been Blocked for a Device,” on page 166
¢ Section 8.2.10, “Unblocking a Bundle That has been Blocked for a User,” on page 166

8.2.1 Renaming, Copying, or Moving Bundles

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the option
is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is
selected, the Rename option is not available from the Edif menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the bundle's name, click Edit, then click an option:

Bundles

[] Status Mame | Type Category Enabled  Version  Has Sandbo

0% {1H oyl ‘Windows Bundle Simple Application Yes 1 Mo
1 Comy System Reguirermentsa..

E &y #® porepad Windows Bundle simple Application Yas 5 Mo

O % @ wordpad windows Bundle Simple application Yes 1 Yes

1-30f3 show 25+ items

Rename: Click Rename, provide a new name for the bundle, then click OK.

IMPORTANT: Do not rename Windows MSP bundles.

Copy: Click Copy, provide a new name for the copy, then click OK.
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The copy option is useful to create a new bundle that is similar to an existing bundle. You can
copy a bundle and then edit the new bundle's settings.

Move: Click Move, select a destination folder for the selected objects, then click OK.

If you rename or move a bundle, its assignments are still in place and ZENworks Configuration
Management does not redistribute the bundle to devices or users because of the name or
location change. However, the changes are effective when the subsequent versions of the bundle
are distributed to the devices or users.

8.2.2 Deleting a Bundle

Deleting a bundle removes the bundle content from the ZENworks content servers but does not
uninstall it from devices where it has already been installed. To uninstall it from devices, you should
use the Uninstall options before deleting the bundle.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Delete.

NOTE: Deleting a Linux or Linux dependency bundle does not immediately remove the YUM
service that was created for the bundle. The YUM service is removed when the next YUM Services
Refresh is configured. Click the Click here to Update YUM Service Now link in YUM Service Settings to
remove the YUM service immediately.

8.2.3 Preventing a Bundle from Being Deployed

A disabled bundle is not deployed to new managed devices or replicated to content servers. It
remains on the device and content server to which it has already been deployed until the next device
refresh.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Disable.

Bundles

B3 New~ Edit~ Delete Action~ Quick Tasks~

Assign to Device...

|:| Status Mame = 5 Category Enabled Version Has Sandbox
Assign to User...
o Gl A s L
Ol #5 & ini_edit fddiToGroty. . 5 Bundle Simple Application Yes 1 No
Specify Content Server...
B i icati
% @ notepad . Bundle Simple Application Yes 5 Mo
Nisable
o i : 2 i
O % & wordpad Rubih Bndets) k Bundle simple Application Yes 1 Yes
4| b |1-303 show 25 ¥ items

8.2.4 Enabling a Bundle to Be Deployed

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
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3 Click Action > Enable.

Bundles
2 New~ Edit~ Delete Action» Quick Tasks »

Assign to Device...

|:| Status Hame = g Category Enabled Version Has Sandbox
Assign to User...
O & & ini_edit 610 Grop:,. k Bundle simple Application Yes 1 No
Specify Content Server...
-
é‘n & notepad e 5 Bundle Simple Application Yes 5 No
5aDE
s -
O & @ wordpad Pubiish B} E Bundle Simple Application Yes 1 Yes
4] r]1-30f3 show 25 v items

8.2.5 Enabling Bundle Ordering

¢ “Enabling Ordering” on page 164
¢ “Configuring Time Slice on the Agent” on page 165

Enabling Ordering

You can use Bundle Ordering to prioritize the way bundles are executed. When you assign an order
value to a bundle, the bundles are executed based on the value assigned. Multiple bundles can be
executed simultaneously, or the order of execution can be prioritized.
1 In ZENworks Control Center, click the Bundles tab.
2 Select an existing bundle or create a new Windows or Linux bundle.
For more information, see Chapter 2, “Creating Bundles,” on page 25.

3 In the General tab of the Summary page, click Yes next to the Enable Bundle Ordering field. This
activates the Bundle Order field.

Add-on Image File: (Create) (Mo add-on image)
Show Bundle Activity: No [Yes)
Dependency Bundles: (Mone)

Enable Bundle Ordering: Mo (Yes)

Bundle Order:
Wait for previous Bundle execution to complete:

4 Click Edit next to the Bundle Order field.

Add-on Image File: (Create) (Mo add-on image)
Show Bundle Activity: Mo (Yes)
Dependency Bundles: [Mone)

Enable Bundle Ordering: Yes [Mo)

Bundle Order: (Edit) (]

Wait for previous Bundle execution to complete: Mo (Yes)

5 In the Bundle Order dialog box that appears, specify a value and then click OK.

Bundle Order:

OK ]

Cancel ]

Values can range from 0 to 9999999. The default value 0, has the highest priority. Bundles are
executed in the ascending order of the values assigned.
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8.2.7

6 (Optional) Click Yes next to Wait for previous Bundle execution to complete, if you want bundles
with lower priorities to wait for bundles with higher priority to complete execution.

Add-on Image File: (Create) [No add-on image)
Show Bundle Activity: No (Yes)
Dependency Bundles: [Mone)

Enable Bundle Ordering: Yes [Mo)

Bundle Order: (Edit) 0

Wait for previous Bundle execution to complete: ‘Yes (Mo)

7 Click Publish.

NOTE: Multiple bundles are executed on the ZENworks agent, even if the bundle ordering feature is
not enabled. But if a bundle is an Install, Patch, or an Update bundle, then the next bundle waits until
the previous bundle is executed. Bundle ordering is applicable to Linux as well as Windows bund]es.

Configuring Time Slice on the Agent

Time slice configuration sets the amount of time that the agent waits before reordering the assigned
bundles. The time slice duration is configurable on the agent; the default is 5 seconds. This value can
be changed. It should be an integer value and is calculated in seconds.

To change the default time slice value of the ZENworks Adaptive Agent on a Windows managed
device:

1 Open the Registry Editor.
2 Go to HKLM\Software\Novell\ZCM\.

3 Add the BundleOrderingTimeSlice parameter as any value greater than 0, in seconds.
To change the default time slice value of the ZENworks Adaptive Agent on a Linux managed device:

1 Open /etc/opt/novell/zenworks/conf/xplatzmd.properties in a text editor.

2 Add the BUNDLE_ORDERING TIME LAG SEC parameter as any value greater than 0, in seconds.

Blocking a Bundle that is Assigned to a Device

In scenarios where the behavior of a bundle is not as per expectation, you can choose to block the
bundle from being executed on a device. This eliminates the need of altering the bundle assignment.

1 In ZENworks Control Center, click the Devices tab.

2 Navigate to the device for which you want to block the bundle.

3 Click Relationships.

4 In the Assigned Bundles panel, select the bundles you want to block on the device.
5 Click Block.

Blocking a Bundle that is Assigned to a User

In scenarios where the behavior of a bundle is not as per expectation, you can choose to block the
bundle from being executed on a device that the user has logged in. This eliminates the need of
altering the bundle assignment.

1 In ZENworks Control Center, click the Users tab.
2 Navigate to the user for which you want to block the bundle.
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3 Click Relationships.

4 In the Assigned Bundles panel, select the bundles you want to block on the device that the user
has logged in.

5 Click Block.

8.2.8 Uninstalling a Blocked Bundle

In ZENworks Control Center, click the blocked bundle that you want to uninstall.
Click Actions > Uninstall.

Click Options to display the Uninstall Options dialog box.

Click Enable Uninstall.

In the Blocked Assignment Options section, select Uninstall application and click OK.
Click Apply.

Click Publish to publish the bundle to next version.

~N o 0o~ WN P

The bundle un installs by running the actions listed within the Uninstall action set.

8.2.9 Unblocking a Bundle That has been Blocked for a Device

1 In ZENworks Control Center, click the blocked bundle that you want to unblock.

2 In the Bundle Status panel, click Refresh.

3 Click the underlined link in the Blocked column for the device.

4 In the Bundle Status (Device assignments-Blocked) page, select the devices for which you
want to unblock the bundle and click Unblock.

8.2.10  Unblocking a Bundle That has been Blocked for a User

1 In ZENworks Control Center, click the blocked bundle that you want to unblock.

2 In the Bundle Status panel, click Refresh.

3 Click the underlined link in the Blocked column for the user.

4 In the Bundle Status (User assignments-Blocked) page, select the user for whom you

want to unblock the bundle and click Unblock.

8.3 Editing Bundle s

After you have assigned a bundle to a device or user, you can choose to edit the bundle :

1 In ZENworks Control Center, click the Bundles tab.
2 Click the desired bundle for which you want to edit the .
3 Click the Relationships tab.

4 Click the Assignment Details link of the assignment for which you want to edit the .
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8.4.1

5 In the View Assignment Details dialog box, click the link next to the type you want to edit.

6 In the dialog box that displays, edit the as desired. For more information on how to edit the,
click Help.

Bundle Change Management

ZENworks 11 SP3 provides a change management capability for bundles allowing you to make
changes to them with minimum disruption to IT services.

To understand bundle change management, see Chapter 7, “Understanding Bundle Change
Management,” on page 157.

Review the following sections:

¢ Section 8.4.1, “Understanding Bundle Versions,” on page 167
¢ Section 8.4.2, “Managing Bundle Versions,” on page 168
¢ Section 8.4.3, “Publishing Sandbox,” on page 169

Understanding Bundle Versions

Bundle Change Management allows you to create either a sandbox-only bundle or a published
version of the bundle. If you edit a published version of the bundle, a sandbox is created. You can
choose to publish the sandbox either as a new version of the bundle or a new bundle.

For more information on the bundle versions, see Section 8.4.2, “Managing Bundle Versions,” on
page 168.

For more information on publishing the sandbox, see Section 8.4.3, “Publishing Sandbox,” on
page 169Section 8.4.3, “Publishing Sandbox,” on page 169.

The Displayed Version option on the bundle’s page lists all the existing versions of the bundle, and the
latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is
selected by default.

Scenario:

1 Consider a bundle named sosl that is created as a sandbox. The Displayed Version option on the
bundle page lists Sandbox and it is selected by default.

2 Click Publish to publish the sandbox to a new version. The Displayed Version option on the bundle
page now lists 0(Published) and it is selected by default.

3 Edit the bundle’s description to create a sandbox. The Displayed Version option on the bundle
page now lists 0(Published) and Sandbox. Sandbox is selected by default.

4 Click Publish to publish the sandbox to a new version. The Displayed Version option on the bundle
page now lists O(Published), and 1(Published). The bundle’s latest version, 1(Published), is selected
by default.

0 is the older version of the bundle.

5 Edit the bundle’s description again to create a sandbox. The Displayed Version option on the
bundle page now lists 0(Published), 1(Published), and Sandbox. Sandbox is selected by default.

0 is the older version of the bundle and 1(Published) is the latest version of the bundle.
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6 Click Publish to publish the sandbox to a new version. The Displayed Version option on the bundle
page now lists 0(Published), 1(Published), 2(Published). The bundle’s latest version, 2(Published), is
selected by default.

0 and 1 are the older versions of the bundle; and 2(Published) is the latest version of the bundle.

8.4.2 Managing Bundle Versions

The Displayed Version option on the bundle’s page lists all existing versions of the bundle, and the
latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is
selected by default.

For more information on the bundle versions, see Section 8.4.1, “Understanding Bundle Versions,” on
page 167.

Select the version of the bundle whose details you want to view or edit.

Task Steps Additional Details

Create a sandbox from the 1. Select the published version A single modification made to the

published version of the bundle of the bundle. bundle creates a sandbox. The
2. Edit the bundle. created sandbox is a copy of the

bundle and also includes the
additional edit. However, the
change is not made to the
published version of the bundle.

The sandbox flows to the test
devices and users to whom the
bundle is assigned.

Changes can now be made to the
sandbox.

You can revert a sandbox to the
original version of the bundle or
publish a sandbox to create a hew
version or a new bundle.

Create a sandbox from an older 1. Select an older version of the The created sandbox is an exact
version of the bundle bundle. copy of the bundle version.

2. Click Create Sandbox. Changes can now be made to the

sandbox.

Publish a sandbox 1. Select Sandbox. The sandbox must be published for
2. Click Publish to display the the changes'to be effective on the
non-test devices and users to

Publish Option page. whom the bundle is assigned.

Revert a sandbox 1. Select Sandbox. All the changes made are
2. Click Revert to delete the d|§c?rded. The sandbox no longer
sandbox. EXISIS.

The published version of the bundle
is displayed in the Displayed
Version option.
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Task Steps Additional Details

Delete an older version of the 1. Select an older version of the To delete all older versions of a
bundle bundle. bundle or delete all versions older
than a particular version, click
Delete Older Versions under the
Bundle Tasks list located in the
ZENworks Control Center left
navigation pane.

2. Click Delete Selected Version.

Publishing Sandbox

The sandbox must be published for the changes to be effective on the devices and users to whom the
bundle is assigned. You can choose to publish the sandbox either as a new version or as a new
bundle.

Review the following sections:

¢ “Publishing a Sandbox as a New Version” on page 169
¢ “Publishing a Sandbox as a New Bundle” on page 170
¢ “Publishing Multiple Sandbox as New Versions” on page 171

Publishing a Sandbox as a New Version

Publishing a sandbox as a new version lets you create a new version of the bundle that has a version
number incremented by one from the latest available version of the bundle.

Perform the following steps in the ZENworks Control Center:

1 On the page of the bundle that you want to publish, select Sandbox in the Displayed Version
option.

2 Click Publish to display the Publish Option page.

3 Click Publish as New Version.

4 (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is
displayed.

This page lists all the bundles that the sandbox you want to publish depends on. These can
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must
publish all the dependent sandbox-only bundles. However, you can choose to publish all the
dependent sandbox bundles.

4a You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish
all the dependent child bundles that have a sandbox-only version.

4b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the
dependent child bundles that have a sandbox.

4c On the Summary Page, review the information and, if necessary, use the Back button to
make changes to the information

5 Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists O(Published), 1(Published),
and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed Version
option on the bundle page now lists O(Published), 1(Published), and 2(Published).

Managing Bundles 169



170

Publishing a Sandbox as a New Bundle

Publishing a sandbox as a new bundle creates a new bundle. Perform the following steps in the
ZENworks Control Center:

1

On the page of the bundle that you want to publish, select Sandbox in the Displayed Version
option.

2 Click Publish to display the Publish Option page.
3 Click Publish as New Bundle.

Specify a name for the bundle.

The bundle name must be different from the name of any other item (bundle, group, folder, and
so forth) that resides in the same folder. The name you provide displays in ZENworks Control
Center and the ZENworks Adaptive Agent (on managed devices).

For more information, see “Naming Objects in ZENworks Control Center” in the ZENworks 11
SP3 ZENworks Control Center Reference.

Specify the folder name or browse to the ZENworks Control Center folder where you want the
bundle to reside. The default is /bundles, but you can create additional folders to organize your
bundles.

Select the Create as Sandbox option to create a sandbox-only version of the bundle and deploy the
bundle as a sandbox. The sandbox version of a bundle enables you to test it on your device
before actually deploying it.

Select the bundle groups that the new bundle should be a member of.

8 Click Next to display the Select Assignments page.

9 Select the device and user assignments that you want to apply to the new bundle.

10
11

12

13

Click Next.

(Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is
displayed.

This page lists all the bundles that the sandbox you want to publish depends on. These can
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must
publish all the dependent sandbox-only bundles. However, you can choose to publish all the
dependent sandbox bundles.

11a You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish
all the dependent child bundles that have a sandbox-only version.

11b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the
dependent child bundles that have a sandbox.

1l1c By default, the dependent bundles are published to the next version. You can choose to
select the Publish the dependent bundles as new bundles option to publish the dependent
bundles as new bundles.

Specify the name or browse to the folder where you want the new bundles to reside. If a
bundle that has the same name as the new bundle already exists in the specified folder, then
the new bundle is saved with a random GUID appended to its name.

On the Summary Page, review the information and, if necessary, use the Back button to make
changes to the information.

Click Finish to create the bundle.
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8.5

Publishing Multiple Sandbox as New Versions

Perform the following steps in the ZENworks Control Center:

1 Select a few bundle folders, bundle groups and bundles.
2 Click Action > Publish Bundle(s) to display the Publish Options page.

3 (Conditional) Select the Include bundles from subfolders also option to publish all the bundles
within the selected folders as new versions of the bundles.

This option is displayed only if you have selected a bundle folder in Step 1.
4 Click Next. On the Select Bundles page, select the bundles you want to publish to next
version, then click Next.

5 (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is
displayed.
This page lists all the bundles that the sandbox you want to publish depends on. These can
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must
publish all the dependent sandbox-only bundles. However, you can choose to publish all the
dependent sandbox bundles.

5a You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish
all the dependent child bundles that have a sandbox-only version.

5b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the
dependent child bundles that have a sandbox.

5¢ On the Summary Page, review the information and, if necessary, use the Back button to
make changes to the information

6 Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists O(Published), 1(Published),
and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed Version
option on the bundle page now lists O(Published), 1(Published), and 2(Published).

Copying a Bundle to a Content Server

By default, a bundle’s content is copied to primary content server. If you specify certain content
servers as hosts, the bundle is hosted on only those content servers; it is not copied to all content
servers. You can also specify whether the selected bundle is replicated to new content servers
(ZENworks Servers and satellite servers) that are added to the Management Zone.

To specify a content server:

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Action > Specify Content Server.

4 The Configure Primary Server Content Replication page lets you specify on which content
servers (ZENworks Servers) the content is hosted.

The relationships between content and content servers that you create using this wizard
override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and
Server 2 and you use this wizard to host it on Server 1 only, Bundle A is excluded from Server 2
and is removed during the next d replication.

4a In the Excluded Primary Servers list, select the desired content server.
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You can use Shift+click and Ctrl+click to select multiple content servers.
4b Click the > button to move the selected content server to the Included Primary
Servers list.

4c Specify the default replication behavior for new ZENworks Primary Servers added to the
system:

¢ Include This Content: Replicates the content to any servers created in the future.

¢ Exclude This Content: Excludes the content from being replicated to any servers
created in the future.

Be aware that any content replication relationships previously set between the content and
servers are lost upon completion of this wizard.

5 Click Next to display the Configure Satellite Server Content Replication page:

Specify Content
XN Step 2: Configure Satellite Server Content Replication

Select all satellite content servers that should replicate the content previously selected and
the default behavior for any satellite content servers subsequently added to the zone,

ofl Please chaoose the satellite content servers that will replicate the content:

Excluded Satellite Servers Included Satellite Servers
Devices/Servers/FTH 0 Satellite &
Devicesforkstations/FTH 0 Sa

[Devices/Servers/FTH 0 Satellite <

Please choose the default replication behavior for any new satellite content servers
added to the systern:

Mew satellite content servers will:
Olnclude this content
@ Exclude this content

WARNING: Any content replication relationships previously set between the content
and servers selected by this wizard will be LOST.

<< Back Hext > Cancel

This page lets you specify on which content servers (satellite servers) the content is hosted.

The relationships between content and content servers that you create using this wizard
override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and
Server 2 and you use this wizard to host it on Server 1 only, Bundle A is excluded from Server 2
and is removed during the next d replication.

5a In the Excluded Satellite Servers list, select the desired content server.
You can use Shift+click and Ctrl+click to select multiple content servers.

You cannot include content on a satellite server without including it on the satellite server’s
parent ZENworks Server. You must select both the satellite server and its parent.

5b Click the > button to move the selected content server to the Included Satellite
Servers list.
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5¢ Specify the default replication behavior for new ZENworks satellite servers added to the

system:

¢ Include This Content: Replicates the content to any servers created in the future.

¢ Exclude This Content: Excludes the content from being replicated to any servers

created in the future.

Be aware that any content replication relationships previously set between the content and
servers are lost upon completion of this wizard.

6 Click Next to display the Finish page, then review the information and, if necessary, use the Back
button to make changes to the information.

7 Click Finish to create the relationships between the content and the content servers. Depending
on the relationships created, the content is replicated to or removed from content servers during

the next d replication.

Bundle Behavior Based on Content Replication Settings

When you created a bundle in earlier versions of ZENworks, the bundle inherited the content
replication settings from its parent folder by default. However, with the introduction of Bundle
Change Management, the behavior has been changed. For more information on this change, see the

following table:

Task Information

Creating a bundle (not as a The new bundle inherits the settings from its parent folder by default.
sandbox)

Creating a bundle as a sandbox The new bundle neither inherits settings from its parent folder nor does it

replicate content by default.

To replicate the content on new Primary Servers:

1. In ZENworks Control Center, click the bundle.
2. Click the Settings tab.

3.
4

. In the Primary Server Replication Status panel, select the New

Click Primary Server Replication.

Primary Servers added to the system will include this content by
default option.

To replicate the content on new Satellite Servers:

1. In ZENworks Control Center, click the bundle.
2. Click the Settings tab.

3.
4

. In the Satellite Server Replication Status panel, select the New

Click Satellite Server Replication.

Satellite Servers added to the system will include this content by
default option.

NOTE: The Sync Sandbox Content to Content Servers option on the

Sandbox Settings page of the bundle is deselected and is not editable.
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Task Information

Creating a sandbox from a The sandbox version of the bundle neither inherits settings from its parent
published version or an older folder nor does it replicate content by default.

version of the bundle

To replicate the content on new Primary and Satellite Servers:

1. In ZENworks Control Center, click the bundle.

2. Click the Settings tab.

3.

4. In the Sandbox Content Replication panel, select the Sync Sandbox

Click Sandbox Settings.

Content to Content Servers option.

Publishing a bundle to create a new If you publish a bundle to create a new bundle with the Create as

bundle as a sandbox Sandbox option selected then the new bundle is created as a sandbox.
The new bundle neither inherits settings from its parent folder nor does it
replicate content by default.

To replicate the content on new Primary Servers:

1. In ZENworks Control Center, click the bundle.
2. Click the Settings tab.

3.
4

. In the Primary Server Replication Status panel, select the New

Click Primary Server Replication.

Primary Servers added to the system will include this content by
default.

If you want to replicate the content on new Satellite Servers, do the
following:

1. Click the Bundle.

2. Click the Settings tab.

3.

4. In the Satellite Server Replication Status panel, select the New

Click Satellite Server Replication.

Satellite Servers added to the system will include this content by
default option.

NOTE: The Sync Sandbox Content to Content Servers option on the
Sandbox Settings page of the bundle is deselected and is not editable.

Publishing a bundle to create a new The settings of the new bundle depend on the source bundle from which it
bundle (not as a sandbox) has been created.

+ If you publish a sandbox-only bundle whose replication settings

have not been modified, the new bundle inherits settings from the
parent folder.

If you publish a sandbox-only bundle whose replication settings
have been modified, the modified replication settings are copied to
the new bundle.

If you publish a sandbox that has been created from a published
version or an older version of a bundle, the content replication
settings from the published version of the source bundle are copied
to new bundle.
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8.7.1

Dependency Bundles

When you create the following actions for a bundle, you create bundle dependencies:

¢ Action - Install Bundle
¢ Action - Launch Bundle
+ Action - Uninstall Bundle

¢ Action - Verify Bundle

A bundle’s Dependency Bundles tree shows the chaining information of that bundle and the action
sets that each dependency is in. To view the Dependency Bundles tree in ZENworks Control Center,
click the Bundles tab, click a bundle that has dependent bundles, then on the Summary tab, click the
Display Bundle Dependencies link in the Dependency Bundles row. If the selected bundle does not have
dependent bundles, the link displays None instead of Display Bundle Dependencies.

The following sections contain additional information:

¢ Section 8.7.1, “Primary Applications vs. Dependent Applications,” on page 175
¢ Section 8.7.2, “Bundle Chains,” on page 176

¢ Section 8.7.3, “Distributing, Installing, and Launching a Bundle That Has Dependencies,” on
page 176

Primary Applications vs. Dependent Applications

When working with bundle dependencies, the primary bundle is the bundle for which you are
establishing dependencies. The bundles that are defined as dependencies are called the dependent
bundles. The following illustration shows this relationship. Application A as the primary bundle
with Applications B, C, and D as dependent bundles.

Figure 8-1 Dependency Bundle Tree

=& /Bundles/Application A (Current Node)
rﬁ /Bundles/Application B Belongs to: Install Action Set(s)
lg [Bundles/Application D Belongs to: Launch Action Setis)
Ig /Bundles/Application C Belongs to: Uninstall Action Set(s)

A primary bundle can have one dependent application or, as shown in the above example, it can have
multiple dependent applications.

In addition, a bundle can be both a primary bundle and a dependent bundle, as shown in the
following illustration. Application A as the primary bundle, with Applications B, B1, B2, C, and D as
dependent bundles.

Figure 8-2 Dependency Bundle Tree

=& /Bundles/Application A (Current Node)
‘@ /Bundles/Application B Belongs to: Install Action Setis)
[9 fBundles/Application B1 Belongs to: Install Action Sets)
19 fBundles/Application B2 Belongs to: Launch Action Setis)
@ /Bundles/Application D Belongs to: Launch Action Setis)
@ /Bundles/Application C Belongs to: Uninstall Action Setis)
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In the above example, Application B is one of Application A's dependent bundles. At the same time,
Application B has dependencies on two bundles, Application B1 and Application B2.

8.7.2 Bundle Chains

A bundle chain is two or more bundles linked together by dependencies. In its simplest form, a
application chain consists of two levels, as shown in the following illustration.

Figure 8-3 Dependency Bundle Tree

=& /Bundles/Application A (Current Node)
Ig /Bundles/Application B EBelongs to: Install Action Set(s)
rﬁ /Bundles/Application D Belongs to: Launch Action Set(s)
@ [Bundles/Application C Belongs to: Uninstall Action Setfs)

However, when bundle dependencies are nested, a bundle chain can grow to include many levels. In
the following example, Application A has a dependency on Application B. Application B, in turn, has
dependencies on Application B1 and Application B2. As a result, all three bundles (B, B1, B2), in
addition to applications C and D, must be present in order for Application A to run.

Figure 8-4 Dependency Bundle Tree
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In some cases, a bundle might belong to more than one bundle chain, as in the following example
where Application D is a dependent application for both Application A and Application E.

=& /Bundles/Application A
248 /Bundles/Application B Belones to: Install Action Setis)
‘rﬁ /Bundles/Application B1 Belongs to: Launch Action Set(s)
fﬁ /Bundles/Application B3 Belongs to: Launch Action Set(s)
Ig /Bundles/Application B2 Eelongs to: Launch Action Set(s)
Ig fBundles/Application D Belongs to: Launch Action Set(s) (Current Hode)
@ fBundles/Application C Belongs to: Uninstall Action Setis)
=& JBundles/Application E
fBundles/Application D Belongs to: Launch Action Set(s) (Current Hode)

8.7.3 Distributing, Installing, and Launching a Bundle That Has
Dependencies

When setting up bundle dependencies, you should be aware of the following;:
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Bundle Assignment: A dependent bundle does not need to be assigned to devices or users. The
primary bundle, however, must be assigned to one or more devices or users for it to function

properly.

Distribution and Installation: If dependent bundles have not already been distributed to or installed
on the user's workstation, when a user launches or installs a bundle, ZENworks Adaptive Agent
distributes and installs them. If ZENworks Adaptive Agent is unable to distribute or install a
dependent bundle (for example, the user’s workstation does not meet the dependent bundle’s system
requirements), the primary bundle is not launched or installed.

Distribution Through an Add-On Image: If you distribute a bundle through an image add-on, its
dependent bundles must be included as another image add-on. Otherwise, the distribution of the
primary bundle fails.

Distribution to Disconnected Workstations: For disconnected workstations, the bundles must be
force cached to the workstation before it becomes disconnected. If changes are made to dependent
bundles after the bundles have been cached to workstations, the version number of the primary
bundle must be updated in order to force a re-cache of the bundles.

Launch: Each time a bundle is launched, ZENworks Adaptive Agent performs any launch
operations, such as other actions, defined for its dependent bundles.

Reboot/Shutdown: Ensure that the dependent bundle does not include a Reboot / Shutdown action.

Redeploying a Bundle to Refresh Its Dependencies: ZENworks Adaptive Agent distributes a
dependent bundle only once, unless the dependent bundle’s version is updated or the distribution or
installation is unsuccessful. If you include a dependent bundle in a primary bundle through the
Install action set, and if there are changes in the dependent bundle, you need to change the primary
bundle to reflect the dependent bundle changes. If you include a dependent bundle in a primary
bundle through the launch action set, and if there are changes in the dependent bundle, you need to
launch the primary bundle again to reflect the dependent bundle changes.
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9.1

Managing Bundle Assignments

Novell ZENworks 11 SP3 lets you assign bundles to users as well as devices. Device-assigned
bundles are available whenever the device is running and connected to the network; user-assigned
bundles are available only when the user is logged in to the Management Zone. For example, if you
assign a bundle to a user, the bundle is available only after the user logs in.

Unlike devices, users are not defined in your Management Zone. Instead, you connect to the LDAP
directory that you want to use as your authoritative user source. If necessary, you can connect to
multiple directories. For more information on the user source, see the ZENworks 11 SP3 User Sources
Reference.

NOTE: Bundles can have a priority configured to determine the bundle assignment that is effective
for a device or a user. Bundles can be assigned to a user or a device through direct association or
through inheritance.

A bundle can be assigned to a user or a device, a user or device group, or a user or device folder. Each
of these assignments also supports scheduling, so you can set a schedule for the deployment of a
bundle. If you have different schedules configured for users, devices, or their groups and folder
assignments, the priority of the schedules is as follows:

1. Bundles assigned through direct association (device or user)

2. Bundles assigned through a group (device group or user group)

3. Bundles assigned through a folder (device folder or user folder).

You can manage a bundle assignment from the bundle’s Relationships page (Click the bundle and
then the Relationship tab). The Relationships page is not affected by the bundle change management
capability.

Review the following sections:

¢ Section 9.1, “Assigning Existing Bundles to Devices,” on page 179
¢ Section 9.2, “Assigning Existing Bundles to Users,” on page 184

¢ Section 9.3, “Assigning a Bundle Group to Devices,” on page 187
¢ Section 9.4, “Assigning a Bundle Group to Users,” on page 188

¢ Section 9.5, “Copying the Relationships of a Device to Other Devices, Folders, and Groups,” on
page 190

Assigning Existing Bundles to Devices

When you create bundles, the object is created without assigning devices or users to it, or specifying
distribution, launch, or availability schedules. Before the bundle can be used on assigned devices,
you must complete the steps in the following procedure. You can assign bundles to devices, device
groups, or device folders.
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You can use ZENworks Control Center or the zman command line utility to assign bundles. The
following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer
the zman command line utility, see the “Bundle Commands” in “ZENworks Command Line
Utilities”.

1 In ZENworks Control Center, click the Bundles tab.

2 Select the desired bundle in the Bundies list by clicking the box next to its name, click Action, then
click Assign to Device.

or

Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.

Bundies

E| Status Hame 2 Type Category Enabled ¥ersion Has Sandbox

O % & chrome Windaws Bundle ‘fes 0 ho

O % @ firefox Windows Bundle Yes 0 Yes

O & P Windows Bundle Yes 0 ho

O ¥ &P e is4 bit) Windows Bundle Yes 0 No

0 %4 & opera - Growp windows Bundle Yes 0 Yes

i '%I* j? Safari Windows Bundla Yes 0 Mo

(| »|1-6016 show 25 v items

A bundle must be assigned to devices and users before it can be distributed to them.

You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle to
a folder or group is the preferred method of assigning bundles. This allows for easier
management of the bundle assignments and can decrease the possibility of high server

utilization caused by assigning the bundle to a large number of items (for example, more than
250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign the
bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the
Servers and Workstations folders are displayed along with any custom folders that you have
created in the Devices folder.

Browse for and select the devices or users, groups, and folders to which you want to assign the
bundle. To do so:

3a Click ¢ next to a folder (for example, the Workstations folder or Servers folder) to
navigate through the folders until you find the device, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you
can use the Items of type list to limit the types of items that are displayed. If you know the
name of the item you are looking for, you can also use the Item name box to search for the
item.

3b Click the underlined link in the Name column to select the device, group, or folder and
display its name in the Selected list box.

3c Click OK to add the selected devices, folders, and groups to the Devices list.
4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device
where ZENworks Adaptive Agent displays the bundle’s icon.
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Assign Bundle
<N Step 1: Bundles to be Assigned

Select the bundles to be assigned to the previously selected device (/Devices/Workstations/Macintosh OS % 10.5 (Leopard)).

Add Remove

[] Hame In Folder

& opera - Group /Bundles

Shortcut Location

Select the locations to place the shortcut for the bundle.

Application Window Desktop [] 3 start Menu
[J &l Quick Launch [] & system Tray

<< Back Next >> I ‘ Cancel

The possible locations include the following:

Application Window: Places the icon in the Application window. This location is selected by
default.

Quick Launch: Places the icon on the Quick Launch area of the Windows taskbar.
Desktop: Places the icon on the device’s desktop.
System Tray: Places the icon in the system tray (notification area) of the Windows taskbar.

Start Menu: Places the icon on the Start menu on all Windows devices except for Windows Vista
and later. It places the icon in Start > All Programs on Windows Vista and later.

On a Windows Vista devices, if you want to change the look and feel of the Start menu or pin
applications to the Start menu, see Appendix D, “Best Practices,” on page 237.

5 Click Next to display the Schedules page.

Bundles » Opera- Group@®5Sandbox > Assign Bundle

Assign Bundle
N Step 2: Schedules and flags

Select one or more of the optional schedules that you would like to configure. Bundle actions can be scheduled along with
the time window during which the bundle will be available to users.

[¥! pistribution Schedule
[JLaunch Schedule
[ availability schedule

Cattempt a dry run (Useful for Linux Bundles)

<< Back | Next >> Cancel

In the Schedules page select the schedules you want to define:

Distribution Schedule: Defines the dates and times when the content of the bundle is
distributed from the ZENworks Server to the managed device or user. If you do not establish a
schedule, the bundle’s content is distributed to the device or user when it is first launched.
However, the schedule does not define the date and time when the action in the bundle runs.
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Launch Schedule: Defines the dates and times when the ZENworks Adaptive Agent
automatically launches the bundle. If you do not establish a schedule, the bundle is launched
only when the user launches it. Before launching the bundle, the ZENworks Adaptive Agent
checks if the bundle is distributed and installed. If the bundle is not yet distributed, the agent
first distributes the bundle, performs the bundle’s install actions to install the bundle, then
performs the bundle’s launch actions to launch it.

IMPORTANT: If Install Immediately after Distribution and Launch Immediately after Installation
options are set for the distribution schedule of a bundle, the content of the bundle is distributed
as per the schedule and, then the bundle is installed and launched.

The Bundle that is distributed once will not be distributed again on the next schedule. Hence,
the Install Immediately after Distribution and Launch Immediately after Installation options which are
specified in the distribution schedule are not considered on subsequent schedules.

To launch the same bundle repeatedly on subsequent schedules, you need to configure the
launch schedule.

Availability Schedule: Defines the dates and times when the bundle is available to the device or
user. The ZENworks Adaptive Agent displays the bundle icon only during the times defined by
the schedule. If you do not establish a schedule, the bundle is available at all times.

NOTE: If a bundle with an assignment schedule fails to execute on a device, an attempt to
execute the bundle on the device is made five times, by default.

To change the default value:
1. Open the Registry Editor.
2. Go to HKLM\ Software\Novell\ZCM\.
3. Create a STRING called ScheduleRetries, and set its value as desired.

For example, if you do not want the failed bundle to be executed again on the device, set the
value of the ScheduleRetries to 0.

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle
Distribution Schedule page.
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Bundles » Opera - Group@5Sandbox > Assign Bundle

Assign Bundle
N Step 3: Bundle Distribution Schedule

Select the schedule to determine when the files are downloaded by the managed devices, If no schedule is configured, the
files will be downloaded at install time

Schedule Type:
:Date Specific v

Start Date(s): *

[ run event every year
[ process immediately if device unable to execute on schedule

Select when schedule execution should start:
@ start immediately at Start Time
(O <tart at a random time between Start and End Times

Start Time: :1 v/ (00 v End Time: [
[Tuse Coordinated Universal Time | Current UTC é:15 Ak )

[Jwake-on-LAN [&pplies to Devices anly) Options
install Immediately after Distribution
[CILaunch Immediately after Installation

| << Baok Next >> | Cancel

The distribution schedule defines the dates and times when the bundle is distributed from the
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle
to be distributed to the device when it is first launched.

In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed
information, click the Help button on the wizard page or see the following sections in the
ZENworks 11 SP3 Primary Server and Satellite Reference:

¢ “Date Specific”
¢ “Recurring”

¢ “Event”

¢+ “Now”

For the 'Now' schedule to be effective during bundle assignment, ensure that the number of
devices to which you want to assign a bundle does not exceed 30. The Now schedule sets a
refresh device schedule and triggers a bundle quick task. To assign bundles randomly to more
than 30 devices, use the Quick Tasks option in ZENworks Control Center.

For more information on the quick tasks, see “Quick Tasks Types” in the ZENworks 11 SP3
ZENworks Control Center Reference.

Select the following options as desired:

Wake-on-LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake-
on-LAN (WOL) technology to power on the device. The device must support WOL.
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NOTE: If you are assigning bundles to Wake-on-Lan devices with Date Specific scheduling
option, you need to enable the Process immediately if device unable to execute on schedule option.
This is required for the distribution to occur on schedule after the device wakes and receives the
bundle distribution schedule.

Install Immediately After Distribution: Performs any installation actions immediately after the
bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the
bundle is installed. This option is available only if the Install Immediately After Distribution option
is enabled.

(Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle Launch
Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent
automatically launches the bundle. The default schedule (no schedule) results in the bundle only
being launched if the user launches it.

In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed
information, click the Help button on the wizard page or see the following sections in the
ZENworks 11 SP3 Primary Server and Satellite Reference:

¢ “Date Specific”
¢ “Recurring”
¢ “Event”

(Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times
defined by the schedule. The default schedule (no schedule) makes the bundle available at all
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user
has not yet installed the bundle, it is only available for installation at the times specified by the
schedule. If a user has already installed the bundle, it is only available for running during the
scheduled times.

In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed
information, click the Help button on the wizard page or see the following sections in the
ZENworks 11 SP3 Primary Server and Satellite Reference:

¢ “Date Specific”
¢ “Recurring”

Click Next to display the Finish page, review the information and, if necessary, use the Back
button to make changes to the information.

Click Finish.

Assigning Existing Bundles to Users

When you create bundles, the object is created without assigning devices or users to it, or specifying
distribution, launch, or availability schedules. Before the bundle can be used on assigned devices,
you must complete the steps in the following procedure. You can assign bundles to users, user
groups, or user folders.
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You can use ZENworks Control Center or the zman command line utility to assign bundles. The
following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer
the zman command line utility, see the “Bundle Commands” in “ZENworks Command Line
Utilities”.

1 In ZENworks Control Center, click the Bundles tab.

2 Select the desired bundle in the Bundies list by clicking the box next to its name, click Action, then
click Assign to User.

or

Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.

Bundles
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A bundle must be assigned to devices and users before it can be distributed to them.

You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle to
a folder or group is the preferred method of assigning bundles. This allows for easier
management of the bundle assignments and can decrease the possibility of high server

utilization caused by assigning the bundle to a large number of items (for example, more than
250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign the
bundle.

The Select Objects dialog box opens with the Users folder as the root folder. By default, the user
sources that have been defined are displayed, as well as the ZENworks User Groups folder.

Browse for and select the users, groups, and folders to which you want to assign the bundle. To
do so:

3a Click ¢ next to a folder to navigate through the folders until you find the user, group, or
folder you want to select.

If you are looking for a specific item, such as a User or a User Group, you can use the Ifems
of type list to limit the types of items that are displayed. If you know the name of the item
you are looking for, you can also use the Item name box to search for the item.

3b Click the underlined link in the Name column to select the user, group, or folder and display
its name in the Selected list box.

3c Click OK to add the selected users, folders, and groups to the Devices list.
4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device
where ZENworks Adaptive Agent displays the bundle’s icon. The possible locations include the
following:

Application Window: Places the icon in the Application window. This location is selected by
default.

Quick Launch: Places the icon on the Quick Launch toolbar area of the Windows taskbar.
Desktop: Places the icon on the device’s desktop.

System Tray: Places the icon in the system tray (notification area) of the Windows taskbar.
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Start Menu: Places the icon on the Start menu on all Windows devices except for Windows Vista
and later. On Windows Vista and later, it places the icon in Start > All Programs.

On Windows Vista devices, if you want to change the look and feel of the Start menu or pin
applications to the Start menu, see Appendix D, “Best Practices,” on page 237.

5 Click Next to display the Schedules page, then select the schedules you want to define. For
information, see Step 5 in Assigning Existing Bundles to Devices (page 179).

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle
to be distributed to the device when it is first launched.

7 Inthe Schedule Type field, select one of the schedules, then fill in the fields. For more information,
see Step 7 in Assigning Existing Bundles to Devices.

8 Select the following options as desired:

Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake on
LAN (WoL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after the
bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the
bundle is installed. This option is available only if the Install Immediately After Distribution option
is enabled.

9 (Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle Launch
Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent
automatically launches the bundle. The default schedule (no schedule) results in the bundle only
being launched if the user launches it.

10 In the Schedule Type field, select one of the following schedules, then fill in the fields. For
information, see Step 10 in Assigning Existing Bundles to Devices.

11 (Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times
defined by the schedule. The default schedule (no schedule) makes the bundle available at all
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user
has not yet installed the bundle, it is only available for installation at the times specified by the
schedule. If a user has already installed the bundle, it is only available for running during the
scheduled times.

12 In the Schedule Type field, select one of the following schedules, then fill in the fields. For more
information, see Step 12 in Assigning Existing Bundles to Devices.

13 Click Next to display the Finish page, review the information and, if necessary, use the Back
button to make changes to the information.

14 Click Finish.

If you assign bundles to Active Directory users, the assignments are available to the users only if the
ZENworks server is able to resolve the DNS name of the Active Directory.
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9.3 Assigning a Bundle Group to Devices

You can assign bundle group to devices, device groups, or device folders.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group (or bundle groups).
3 Click Action > Assign to Device.

Bundles

|:| Status Name = Category Enabled Version Has Sandbox

% groupt roup

O & & ini_edit 5 Bundle Simple Application Yes 1 No

M| %y & notepad FUDUSF—I Bundle(s)... 5 Bundle Simple Application Yes 5 No

O g?. & wordpad Windows Bundle Simple Application Yes 1 Yes

([ b]1-40ra show 257 items |

4 Browse for and select the devices, device groups, and device folders to which you want to assign
the group. To do so:

4a Click £ next to a folder (for example, the Workstations folder or Servers folder) to
navigate through the folders until you find the device, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you
can use the Items of type list to limit the types of items that are displayed. If you know the
name of the item you are looking for, you can use the Item name box to search for the item.

4b Click the underlined link in the Name column to select the device, group, or folder and
display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Devices list.

5 Specify the locations on the managed device where ZENworks Adaptive Agent displays the
bundle group’s icons. The possible locations are:

Application Window: Places the icons in the Application window.
Desktop: Places the icons on the device’s desktop.
Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.

Start Menu: Places the icons on the Start menu on all Windows devices except for Windows
Vista and later. It places the icon in Start > All Programs on Windows Vista and later.

System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define. For
information on schedules, see Step 5 in Assigning Existing Bundles to Devices (page 179).

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle
to be distributed to the device when it is first launched.

8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For
information, see Step 7 in Assigning Existing Bundles to Devices.

9 Select the following options as desired:

Managing Bundle Assignments 187



Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake on
LAN (WOL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after the
bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the
bundle is installed. This option is available only if the Install Immediately After Distribution option
is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle Launch
Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent
automatically launches the bundle. The default schedule (no schedule) results in the bundle only
being launched if the user launches it.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For
information, see Step 10 in Assigning Existing Bundles to Devices.

12 (Conditional) If you selected Awvailability Schedule in Step 6, click Next to display the Bundle
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times
defined by the schedule. The default schedule (no schedule) makes the bundle available at all
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user
has not yet installed the bundle, it is only available for installation at the times specified by the
schedule. If a user has already installed the bundle, it is only available for running during the
scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For more
information, see Step 12 in Assigning Existing Bundles to Devices.

14 Click Next to display the Finish page, review the information and, if necessary, use the Back
button to make changes to the information.

15 Click Finish.

9.4 Assigning a Bundle Group to Users

You can assign bundle group to users, user groups, or user folders.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group (or bundle groups).
3 Click Action > Assign to User.
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Browse for and select the user, user groups, and user folders to which you want to assign the
group. To do so:

4a Click £ next to a folder to navigate through the folders until you find the user, group, or
folder you want to select.

If you are looking for a specific item, such as a User or a User Group, you can use the Items
of type list to limit the types of items that are displayed. If you know the name of the item
you are looking for, you can use the Itern name box to search for the item.

4b Click the underlined link in the Name column to select the user, group, or folder and display
its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Users list.

Specify the locations on the managed device where ZENworks Adaptive Agent displays the
bundle group’s icons. The possible locations are:

Application Window: Places the icons in the Application window.
Desktop: Places the icons on the device’s desktop.
Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.

Start Menu: Places the icons on the Start menu on all Windows devices except for Windows
Vista and later. It places the icon in Start > All Programs on Windows Vista and later.

System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

Click Next to display the Schedules Page, then select the schedules you want to define. For
information on schedules, see Step 5 in Assigning Existing Bundles to Devices (page 179).

(Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle
to be distributed to the device when it is first launched.

In the Schedule Type field, select one of the following schedules, then fill in the fields. Fore
information, see Step 7 in Assigning Existing Bundles to Devices.

Select the following options as desired:

Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake on
LAN (WoL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after the
bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the
bundle is installed. This option is available only if the Install Immediately After Distribution option
is enabled.

(Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle Launch
Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent
automatically launches the bundle. The default schedule (no schedule) results in the bundle only
being launched if the user launches.

In the Schedule Type field, select one of the following schedules, then fill in the fields. For
information, see Step 10 in Assigning Existing Bundles to Devices.

(Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle
Availability Schedule page.
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9.5

13

14

15

The availability schedule defines the dates and times when the bundle is available on the
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times
defined by the schedule. The default schedule (no schedule) makes the bundle available at all
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user
has not yet installed the bundle, it is only available for installation at the times specified by the
schedule. If a user has already installed the bundle, it is only available for running during the
scheduled times.

In the Schedule Type field, select one of the following schedules, then fill in the fields. For
information, see Step 12 in Assigning Existing Bundles to Devices.

Click Next to display the Finish page, review the information and, if necessary, use the Back
button to make changes to the information.

Click Finish.

Copying the Relationships of a Device to Other Devices,
Folders, and Groups

The Copy Relationships page allows you to copy the Bundles, Policies and Group relationships of a
selected device to the target devices, folders, and groups. It also allows you to add the target devices,
devices inside the target folder, members of the target groups to members of the groups in which the
selected device is a member.

The Copy Relationships option is not enabled for a workstation group or a dynamic workstation
group.

To perform Copy Relationships operation:

1
2

o 01~ W

In ZENworks Control Center, click the Devices tab.

In the Devices page, select the check box next to a device.

For the Copy Relationships operation, you need to select a device that has existing relationships
to copy. Otherwise, an error message is displayed:

The selected target object has no relationships to perform copy operation

Click Action > Copy Relationships.
Select either all or only the required bundles, policies, and groups for copying.
Click Next to display the Select Target Objects page.

Select devices, folders, or groups to which you want to copy the relationships. When you select a
folder or group, the relationships will be copied only to the objects within the folder or group.

Direct Assignment Options allow you to copy relationships easily if the target devices are
members of a folder or members of groups. Select all or only the required Direct Assignment
Options listed.

7a If you check this, the relationships will be copied to the devices within the selected target
groups.

7b If you check this, the relationships will be copied to the devices within the selected folders.

7c If you check this, the relationships will be copied to the devices within the sub-folders of the
selected target folders.
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8 Conflict Resolution Options resolve the conflicts that might arise due to a conflict between the
existing relationships of the target device and that of the selected device. Select all or only the
required Conflict Resolution Options listed:

8a If you check this, the existing relationships of the target device will be removed while
copying the selected relationships.

8b If you check this, the selected relationships will be copied to the target device and the
existing relationships will be retained.

9 Group Membership Options allow you to add members of the target groups, objects of the target
folder and sub-folder as members of the groups to which the selected device belongs. You can
add the target devices as members of the groups in which the selected device is a member.

You can also add members of target groups as members of the groups in which the selected
device is a member.

For Example:

The target group B has b1, b2, and b3 as members. The selected (source) group A has al, a2, and
a3 as members. You cannot associate A and B groups directly. However you can add b1, b2 and
b3 as members of al, a2, and a3.

Select all or only the required Group Membership Options listed. If the selected device is not a
member of any group, the Group Membership Option will not be available on this page.

9a If you check this, the members of the target group will be added as members of the group to
which the selected device belongs.

9b If you check this, objects that are inside the target folders will be added as members of the
groups to which the selected device belongs.

9b1 If you check this, objects inside a folder and its sub-folder will be added as members of
the groups to which the selected device belongs.

9c If you check this, the group memberships of the target devices will be deleted.

10 Click Next to display the Finish page, then review the information and, if necessary, use the Back
button to make changes to the configured settings for Copy Relationships> Click OK.
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10.1

10.1.1

Managing System Requirements

The System Requirements panel lets you define specific requirements that a device must meet for the
bundle to be distributed to it.

You define requirements through the use of filters. A filter is a condition that must be met by a device
in order for the bundle to be applied. For example, you can add a filter to specify that the device must
have exactly 512 MB of RAM in order for the bundle to be applied, and you can add another filter to
specify that the hard drive be at least 20 GB in size.

Review the following sections:

¢ Section 10.1, “Adding System Requirements for a Bundle,” on page 193
¢ Section 10.2, “Copying a Bundle’s System Requirements,” on page 199
¢ Section 10.3, “Copying a Bundle Group’s System Requirements,” on page 200

Adding System Requirements for a Bundle

1 In ZENworks Control Center, click the Bundles tab.

2 Click the underlined link for the desired bundle to display the bundle’s Summary page.
3 Click the Requirements tab.

4 Click Add Filter, select a filter condition from the drop-down list, then fill in the fields.

As you construct filters, you need to know the conditions you can use and how to organize the
filters to achieve the desired results. For more information, see Section 10.1.1, “Filter
Conditions,” on page 193 and Section 10.1.2, “Filter Logic,” on page 198.

5 (Conditional) Add additional filters and filter sets.
6 Click Apply to save the settings.

NOTE: After defining a bundle’s system requirements, you can copy its requirements and apply it to
other bundles or policies. To do so, click the Bundles tab, select the check box in front of the bundle,
click Edit, click Copy System Requirements, select Bundles or Policies, then click Add to select the bundles
or policies to which you want to copy the selected bundle’s system requirements.

Filter Conditions

You can choose from any of the following conditions when creating a filter. Place your mouse pointer
over fields that require input to display a tooltip containing example usage.

Architecture: Determines the architecture of Windows* running on the device. The condition you
use to set the requirement includes a property, an operator, and a property value. The possible
operators are equals (=) and does not equal (<>). For example, if you set the condition to
architecture = 32, the device’s Windows operating system must be 32-bit to meet the requirement.
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Bundle Installed: Determines if a specific bundle is installed. After specifying the bundle, the two
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle
must already be installed to meet the requirement. If you select No, the bundle must not be installed.

Configuration Location: Determines if the bundle is applicable to a specific location. The condition
you use to set the requirement includes an operator and a value. The possible operators are equals (=)
and does not equal (<>). The values are the existing locations in the Management Zone. For example,
if you set the condition to =Iocation name, the selected location must match the device’s location to
meet the requirement.

Configuration Network Environment: Determines if the bundle is applicable to a specific network
environment. The condition you use to set the requirement includes an operator and a value. The
possible operators are equals (=) and does not equal (<>). The values are the existing network
environments in the Management Zone. For example, if you set the condition to

=network environment name, the selected network environment must match the device’s current
network environment to meet the requirement.

Connected: Determines if the device is connected to the network. The two conditions you can use to
set the requirement are Yes and No. If you select Yes, the device must be connected to the network to
meet the requirement. If you select No, it must not be connected.

Connection Speed: Determines the speed of the device’s connection to the network. The condition
you use to set the requirement includes an operator and a value. The possible operators are equals
(=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less
than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps),
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to
>= 100 Mbps, the connection speed must be greater than or equal to 100 megabits per second to meet
the requirement.

Disk Space Free: Determines the amount of free disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: >= 80 MB, the free disk space must be greater than or equal to 80
megabytes to meet the requirement.

Disk Space Total: Determines the amount of total disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: >= 40 GB, the total disk space must be greater than or equal to 40
gigabytes to meet the requirement.

Disk Space Used: Determines the amount of used disk space on the device. The condition you use to
set the requirement includes a disk designation, an operator, and a value. The disk designation can be
a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is
greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The
possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if
you set the condition to c: <= 10 GB, the used disk space must be less than or equal to 10 gigabytes
to meet the requirement.

Environment Variable Exists: Determines if a specific environment variable exists on the device.
After specifying the environment variable, the two conditions you can use to set the requirement are
Yes and No. If you select Yes, the environment variable must exist on the device to meet the
requirement. If you select No, it must not exist.
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Environment Variable Value: Determines if an environment variable value exists on the device. The
condition you use to set the requirement includes the environment variable, an operator, and a
variable value. The environment variable can be any operating system supported environment
variable. The possible operators are equal to, not equal to, contains, and does not contain. The possible
variable values are determined by the environment variable. For example, if you set the condition to
Path contains c:\windows\system32, the Path environment variable must contain the
c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the
filename, an operator, and a date. The filename can be any filename supported by the operating
system. The possible operators are on, after, on or after, before, and on or before. The possible dates are
any valid dates. For example, if you set the condition to appl.msi on or after 6/15/07, the
appl.msi file must be dated 6/15/2007 or later to meet the requirement.

File Exists: Determines if a file exists. After specifying the filename, the two conditions you can use to
set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the
requirement. If you select No, the file must not exist.

File Size: Determines the size of a file. The condition you use to set the requirement includes the
filename, an operator, and a size. The filename can be any file name supported by the operating
system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or
equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are designated in
bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the
condition to docl.pdf <= 3 MB, the docl.pdf file must be less than or equal to 3 megabytes to meet
the requirement.

File Version: Determines the version of a file. The condition you use to set the requirement includes
the filename, an operator, and a version. The filename can be any file name supported by the
operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is
greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For
example, the file version for calc.exe might be 5.1.2600.0. Each component is treated independently.
For this reason, the system requirements that you set might not provide your expected results. If you
do not specify all four components, wildcards are assumed.

For example, if you set the condition to calc.exe <= 5, you are specifying only the first component
of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, the
calc.exe file must be less than or equal to version 5.1 to meet the requirement.

IP Segment: Determines the device’s IP address. After specifying the IP segment name using CIDR
(Classless Inter-Domain Routing) format, the two conditions you can use to set the requirement are
Yes and No. If you select Yes, the device’s IP address must match the IP segment. If you select No, the
IP address must not match the IP segment.

You must specify the IP address using CIDR format. With CIDR, the dotted decimal portion of the IP
address is interpreted as a 32-bit binary number that has been broken into four 8-bit bytes. The
number following the slash (/n) is the prefix length, which is the number of shared initial bits,
counting from the left side of the address. The /n number can range from 0 to 32, with 8, 16, 24, and 32
being commonly used numbers. Examples:

123.45.67.12/16: Matches all IP addresses that start with 123.45.

123.45.67.12/24: Matches all IP addresses that start with 123.45.67.
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Logged on to Primary Workstation: Determines whether the user is logged on to his or her primary
workstation. The two conditions you can use to set the requirement are Yes and No. If you select Yes,
the user must be logged on to his or her primary workstation to meet the requirement. If you select
No, if no user is logged on to the workstation, the requirement is not met. However, if a user other
than the primary user is logged on to the workstation, the requirement is met.

Memory: Determines the amount of memory on the device. The condition you use to set the
requirement includes an operator and a memory amount. The possible operators are equals (=), does
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or
equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). For
example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of memory to
meet the requirement.

Novell Client Installed: Determines if the device is using the Novell Client for its network
connection. The two conditions you can use to set the requirement are Yes and No. If you select Yes,
the device must be using the Novell Client to meet the requirement. If you select No, it must not be
using the Novell Client.

Operating System - Windows: Determines the service pack level, server type, and version of
Windows* running on the device. The condition you use to set the requirement includes a property,
an operator, and a property value. The possible properties are service pack, server type, and version. The
possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to
(>=), is less than (<), and is less than or equal to (<=). The property values vary depending on the
property. For example, if you set the condition to version = Windows XP Versions, the device’s
Windows version must be XP to meet the requirement.

NOTE: Be aware that operating system version numbers contain four components: Major, Minor,
Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 5.0.2159.262144.
Each component is treated independently. For this reason, the system requirements that you set
might not provide your expected results.

For example, if you specify Operating System - Windows in the first field, Version in the second field, >
in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only the first two
components of the version number: Major (Windows) and Minor (5.0). As a result, for the
requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is
version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000
SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 5.0.0
to make the requirement evaluate as true because the actual revision component is greater than 0.

When you select the OS version from the drop-down, the Major and Minor components are
populated. The Revision and Build components must be typed in manually.

Primary User Is Logged In: Determines if the device’s primary user is logged in. The two conditions
you can use to set the requirement are Yes and No. If you select Yes, the primary user must be logged
in to meet the requirement. If you select No, the user must not be logged in.

Processor Family: Determines the device’s processor type. The condition you use to set the
requirement includes an operator and a processor family. The possible operators are equals (=) and
does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, Pentium IlI,
Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For example, if you set the
condition to <> Celeron, the device’s processor can be any processor family other than Celeron to
meet the requirement.

Processor Speed: Determines the device’s processor speed. The condition you use to set the
requirement includes an operator and a processor speed. The possible operators are equals (=), does
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or
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equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and
gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be at
least 2 gigahertz meet the requirement.

Registry Key Exists: Determines if a registry key exists. After specifying the key name, the two
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified key must
exist to meet the requirement. If you select No, the key must not exist. For example, if you specify
HKEY LOCAL MACHINE\SOFTWARE\Novell\Messenger\Login and set the requirement to Yes, the
specified registry key must exist to meet the requirement.

Registry Key Value: Determines if a registry key value meets a defined condition. The condition you
use to set the requirement includes the key name, the value name, an operator, a value type, and a
value data. The key and value names must identify the key value you want to check. The possible
operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less
than (<), and is less than or equal to (<=). The possible value types are Integer Type (specify a decimal
value) and String Type. The possible value data is determined by the key, value name, and value type.

If the value type is String Type, ZCM compares only those values in the registry if the actual type in
the registry is REG_STRING or REG_EXPANDED_STRING.

If the value type is Integer, ZCM compares only those values in the registry if the actual type in the
registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no
name and is displayed in regedit as (Default).

For example, if you specify HKEY LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login as the key
name, Port as the value name, select = as the operator, select Integer Type as the value type, and
specify 443 as the value data, the port specified as the value data must match with the port specified
in the registry key to meet the requirement.

If the value type is IP Address, ZCM compares only those values in the registry if the actual type in the
registry is REG_STRING.

NOTE: The filter condition Registry Key Value is available only for Windows bundles. The value type
IP Address for Registry Key Value is applicable only in VDI environments (VMwareVDI and
CitrixVDI).

If you have set the condition to Registry Key Value and selected IP Address as the value type, then the
two conditions that you can use to set the requirements are Is in Subnet and Is not in Subnet. If you
select Is in Subnet, then the thin-client IP address of the device must be within a specific subnet. If you
select Is not in Subnet, then the thin-client IP address of the device must be outside the subnet.

Specify the following in the text fields:

¢ Path of the registry key that should be compared
¢ Name of the registry value, for example: ViewClient IP Address

¢ IP Address of the network and a subnet mask to compare in order to determine if the device is
within the segment (Example: 10.0.0.0/24)

For the VMware-VDI Environment

If you are connected to a VMware desktop from any thin client, the following registry key will be
created automatically in the VMware desktop, indicating the thin-client IP address through which it
is connected. You can use the same Registry key as a filter to specify the filter requirement.
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Example:
Registry key Path: HKEY CURRENT USER\Volatile Environment
Registry key Name: ViewClient IP Address

Value: This specifies the thin-client IP address through which you are connected to the VMware
desktop. This value should be in the CIDR format for both Is in Subnet and Is not in Subnet (Example:
10.0.0.0/24).

For the Citrix- VDI Environment

If you are connected to a Citrix desktop from any thin client, the following registry key will be
created automatically in the Citrix desktop, indicating the thin-client IP address through which it is
connected. You can use the same registry key as a filter to specify the filter requirement.

Example:
Registry key path: HKEY LOCAL_ MACHINE\SOFTWARE\Citrix\Ica\Session
Registry key name: ClientAddress

Value: This specifies the thin client address through which you are connected to the Citrix desktop
(Example: 10.0.0.0/24).

Registry Key and Value Exists: Determines if a registry key and value exist. After specifying the key
name and value, the two conditions you can use to set the requirement are Yes and No. If you select
Yes, the specified key and value must exist to meet the requirement. If you select No, the key and
value must not exist.

For example, if you specify HKEY LOCAL MACHINE\SOFTWARE\Novell\Messenger\Login as the key
name, Port as the value name, and set the requirement to Yes, then the

HKEY LOCAL MACHINE\SOFTWARE\Novell\Messenger\Login key having Port as its value, must exist
to meet the requirement.

Service Exists: Determines if a service with the given name exists in the Services list of the system.
Specify a service name and ensure that the service name is not enclosed in quotes. After specifying
the service name, the two conditions you can use to set the requirement are Yes and No. If you select
Yes, the service must exist to meet the requirement. If you select No, the service must not exist.

Specified Devices: Determines if the device is one of the specified devices. After specifying the
devices, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the
device must be included in the specified devices list to meet the requirement (an inclusion list). If you
select No, the device must not be included in the list (an exclusion list).

Filter Logic

You can use one or more filters to determine whether the bundle should be distributed to a device. A
device must match the entire filter list (as determined by the logical operators that are explained
below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

¢ Designing a filter structure that is easy to understand

¢ Organizing the filters so that you do not create conflicting filters
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Filters, Filter Sets, and Logical Operators

You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine
each filter and filter set. By default, filters are combined using OR (as determined by the Combine
Filters Using field) and filter sets are combined using AND. You can change the default and use AND
to combined filters, in which case filter sets are automatically combined using OR. In other words, the
logical operator that is to combine individual filters (within in a set) must be the opposite of the
operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set
options a few times each to create a few filter sets, then switch between AND and OR in the Combine
Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals,
where filters are contained within parentheses, and sets are separated into a series of parenthetical
groups. Logical operators (AND and OR) separate the filters within the parentheses, and the
operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the
filter list, this looks like:

u AND
v AND
w

OR

x AND
y AND
z

Nested Filters and Filter Sets

Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter set
to match the device is used. Therefore, the order in which they are listed does not matter. You are
simply looking for a match to cause the bundle to be applied to the device.

Copying a Bundle’'s System Requirements

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle.
3 Click Edit > Copy System Requirements.

Bundles

Rename...

|:| Status Mame = & Type Category Enabled Version Has Sandbox
OPY...

El| % & ini| MNove windows Bundle simple Application Yes 1 No
Copy System Requirements...

é?-a @ notepad Windows Bundle Simple Application fes 5 No

o
Ol &g & wordpad Windows Bundle Simple Application Yes 1 Yes
4| b |1-30t3 show 25 v items

If more than one check box is selected, the Copy System Requirements option is not available on
the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to
copy the selected bundle’s system requirements.
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10.3 Copying a Bundle Group’s System Requirements

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group.
3 Click Edit > Copy System Requirements.

If more than one check box is selected, the Copy System Requirements option is not available on
the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to
copy the selected bundle group’s system requirements.
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Managing Bundle Settings

The Settings page lets you manage bundle settings, including the variables that are available for use
on bundles and content replication settings for ZENworks Primary Servers and Satellite devices.

Settings can be inherited from the following locations:
¢ (System): The bundle is inheriting the setting established for the Management Zone
(Configuration tab > Management Zone Settings).
¢ Folder: The bundle is inheriting the setting established for one of its parent folders.

¢ Device: The bundle is not inheriting the setting, but the setting is configured directly on the
bundle. In other words, the setting is not configured at the system level, the folder level, or the
bundle level.

To configure a setting for the bundle:

1 Click Bundle Management.
2 Click the setting name.

3 If the setting is configured at the system or folder level, click Override settings to enable you to
configure the setting at the bundle level.

4 Fill in the fields.

To get information about the fields, click the Help button or review the following sections:

¢ Section 11.1, “Managing System Variables,” on page 201
¢ Section 11.2, “Primary Server Replication,” on page 203

¢ Section 11.3, “Satellite Server Replication,” on page 203

¢ Section 11.4, “Sandbox Settings,” on page 203

¢ Section 11.5, “End Point Throttle,” on page 204

¢ Section 11.6, “Image Bundle Flag Settings,” on page 204

11.1 Managing System Variables

The Bundles Settings page lets you manage the variables that are available for use on bundles.

The Inherited Variables panel displays all system variables that are inherited from the ZENworks
Management Zone or parent folders. You cannot delete or modify inherited variables. However, if
you add the same system variable, but give it a different value, the new variable value overrides the
inherited variable value.

When specifying the variable in a field, use the following syntax:
${VAR NAME}

Replace VAR NAME with the name of the variable.
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The System Variables panel lets you define variables that can be used to replace paths, names, and so
forth as you enter information. For more information on the system variables supported in Novell
ZENworks Configuration Management, see “Using System Variables”and “Using Special System
Variables”in the ZENworks 11 SP3 ZENworks Control Center Reference.

You can define system variables at three levels:
¢ Management Zone: The system variables are inherited by the following: device folders, devices,
and bundles.

¢ Device Folder: The system variables are inherited by all devices contained within the folder or
its subfolders.

¢ Device or Bundle: The system variables apply only to the device or bundle for which they are

configured.

The following table lists the tasks you can perform to manage the system variables:

Task

Steps

Additional Details

Add a variable

1.

If you are configuring system
variables for an object (not for the
entire Management Zone), click
Override settings to activate the
System Variables panel.

When configuring system variables for
an object, you can override an inherited
variable by defining a new variable with
the same name but a different value.
For example, if Varl=c:\ is inherited,
you can override it by defining

2. Click Add, provide the name and
value for the variable, then click Varl=d:\.
OK. Variable names cannot include spaces
3. Click Apply. and must be unique at the level where
they are defined. For example, you
cannot have two variables named Varl
defined at the device level (unless one
is inherited, in which case the device
level variable overrides the inherited
variable).
Variable values cannot include the
characters & and <.
Remove a variable 1. Select the check box next to the
variable (or variables).
2. Click Remove.
3. Click Apply.
Edit a variable 1. Select the check box next to the Variable names cannot include spaces
variable. and must be unique at the level where
2. Click Edit. they are defined. Fo_r example, you
_ ] cannot have two variables named Varl
3. Modify the Name and Value fields  defined at the device level (unless one
as desired, then click OK. is inherited, in which case the device
4. Click Apply. level variable overrides the inherited

variable).

Variable values cannot include the
characters & and <.
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11.2

11.3
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Task Steps Additional Details

Use a variable 1. Use the following syntax:
${ VAR NAME}

Replace VAR NAME with the name
of the variable.

NOTE: The ${ZENUSER} system variable maps to the user logged into the graphical session on the
Linux or Macintosh device. For example, if user 'bob' is logged into the display:0 of a Linux device,
then any bundle that references the ${ZENUSER]} variable resolves to 'bob'. There are various
applications to do this. For example, the ${ZENUSER} variable can be used to install Desktop icons in
the home directory of the logged-in user by setting the path of the icon file to /home/${ZENUSER}/
Desktop/. The ${ZENUSER} variable is applicable for only Linux and Macintosh bundles, not for
Windows bundles. A system variable could also be used to set the permission of a installed file to the
logged-in user.

Primary Server Replication

Lets you manage content replication to Primary Servers. You can specify whether or not new Primary
Servers added to the system are assigned to host the bundle. You can also specify that the bundle is
included or excluded from being hosted on a specified Primary Server. For more information on this
page, click Help.

For more information on content replication, see “Content Replication”in the ZENworks 11 SP3
Primary Server and Satellite Reference.

Satellite Server Replication

Lets you manage content replication to Satellite devices. You can specify whether or not new
Satellites added to the system are assigned to host the bundle. You can also specify that the bundle is
included or excluded from being hosted on a specified Satellite. For more information on this page,
click Help.

For more information on content replication, see “Content Replication”in the ZENworks 11 SP3
Primary Server and Satellite Reference.

Sandbox Settings

Lets you configure the settings for the sandbox version of the bundle. You can enable the Primary
Server Replication settings and Satellite Server Replication settings of the published version of the
bundle to be applied to the sandbox version of the bundle. You can also enable a device to receive the
sandbox version of the dependent bundles if any exists when the parent bundle is assigned to the
device. For details, see Bundle Behavior Based on Content Replication Settings and Publishing
Sandbox.
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11.5 End Point Throttle

Allows you to override the throttle rate settings that have been set for the location or network
environment of the target device.

A specific bundle or bundles in a folder can be delivered at maximum speed, by selecting the Ignore
endpoint throttle value option at the bundle or the bundle folder level.

For more information on this page, click Help.

11.6 Image Bundle Flag Settings

Lets you configure Image bundle settings that are used when restoring an image by applying a
bundle.

For more information on Image bundle settings, see the ZENworks 11 SP3 Preboot Services and Imaging
Reference.
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12.1

Managing Action and Action Sets

The Actions panel displays the action sets available for the bundle. Depending on the bundle type,
the possible action sets are Distribute, Install, Launch, Verify, Uninstall, Terminate, and Preboot. For
example, if you select a Windows bundle, all five actions sets are available. If you select an Preboot
bundle, Preboot is the only available action set.

You can add an action to any of the available action sets. When you do so, that action is performed
whenever the action set is applicable. For example, when you add an action to the Install action set,
that action is performed whenever the bundle is installed.

¢ Section 12.1, “Managing Actions,” on page 205
¢ Section 12.2, “Modifying Action Set Options,” on page 207

Managing Actions

When you create a bundle, all actions are enabled by default, meaning that after you add them to a
action set, they run according to the action set’s options. However, not all action sets are enabled by
default. You can choose to modify the action sets. For more information on modifying the action set
options, see Section 12.2, “Modifying Action Set Options,” on page 207.

The following table lists the tasks you can perform to manage actions associated with the bundle. For
more information on the different actions, see “Actions” on page 67.

Task Steps Additional Details

Add an action 1. If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

2. Click Add, then click the action you
want to add.

3. Fill'in the appropriate fields. Click the
Help button in the Add Action dialog
box for details.

4. Click Apply.
Remove an action 1. If you are not already on the
appropriate action set tab, click

Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

2. Select the check box next to the
action (or actions).

3. Click Remove.
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Task

Steps

Additional Details

Edit an action 1.

Reorder the actions 1.

Enable an action to 1.

be performed

If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

Click the action’s name to display the
edit page.

Modify the desired settings. Click the
Help button in the Edit Action dialog
box for details.

After returning to the action set page,
click Apply.

If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

Select the check box next to the
action you want to move.

Click Move Up and Move Down to
relocate it.

Click Apply.

If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

. Select the check box next to the

action (or actions).

3. Click Enable.
4. Click Apply.

Prevent an action 1.

from being performed

If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

. Select the check box next to the

action (or actions).

3. Click Disable.
4. Click Apply.

Bypass an action that 1.

fails

If you are not already on the
appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

Select the check box next to the
action (or actions) you want to
bypass on failure

Select the check box in the Continue
on Failure column.

. Click Apply.

The actions are performed in the order
they are listed.
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Task Steps Additional Details

Configure an action 1. If you are not already on the

set’s options appropriate action set tab, click
Distribute, Install, Launch, Verify,
Uninstall, Terminate, or Preboot.

2. Click Options.

3. Modify the desired settings, then click
OK to return to the action set page.

4. Click Apply.

Modifying Action Set Options

When you create a bundle, all actions are enabled by default, meaning that after you add them to a
action set, they run according to the action set’s options. However, not all action sets are enabled by
default. The Install, Launch, and Terminate action sets are enabled, meaning that after you add an

action, it runs on assigned devices according to its action set’s options. The Uninstall action set is not
enabled by default.

The following sections contain information about modifying action set options and enabling the
Uninstall action set:

¢ Section 12.2.1, “Install Action Set Options,” on page 207

¢ Section 12.2.2, “Launch Action Set Options,” on page 208

¢ Section 12.2.3, “Uninstall Action Set Options,” on page 209

¢ Section 12.2.4, “Terminate Action Set Options,” on page 211

Install Action Set Options

The Install Options dialog box lets you specify the how often the bundle’s install actions are
performed on managed devices and to specify if users can postpone the bundle’s installation. If the
install action set or its options are modified and the bundle is re-published, then when the bundle is
installed or launched, the install action set is invoked again, even if it has been set to install only once.

Bundle Change Management causes a change in the behavior of the Install action set on a device. For
more information on the changed behavior, see Appendix C, “How Bundle Versions Affect an Install
Action Set,” on page 233.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary
page.

3 Click the Actions tab, then click the Install tab.

4 Click Options to display the Install Options dialog box.

Managing Action and Action Sets 207



Install Options ?|X

Install Frequency
@ Install once per device
O Install once per user per device
O Install always

User Download Options
Actions allowed when content is being downloaded:

O Always allow postpones
O Never allow postpones

K[a)

@ Limit postpones to

OK Cancel

5 Specify how often you want the bundle’s install actions performed:
Install once per device: Performs the bundle’s install actions once on each managed device.

Install once per user per device: Performs the bundle’s install actions once for each user on each
managed device.

Install always: Performs the bundle’s install action each time the bundle is run on the managed
device.

6 Specify whether to allow users to postpone performing the bundle’s install actions and specify
the number of postpones to allow.

Always allow postpones: Allow the user to postpone the installation an unlimited number of
times.

Never allow postpones: Do not allow the user to postpone the installation.
Limit postpones to: Specify the number of times that the user can postpone the installation.

7 Click OK, then click Apply.

12.2.2  Launch Action Set Options

208

The Launch Options dialog box lets you configure how often the bundle’s launch actions are
performed on managed devices. By default, the launch actions are performed according to the
bundle’s or when the user launches the bundle using its shortcut (from the Application Window,
desktop, and so forth). If the launch action set or its options are modified and the bundle is re-
published, then when the bundle is launched, the launch action set will be invoked again even if it
has been set to launch once.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary
page.

3 Click the Actions tab, then click the Launch tab.

4 Click Options to display the Launch Options dialog box.
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Launch Options 2%

[JRun once:
for each device
for the first user that logs in

for every user that logs in

OK Cancel

5 Fill in the fields:

: Select this option to configure the bundle’s launch actions, then select one of the following
options. If you do not select this option (the default), the launch actions are performed each time
a user launches the application contained in the bundle.

¢ For each device: Launches the bundle’s actions once on each managed device.

¢ For the first user that logs in: Launches the bundle’s actions once on each managed device
when the first user logs in to that device. If subsequent users log in to the device, the action
set is not launched. If you select this option, the bundle’s icon is removed from the device’s
Application Window, desktop, and so forth.

¢ For every user that logs in: Launches the bundle’s actions for every user that logs in to the
device.

6 Click OK, then click Apply.

Uninstall Action Set Options

The Uninstall Options dialog box lets you enable the application to be uninstalled, allow the user to
perform the uninstall, and specify that the application is uninstalled if it is not used with in a
specified number of days.

When you create a bundle, the Undo Install action is enabled by default; however, the Uninstall
Action Set is not enabled. Therefore, in order for any actions in the action set to run (including the
Undo Install action), you must enable the action set.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary

page.
3 Click the Actions tab, then click the Uninstall tab.
4 Click Options to display the Uninstall Options dialog box.
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Uninstall Options 7%

[“lEnable Uninstall

—User Options
[l allow user to perfarm uninstall
[ Display message to the user before uninstalling the application
[ allow user to cancel the uninstallation of the application

—Other Options

[&]
Uninstall application if not used within N & davs

lgnore chained dependencies

0K Cancel

5 Select the Enable Uninstall option. The following uninstall options are available only if Enable

Uninstall option is selected:
User Options:

Specify whether the user should be allowed to uninstall or cancel the uninstallation of an
application from a device:

Allow User to perform uninstall: Select this option to enable users to remove the application
from their devices.

Display message to the user before uninstalling the application: Select this option to specify
that a message warning the user that the application is going to be uninstalled from the device is
displayed.

Allow user to cancel the uninstallation of the application: Select this option to specify whether
the user can cancel the uninstallation of the application. You can enable this option only if the
Display message to the user before uninstalling the application option is enabled.

Other Options:
Specify additional options to enable the uninstallation of the application from the device:

Uninstall application if not used within _ days: Select this option to automatically remove the
application if the user has not run it within the specified number of days (the default is 30).

Ignore Chained Dependencies: Select this option to enable the uninstallation of a dependent
application that is referenced by two or more applications. For example, consider three
applications (A, B, and C), where C is the dependent application. Assume application A installs
application C, and application B uninstalls application C. Application C is uninstalled only if
Ignore Chained Dependencies is selected.

Do not uninstall application on unassignment: Select this option to prevent the application
from being uninstalled after it is unassigned from the device or user.

6 Click OK, then click Apply.
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12.2.4  Terminate Action Set Options

The Terminate Options dialog box lets you specify that the bundle’s actions can be terminated. This
setting is used if a bundle has an availability . For example, if a bundle can be installed only between
1 p.m. and 5 p.m. and the bundle is in the process of being installed at 5 p.m., the installation process
terminates.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary
page.
Click the Actions tab, then click the Terminate tab.
Click Options to display the Terminate Options dialog box.
Select or deselect the Enable Terminate check box.

Click OK, then click Apply.

o 01~ W
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13.1

Accessing Bundles on a Managed
Device

The ZENworks Adaptive Agent is part of the Novell ZENworks Configuration Management
software that lets your administrator manage devices over the network.

NOTE: This section contains information from the Adaptive Agent online Help system and is written
from the perspective of the end-user.

The ZENworks Adaptive Agent, commonly referred to as the Adaptive Agent, provides services that
help your administrator do the following without visiting devices:

¢ Deliver software, patches, and other files to your device

¢ Manage policies that determine the behavior of your device.

¢ Take inventory of your device’s hardware and software.

¢ Access your device from a remote location to troubleshoot and fix problems with hardware and

software.

Software applications and other files are distributed to your device as bundles. A bundle contains all
of the content (files, etc.) and instructions (registry modifications, shortcut information, etc.) required
to install the software on the device.

The following information discusses how to manage bundles by using the ZENworks Adaptive
Agent:

¢ Section 13.1, “Bundles vs. Applications,” on page 213

¢ Section 13.2, “User-Assigned vs. Device-Assigned Bundles,” on page 214

¢ Section 13.3, “Accessing Bundles,” on page 214

¢ Section 13.4, “Understanding Bundle Icons,” on page 218

¢ Section 13.5, “Launching a Bundle,” on page 219

¢ Section 13.6, “Postponing a Bundle Download,” on page 220

¢ Section 13.7, “Verifying a Bundle,” on page 220

¢ Section 13.8, “Viewing a Bundle’s Properties,” on page 220

¢ Section 13.9, “Uninstalling a Bundle,” on page 221

Bundles vs. Applications

Bundles are different than standard applications, such as Windows Notepad, that already reside on
your device. When you double-click a bundle to launch it, the ZENworks Adaptive Agent might first
complete a variety of distribution tasks before the application is launched, including installing the
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13.2

13.3

13.3.1

application files, running scripts, and changing the device’s registry, specific INI files, or
environment variables. These tasks are all configured by your administrator to ensure that the
application runs correctly on your device.

In some instances, a bundle’s icon appears dimmed or grayed out. This indicates that your device
does not meet the requirements that the administrator defined for the application, or the bundle is
not d to be available to you at that time. The Adaptive Agent does not distribute the application to
your device until the requirements are met or the is appropriate.

User-Assigned vs. Device-Assigned Bundles

The bundles that you see on your device might be assigned to you or they might be assigned to the
device. Bundles assigned to you are referred to as user-assigned bundles, and bundles assigned to
your device are referred to as device-assigned bundles.

The ZENworks Adaptive Agent displays your user-assigned bundles only when you are logged in to
your user directory (Microsoft Active Directory or Novell eDirectory). If you are not logged in, you
can log in through the ZENworks Configuration Management login screen. To do so, right-click the

& icon in the notification area, then click Login.

The Adaptive Agent always displays the device-assigned bundles regardless of whether or not you
are logged in. Device-assigned bundles can be launched by anyone who uses your device.

Accessing Bundles

The ZENworks Adaptive Agent provides three ways for you to access the bundles that are assigned
to you:

¢ Section 13.3.1, “ZENworks Window,” on page 214
¢ Section 13.3.2, “ZENworks Explorer,” on page 217
¢ Section 13.3.3, “ZENworks Icon,” on page 218

ZENworks Window

The ZENworks Window is a standalone window that you can launch from the Start menu or the
command prompt.

¢ “Using the Start Menu” on page 215

¢ “Using the Command Prompt” on page 215

¢ “Using the ZENworks Window as the Windows Shell” on page 216
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Using the Start Menu

1 Click Start > Programs > Novell ZENworks > ZENworks Application Window
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The ZENworks Window left pane displays the following:
+ [All] folder: Contains all bundles that have been distributed to you, regardless of the folder in
which they are located.

¢+ ZENworks folder: Contains all bundles that have not been assigned to a different folder. The
ZENworks folder is the default folder for bundles; however, your administrator can create
additional folders to organize bundles, and can even rename the ZENworks folder.

When you select a folder in the left pane, the right pane displays the bundles that are contained
within the folder. You can:

¢ Install a bundle or launch an application for an already installed bundle.

¢ View the properties of a bundle. The properties include a description of the bundle, information
about people to contact for help with the bundle, the times when the bundle is available for use,
and the system requirements established for the bundle.

¢ Repair an installed application.

¢ Uninstall an application. This is an administrator-controlled feature that might not be enabled.

Using the Command Prompt

1 Open the command prompt and execute the following command:

nalwin

The following command line switches can be used when starting the Application Window using
nalwin.

Table 13-1 Application Window Command Line Switches

Switch Description

Hides the initial splash screen.
EXAMPLE: nalwin :
1? Displays the help.

EXAMPLE: nalwin /?
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Switch Description

lc="window title" Uses the specified text as the title for the Application Window. The
. default window title is “ZENWorks Window for User,” where User is
EXAMPLE: nalwin / the distinguished name of the user.

c="%Username%'s Apps"
The text specified can contain macros (variables) to display

eDirectory information. The example, c="%Username%'s Apps"
substitutes the user's common name in the title (for example,
JSmith's Apps).

NOTE: The quotation marks are required only if a space is used in
the window title.

/max Displays the Application Window maximized when first loaded,
. overriding the window state (size and position) that was saved

EXAMPLE: nalwin /max when exiting the previous Application Window session.

/min Displays the Application Window minimized when first loaded,
. . overriding the window state (size and position) that was saved

EXAMPLE: nalwin /min when exiting the previous Application Window session.

/r Resets the Application Launcher launch flag to 0. This occurs
. automatically when Application Launcher terminates normally.

EXAMPLE: nalwin /r However, if Application Launcher terminates abnormally (for

example, a user uses Ctrl+Alt+Del to shut down nalwin. exe), the
launch flag is not reset and Application Launcher cannot be
restarted until the workstation is rebooted or this switch is used.

/s Makes the Application Window act like the Windows shell. For
. example, on the File menu, the Exit Application Launcher option
EXAMPLE: nalwin /s changes to Shutdown and gives the user the standard Windows

shutdown options.

The Contents option on the Help menu is disabled. So, you cannot
view the help.

This is not a true replacement for the Windows shell. If users
minimize the Application Window, they have access to the normal
desktop.

/d Displays the Application Window with the Contents option on the

Help menu disabled. So, you cannot view the help.
EXAMPLE: nalwin /d

Using the ZENworks Window as the Windows Shell

If the ZENworks Window is used as a Windows shell, only the ZENworks Window is visible on the
device. You do not have access to the device desktop so the Start menu, Quick Launch toolbar, and
the ZENworks Icon are also not visible. Also, help is disabled on the device.

Using the ZENworks Window as a Windows shell is useful in scenarios where you want to restrict
the user on the managed device to access only the applications displayed in the ZENworks Window.
For example, if you want the user to access only applications such as Notepad and Calculator, ensure
that the ZENworks Windows displays only these applications. To shut down the device, click File >
Shutdown.

To use the ZENworks Window as a shell:

1 On the Windows device, run regedit . exe and locate the following setting:
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HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

2 Change the SHELL value from explorer.exe to:

%zenworks_home%\bin\NalWin.exe

If you want the ZENworks Window to be maximized when it comes up, add the /max switch to
nalwin.exe (for example, nalwin.exe /max).

3 Close regedit.exe.
4 Restart Windows.

ZENworks Explorer

ZENworks Explorer is an extension to Windows Explorer that enables bundles to be displayed in
Windows Explorer, on the desktop, on the Start menu, on the Quick Launch toolbar, and in the
notification area.

Figure 13-1 Bundles Displayed in Windows Explorer
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Figure 13-2 Bundles Displayed on the Desktop

You can perform the same tasks on the bundles in the ZENworks Explorer as you can in the
ZENworks Window.

NOTE: Windows does not allow certain characters in folder paths (\ /:*? “<> | ). If you use any of
these characters as part of the name of the ZENworks Explorer folder path, each character displays as
an underscore ( _ ) in the Start menu. The characters display correctly in the ZENworks Window.
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13.3.3 ZENworks Icon

The ZENworks Icon @ is located in the Windows notification area. You can double-click the icon to
display the ZENworks Adaptive Agent properties. Located in the left navigation pane, the Bundles
link lets you view the bundles that are assigned to you and to your device.

Figure 13-3
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The bundle list includes the following information:
¢ Name: Displays the name of the bundle. Click the name to display the properties for the bundle,
including such information as the version, folder and icon locations, and help contacts.
¢ Status: Displays the installation status for the bundle.

¢ Effective: Displays whether or not the bundle can be used on the device. If the Effective box is
selected, the bundle meets all system requirements and constraints to be used. You can click the

bundle icon % to launch the bundle.

If the box is not selected, it cannot be used; to find out why, click the bundle name to display the
system requirements and properties.

13.4 Understanding Bundle Icons

A bundle icon changes to reflect the current status of the bundle. The following table shows the
bundle icons with the default light blue background icon. Your administrator might choose to use a
different background icon; however, the status icons such as [ and [£], remain the same.
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Status Description

Available The bundle is available on the device. You can launch the bundle. Installed
bundles can be verified. To verify the bundle, right-click the icon and click
Verify. For more information on verifying the bundle, see Verifying a Bundle.

Fﬂ g
o
>

Unavailable You cannot launch the bundle. Either the device does not meet the system
requirements established for the bundle or the bundle is not d to be
available at the current time.

@ Downloading The bundle is downloading from the network location where it is stored.
@ Installing The bundle is installing to the device.

@ Running The bundle is currently running.

@ Uninstalling The bundle is being removed from the device.

@ Not Installed The bundle failed to install or is not yet installed.

Launching a Bundle

By default, the ZENworks Adaptive Agent does not distribute (download and install) a bundle to
your device until the first time you launch it. The distribution process might include installing the
bundle’s files, running scripts, and changing the device’s registry, specific INI files, or environment
variables. Or, the process might include nothing more than providing a shortcut to the application's
executable file on your local device or a network server.

To launch a bundle:

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks
Window.

ZENworks Explorer: Open Windows Explorer and find the i ZENworks Adaptive Agent
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

ZENworks Icon: In the notification area, double-click the ¥ icon, then click Bundles.

2 Double-click the bundle icon.

NOTE: You must not launch multiple personality migration bundles at the same time. If you do so,
the bundles are not launched correctly, and the logs of only the bundle that was launched first is
stored in the personalitylog.xml file. Also, the dynamic administrator user profile of only the
bundle that was launch first is deleted. The dynamic administrator user profiles of the remaining
bundles must be manually deleted.
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Postponing a Bundle Download

If, after you launch a bundle, it begins to download and you need to stop the download, you can
postpone the download to a later time. When you resume the download, it continues from the point
where it previously stopped.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks
Window.

ZENworks Explorer: Open Windows Explorer and find the ld ZENworks Adaptive Agent
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2 Right-click the bundle icon, then click Postpone.

Verifying a Bundle

If an installed application is not functioning correctly or you think it might be outdated, you can
verify that the application’s bundle information is still correct. If it is not, the ZENworks Adaptive
Agent reinstalls the bundle to your workstation.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks
Window.

ZENworks Explorer: Open Windows Explorer and find the [l ZENworks Adaptive Agent
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2 Right-click the bundle icon, then click Verify.

Viewing a Bundle’s Properties

You can view a bundle’s properties to see its version number, current installation status, and help
contacts. In addition, if the bundle is unavailable, you can see if it is unavailable because of system
requirements or restrictions.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks
Window.

ZENworks Explorer: Open Windows Explorer and find the [l ZENworks Adaptive Agent
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2 Right-click the bundle icon, then click Properties.
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Uninstalling a Bundle

Uninstall is an administrator-controlled feature. By default, uninstall is not enabled, which means
that you can only uninstall bundles if your administrator has enabled the feature. Uninstall is
enabled on a per-bundle basis. Depending on what your administrator enables, you might be able to
uninstall some bundles but not others.

When you uninstall a bundle, the ZENworks Adaptive Agent removes all files from your device and
undoes all configuration settings made to your device during the bundle installation. Only files that
the Adaptive Agent installs specifically for the bundle are removed. For example, the Adaptive
Agent does not remove any shared files (files used by another application) or any user-created files
such as word processing documents or spreadsheets.

After you uninstall a bundle, the bundle’s icon remains on your device. This enables you to install the
bundle again whenever necessary.

To uninstall a bundle:

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks
Window.

ZENworks Explorer: Open Windows Explorer and find the ld ZENworks Adaptive Agent
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2 Right-click the bundle icon, then click Uninstall.
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Install, Uninstall, and Repair MSI
Bundle Parameters

While creating Windows MSI bundles, you can select install, uninstall, and repair parameters. The
following sections contain information to help you select the desired options:

¢ Section A.1, “Install Parameters,” on page 223
¢ Section A.2, “Uninstall Parameters,” on page 225

¢ Section A.3, “Repair Parameters,” on page 227

Install Parameters

The Install Parameters dialog box lets you specify the desired parameters.

Figure A-1 Install Parameters Dialog Box

Install Parameters

— Restart Options
® None (default)

O Do not restart (fnorestart)

O prompt for restart (/promptrestart)
O Always restart (/forcerestart)

— Display Options
O No Ul {/gn)
OFullul (7qf)
O Reduced Ul (/qr)
O Basic Ul (/qb)
Mo modal dialog at end (-)
Modal dialog at end (+)
Hide Cancel button (!)

— Install Options

@ Install (/1)
O administrative Install {7a)
Advertise

O For all users (/im)
O For logged in user only (/iu)

Command Line Parameters:

I

[ ok | [ cancel
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The following sections contain additional information:

¢ Section A.1.1, “Restart Options,” on page 224
¢ Section A.1.2, “Display Options,” on page 224
¢ Section A.1.3, “Install Options,” on page 225

¢ Section A.1.4, “Command Line Parameters,” on page 225

Restart Options

In some cases, installing an application requires restarting the workstation.
In the Install Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs.
ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the install process. The
installation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users
answer No, the installation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

Display Options

In the Install Parameters dialog box, select the desired Display options. You can choose to perform
the installation with or without a user interface, whether to display a modal dialog box at the end of
the install process (a modal dialog box demands a response from the user before the installation is
complete), or to hide the Cancel button so that users cannot cancel the installation.

No UI (/qn): Installs the application with no user interface (silent installation).

NOTE: This is the default installation option. If you want users to be aware that ZENworks
Configuration Management is installing an application to help prevent them from rebooting or
calling the help desk, change the display options to Basic UI (/gb) with No modal dialog at end (-) and
Hide Cancel button (!).

You can select the options in the dialog box or you can type /i /gb-! in the Command Line Parameters
field.

Full UI (/qf): Installs the application with the full user interface and a modal dialog box displayed at
the end of the installation.

Reduced UI (/qr): Installs the application with a reduced user interface and a modal dialog box
displayed at the end of the installation.

Basic UI (/qb): Installs the application with a basic user interface consisting of a progress bar. The
following settings are available with this option:

+ No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed
at the end of the installation.

¢ Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at
the end of the installation.
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¢ Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user
cannot cancel the installation process.

Install Options

In the Install Parameters dialog box, select the desired Install options:
Install (/i): Installs the application.

Administrative Install (/a): Creates an administrative installation point for the application. This
option is useful for a network installation.

For All Users (/im): Advertises the application on the computer and installs the application for all
users on first use.

For Logged In User Only (/iu): Advertises the application on the computer for the logged-in
(current) user and installs the application on first use. Do not use this option when performing a
System installation or when using a dynamic administrator to install the application.

A dynamic administrator is an administrator account that is created on the fly to perform certain
procedures, such as installing applications. Using a dynamic administrator is helpful when installing
applications (some MSI applications, for example) that cannot be installed in the system space. When
you select this action, the dynamic administrator is created, it performs the required tasks, and then
the account is deleted.

Command Line Parameters

Displays the install command line parameters used during the application’s installation. As you
select Restart, Display, and Install options, the command line parameters in this field are
automatically populated.

Uninstall Parameters

The Uninstall Parameters dialog box lets you specify the desired parameters.
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Figure A-2  Uninstall Parameters Dialog Box

Uninstall Parameters

— Restart Options
@ None (default)
O Do not restart (#norestart)
O Prompt for restart (/promptrestart)
O always restart (/forcerestart)

— Display Options
O No Ul {/gn)
OFullul (/qf)
O Reduced Ul (£qr)

O Basic Ul (£gb)
No modal dialog at end (-)
Modal dialog at end (+)
Hide Cancel button (1)

Command Line Parameters:

x

[ ok | [ Cancal |

The following sections contain additional information:

¢ Section A.2.1, “Restart Options,” on page 226
¢ Section A.2.2, “Display Options,” on page 226

¢ Section A.2.3, “Command Line Parameters,” on page 227

A.2.1 Restart Options

In some cases, uninstalling an application requires restarting the workstation.
SIn the Uninstall Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs.
ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the uninstall process. The
uninstallation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users
answer No, the uninstallation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.2.2 Display Options

In the Uninstall Parameters dialog box, select the desired Display options. You can choose to perform
the uninstallation with or without a user interface, whether to display a modal dialog box at the end
of the uninstallation process (a modal dialog box demands a response from the user before the

uninstallation is complete), or to hide the Cancel button so that users cannot cancel the uninstallation.

No UI (/qn): Uninstalls the application with no user interface (silent uninstallation).
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Full UI (/qf): Uninstalls the application with the full user interface and a modal dialog box displayed
at the end of the uninstallation.

Reduced UI (/qr): Uninstalls the application with a reduced user interface and a modal dialog box
displayed at the end of the uninstallation.

Basic UI (/qb): Uninstalls the application with a basic user interface consisting of a progress bar. The
following settings are available with this option:

+ No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed
at the end of the uninstallation.

¢+ Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at
the end of the uninstallation.

+ Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user
cannot cancel the uninstallation process.

A.2.3 Command Line Parameters

Displays the command line parameters used during the application’s uninstallation. As you select
Restart and Display options, the command line parameters in this field are automatically populated.

A.3 Repair Parameters

The Repair Parameters dialog box lets you specify the desired parameters.

Figure A-3 Repair Parameters Dialog Box

Repair Parameters

r— Restart Options
@ Naone (default)
O Do not restart (/norestart)
O prompt for restart (/promptrestart)
O Always restart (/forcerestart)

—Display Options
O Mo UI (/gn)
OFullui (7qf)
O Reduced Ul (/qr)

O Basic Ul (7gb)
Mo modal dialog at end (-)
Modal dialog at end (+)
Hide Cancel button (!)

— Repair Options
[ missing file P) [JForce all (a) [JFailed checksum (c)
[Jolder file (o) [Juser registry keys (u) [Jinstall and re-cache (v)
[JEqual or older file (e) [J computer registry keys (m) []Shortcuts (s)

[ pifferent file version (d)

Command Line Parameters:

G

[ ok | [ Canca |
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The following sections contain additional information:

¢ Section A.3.1, “Restart Options,” on page 228
¢ Section A.3.2, “Display Options,” on page 228
¢ Section A.3.3, “Repair Options,” on page 228

¢ Section A.3.4, “Command Line Parameters,” on page 229

Restart Options

In some cases, repairing an application requires restarting the workstation.
In the Repair Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs.
ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the repair process. The repair
process is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users
answer No, the repair process is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

Display Options

In the Repair Parameters dialog box, select the desired Display options. You can choose to perform
the repair process with or without a user interface, whether to display a modal dialog box at the end

of the repair process (a modal dialog box demands a response from the user before the repair process

is complete), or to hide the Cancel button so that users cannot cancel the repair process.

No UI (/qn): Repairs the application with no user interface (silent repair process).

Full UI (/qf): Repairs the application with the full user interface and a modal dialog box displayed at

the end of the repair process.

Reduced UI (/qr): Repairs the application with a reduced user interface and a modal dialog box
displayed at the end of the repair process.

Basic UI (/qb): Repairs the application with a basic user interface consisting of a progress bar. The
following settings are available with this option:

+ No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed
at the end of the repair process.

¢+ Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at
the end of the repair process.

¢ Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user
cannot cancel the repair process.

Repair Options
In the Repair Parameters dialog box, select the desired Repair options:

Missing File (p): Instructs Windows Installer to repair a file only if it is missing.
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Older File (0): Instructs Windows Installer to repair a file if it is missing or if the installed file’s
version is older than the file in the MSI package.

Equal or Older File (e): Instructs Windows Installer to repair a file if it is missing or if the installed
file’s version is the same as or older than the file in the MSI package.

Different File Version (d): Instructs Windows Installer to repair a file if it is missing or if the installed
file’s version is not exactly the same as the file in the MSI package.

Force All (a): Instructs Windows Installer to repair all files.

User Registration Keys (u): Instructs Windows Installer to repair all per-user entries from the MSI
package to the Windows system registry. Per-user entries are those entries contained in the
HKEY CURRENT USER and HKEY_ USERS registry hives.

Computer Registry Keys (m): Instructs Windows Installer to repair all per-machine entries from the
MSI package to the Windows system registry. Per-machine entries are those entries contained in the
HKEY LOCAL MACHINE and HKEY CLASSES_ROOT registry hives.

Failed Checksum (c): Instructs Windows Installer to perform a checksum on all executable files and
to repair a file if it is missing or if the checksum verifies that the file is corrupt. Only files that have
msidbFileAttributesChecksumin the Attributes column of the MSI package’s File Table are
repaired.

Install and Re-Cache (v): Instructs Windows Installer to repair files from the re-cache (local) source
rather than the source package.

Shortcut(s): Instructs Windows Installer to repair the MSI application’s shortcuts, overwriting any
existing shortcuts and icons.

Command Line Parameters

Displays the command line parameters used during the application’s repair process. As you select
the Restart, Display, and Repair options, the command line parameters in this field are automatically
populated.
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Authentication Hook

An authentication hook enables you to control the installation or launching of the bundle.

Create an executable file containing your authentication logic and begin its name with authhook. For
example, authhookinstall.exe. During the installation or launching of the bundle, the bundle
manager searches for a file matching authhook*.* in the bin directory of ZENworks. If the file is
found, the bundle manager passes four arguments: zone name, bundle ID, bundle name, and
username of the current bundle to the file. On execution, the file returns a code. The bundle manager
installs or launches the bundle only if the returned error code matches 264.

Authentication Hook 231
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How Bundle Versions Affect an
Install Action Set

Bundle Change Management results in a change in the behavior of the Install action set on a device if
the install frequency option of the action set is configured either to install once per device or install
once per user per device.

¢ Section C.1, “Triggers that Cause an Install Action Set to Run,” on page 233

¢ Section C.2, “Sample Scenario,” on page 233

¢ Section C.3, “Additional Scenarios,” on page 234

Triggers that Cause an Install Action Set to Run

If you assign a bundle to a device or user, the Install action set runs on the device only in the
following circumstances:
¢ If the Install action set has never run on the device.

+ If the version of the Install action set is different from the version of the Install action set that has
previously run on the device

The Install action set of a bundle is internally associated with a global version identifier and the
Install action set of every bundle version is internally associated with a local version identifier.

If you make any modifications to a bundle other than modifying its Install action set, the Install
action set of the sandbox that is created has the same local version identifier as the bundle
version you modified. However, if you modify the Install action set of a bundle, the global
version identifier of the bundle’s Install action set is incremented by one and the modified Install
action set’s local version identifier is set to the new value of the global version identifier.

If the install action set or its options are modified and the bundle is re-published, then when the
bundle is installed or launched, the install action set is invoked again, even if it has been set to install
only once.

Sample Scenario

For example, consider the following scenario:
1. In ZENworks Control Center, create a bundle (not as a sandbox).

The bundle version, the global version identifier of the bundle’s Install action set, and the local
version identifier of the created bundle version are all set to 0 (zero).
2. In the Install action set of the bundle, add one or more actions and then click Apply.

The global version identifier for the Install action set is incremented to 1.

3. Click Publish to publish the sandbox as version, 1.
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The local version identifier of this published version also changes to 1.

4. Assign the bundle to Device A.

The bundle runs on Device A and the actions in the Install action set of the latest published
version of the bundle, which has the local version identifier set to 1, are executed on the device.

5. Modify the Install action set of the bundle and click Apply.

The global version identifier is incremented to 2.

6. Repeat Step 5 twice more.

The global version identifier is incremented to 4.

7. Click Publish to publish the sandbox as version, 2

The local version identifier of this published version also changes to 4.
8. Assign the bundle to Device B.

The bundle runs on Device B and the actions in the Install action set of the latest published
version of the bundle, which has the local version identifier set to 4, are executed on the device.

Additional Scenarios

Perform the tasks listed in the following table to understand the subsequent behavior of the Install
action set on Device A and Device B. When you begin, Device A has an Install action set with version
1 (see Step 4) and Device B has an Install action set with version 4 (see Step 6) in Section C.2, “Sample

Scenario,” on page 233.

Task

Device A

Device B

Modify the Install action set of the
latest published version to create a
sandbox and then publish the
sandbox.

Starting value of the local version
identifier: 4

New value of the local version
identifier: 5

Modify a property of bundle other
than the Install action set of the
latest published version to create a
sandbox and then publish the
sandbox.

Starting value of the local version
identifier: 4

New value of the local version
identifier: 4

The actions in the Install action set
of the latest published version of
the bundle, which has the local
version identifier set to 5, are
executed on the device.

The actions in the Install action set
of the latest published version of
the bundle, which has the local
version identifier set to 4, are
executed on the device.

The actions in the Install action set
of the latest published version of the
bundle, which has the local version
identifier set to 5, are executed on
the device.

Because the version of the
previously run Install action set on
the device is the same as the value
of the local version identifier, the
Install action set does not run on the
device.
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Task

Device A

Device B

Create a sandbox from an older
version of the bundle, modify the
Install action set to create a
sandbox, and then publish the
sandbox.

Starting value of the local version
identifier: 4

New value of the local version
identifier: 5

Create a sandbox from an older
version of the bundle, modify a
property of the bundle other than
the Install action set to create a
sandbox, and then publish the
sandbox.

Starting value of the local version
identifier: 4

New value of the local version
identifier: 4

The actions in the Install action set
of the latest published version of
the bundle, which has local version
identifier set to 5, are executed on
the device.

Because the version of the
previously run Install action set on
the device is the same as the value
of the local version identifier, the
Install action set does not run on
the device.

The actions in the Install action set
of the latest published version of the
bundle, which has local version
identifier set as 5, are executed on
the device.

The actions in the Install action set
of the latest published version of the
bundle, which has the local version
identifier set to 1, are executed on
the device.

If a sandbox version of a bundle is assigned to a test device or user, the execution of the Install action
set depends on whether the action set is modified or not. Even though there is no change in the
bundle version, the action set runs on the device if it has been modified.

NOTE: When you have a bundle that references a file on a share and if the file in the share location
has changed, you need to modify the action set in which you are referring the file, if you want the
bundle to be reinstalled with the new file.

How Bundle Versions Affect an Install Action Set
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D.1

D.2

Best Practices

The following sections contain information on the best practices to follow while using the Bundles
component of Novell ZENworks 11 SP3:

¢ Section D.1, “Changing the Look and Feel of the Start Menu on a Windows Vista Device,” on
page 237

¢ Section D.2, “Pinning Applications to the Start Menu on a Windows Vista Device,” on page 237

¢ Section D.3, “Assigning Bundles to a Device or User,” on page 238

¢ Section D.4, “ZENworks Explorer Folder Naming Convention,” on page 238

¢ Section D.5, “Creating Bundles with Large Content,” on page 238

¢ Section D.6, “Enabling the Loading of Application Data in to the Device Memory on Demand,”
on page 238

Changing the Look and Feel of the Start Menu on a
Windows Vista Device

On a Windows Vista device, the folders on the Start menu have a cascading effect. To have the same
look and feel as the Windows XP Start menu:

1. Right-click Start.

2. Click Properties.

3. Select Classic Start Menu.
4. Click OK.

Pinning Applications to the Start Menu on a Windows Vista
Device

On a Windows Vista device, you can choose to have the folders pinned to the Start menu to have the
same look and feel as the pinned folders on the Windows XP Start menu.

Right-click Start.

Click Properties.

Select Classic Start Menu.
Click OK.

Restart the system.

S
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D.3

D.4

D.5

D.6

Assigning Bundles to a Device or User

Do not assign more than two bundles that has the same name to a Windows managed device because
only the first two bundles that are assigned to the device are displayed on the device.

Sample Scenario: Assume that bundles named test, Test, TEST are assigned to a Windows managed
device. The first bundle that is assigned to the device has the specified name. The second bundle that
is assigned to the device has the management zone name appended to the specified name. However,
the third bundle is not displayed on the device.

ZENworks Explorer Folder Naming Convention

If the ZENworks Explorer Folder name for two or more bundles is the same but has a different case,
then only one folder and containing all the bundle's shortcuts is displayed in the start menu and the
ZENworks Explorer window.

Creating Bundles with Large Content

By default, ZENworks Control Center has a 30-minute timeout value. If you choose to create bundles
with a large amount of content, you must change the ZENworks Control Center timeout value as
required. For information on the changing the timeout value for ZENworks Control Center, see
“Changing the Timeout Value for ZENworks Control Center”in the ZENworks 11 SP3 ZENworks
Control Center Reference.

Enabling the Loading of Application Data in to the Device
Memory on Demand

You can choose to enable the loading of application data in to the device memory as and when
required by setting the LoadAppdataIntoMemoryOndemand registry key to true. This helps
significantly on low memory devices:

1 Open the Registry Editor.

2 Goto HKEY LOCAL MACHINE\Software\Novell\ZCM.

3 (Conditional) If the registry key named LoadAppdataIntoMemoryOndemand already exists,
ensure that its value is set to True, else create a String named LoadAppdataIntoMemoryOndemand
and set its value to True.

For more information on the Registry keys used in ZENworks, see the ZENworks 11 SP3 Registry Keys
Reference.
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E Troubleshooting

The following sections explains the scenarios that you might encounter while using the Bundles
component of Novell ZENworks 11.

+ “Unable to locate the active text box in the user interface of ZENWorks Control Center” on
page 240

¢ “Uploading content from a text file that contains extended characters corrupts the content” on
page 240

¢ “While launching applications, the window prompting for user input might not be displayed”
on page 240

¢ “Unable to select a large number of files to upload to the content server while performing the
Install Directory or Install Files action with the Firefox browser” on page 240

¢ “Unable to execute the Install MSI action on a Windows 2000 device” on page 241

¢ “Cannot back up the registry and edit the HKEY_CURRENT_USER by using a single registry
action on a Windows Vista device” on page 241

¢ “The Undo Install Actions fails to uninstall a directory” on page 241
¢ “Unable to launch a RDP session from a 64-bit device” on page 241
¢ “Unable to select an icon with the 64-bit Internet Explorer” on page 242

¢ “If the Wake-on-LAN on the managed device is behind the server’s time zone, the device fails to
wake up” on page 242

¢ “Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7 device taskbar” on
page 242

¢ “Repairing an MSI that is installed on a device might reboot the device even if the norestart
parameter is specified” on page 243

¢ “Unable to install or launch a bundle on a Linux or Macintosh device” on page 243
¢ “Unable to import an exported registry file into the Windows registry” on page 243

¢ “The File Upload plug-in does not upload all of the selected files in Internet Explorer, or the
browser is not responsive after files are uploaded in Firefox” on page 244

¢ “Unable to use the uninstall option for ZENworks bundle in the start screen on a Windows 8
machine” on page 244

¢ “After the upgrade, unable to uninstall a bundle that is set to uninstall prior to upgrade” on
page 244

+ “Novell ZENworks File Upload plug-in might crash while trying to perform advance
operations” on page 245

¢ “Bundle distribution fails when you assign a bundle to be launched during Wake- on - Lan with
date specific - schedule” on page 245

¢ “Unable to create a bundle due to internal data model exception” on page 245

¢ “An error message is displayed while trying to upload files or directories using ZENworks File
Upload plug-in” on page 246
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¢ “Bundle icons are not visible on the desktop when the desktop folder is redirected to a network
share for agents running on Windows 7 and Windows 2008” on page 246

¢ “Bundle shortcut icon is not visible in the Start Menu of a Windows 7 device” on page 246

¢ “In a rebootless scenario, sometimes NALShell.dll causes Windows Explorer to crash after an
upgrade” on page 247

¢ “On a Windows device, NAL icons are not displayed even after enabling the disabled bundle
management” on page 247

¢ “When a Mac patch policy bundle fails, the xauth messages that are launched are not
terminated” on page 247

¢ “When you select either the Sandbox or an old version of a bundle or policy, the status is not
displayed in the summary page of the bundle or policy” on page 247

Unable to locate the active text box in the user interface of ZENWorks Control
Center

Source: ZENworks 11; Software Distribution.

Explanation: If you use Firefox 2.0 to open ZENworks Control Center, the cursor might fail to
appear in the active text box.

Action: Use Internet Explorer.

Uploading content from atext file that contains extended characters corrupts the
content

Source: ZENworks 11; Software Distribution.

Explanation: If you use the Edit Text File action to upload a text file containing extended
characters, the content is corrupted.

Action: Open the text file, save it as UTF-8, then upload the file.

While launching applications, the window prompting for user input might not be
displayed
Source: ZENworks 11; Software Distribution.

Explanation: If you use bundles to launch applications that require user input, the window
prompting for the input might be hidden behind the application. This problem
might occur if the applications are launched for the first time for each user login.

Action: If you want to immediately view the window, minimize the application. To fix
the problem, restart the system.

Unable to select a large number of files to upload to the content server while
performing the Install Directory or Install Files action with the Firefox browser
Source: ZENworks 11; Software Distribution.

Explanation: You cannot select a large number of files to upload to the content server while
performing the Install Directory or Install Files action with the Firefox browser.

Action: Upload a smaller number of files with the Firefox browser, or use the Internet
Explorer browser to perform the action.
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Unable to execute the Install MSI action on a Windows 2000 device

Source: ZENworks 11; Software Distribution.

Explanation: If Grant administrator privilege to user during installation is selected in the Install
MSI dialog box to provide administrator privileges to the logged in user, the user
is prompted to provide the log in credentials when the Install MSI action is
executed on the device. The action fails to execute even if the user has provided
the correct password.

Action: Add the user as a part of the operating system as follows:

1 Run MMC.
2 Click File > Add/Remove Snap-in, click Add.

3 In the Add Standalone Snap-in dialog box, select Group Policy Object Editor,
click Add > Finish.

4 Click Close to close the Add Standalone Snap-in dialog box.
5 Click OK.

6 In the Console Root window, double-click Computer Configuration > Windows
Settings > Security Settings > Local Policies > User Rights Assignment > Act as
part of the operating system

7 Click Add User or Group.
8 In Enter the object names to select, specify the user name. Click OK.
9 Click OK.

Cannot back up the registry and edit the HKEY_CURRENT_USER by using a
single registry action on a Windows Vista device

Source: ZENworks 11; Software Distribution.

Explanation: If you set up an action to both back up the registry and edit the
HKEY_CURRENT_USER registry entry on Windows Vista®, the action fails
because all user-initiated processes in Vista run as the lowest privileged user.

Action: Use two different registry actions, one to back up the registry in the system
context, and another to edit HKEY_CURRENT _USER in the user context.

The Undo Install Actions fails to uninstall a directory

Source: ZENworks 11; Software Distribution.

Explanation: When you create an Install Directory File bundle, the directory is installed even
if its name contains spaces; however, it cannot currently be uninstalled by using
the Undo Install Actions action.

Action: Avoid spaces in directory names if you want to enable the uninstallation of that
directory.

Unable to launch a RDP session from a 64-bit device

Source: ZENworks 11; Software Distribution.

Explanation: If you launch a Launch Windows Thin Client Application action configured with
the RDP Session on a 64-bit managed device, the action might fail.
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Action:

Apply the KB925876 patch (http://support.microsoft.com/kb/925876).

Unable to select an icon with the 64-bit Internet Explorer

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

If you use the 64-bit Internet Explorer to launch ZENworks Control Center, then
click the browse icon to browse to and select an icon from the icon resources
such as an .exe, .dll, or .ico file, one of the icons from the resource file is selected
by default. You cannot select any other icon.

Use the 32-bit Internet Explorer to launch ZENworks Control Center.

If the Wake-on-LAN on the managed device is behind the server’s time zone, the
device fails to wake up

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

If a bundle having the distribution configured is assigned to a managed device
such that the Wake-on-LAN is behind the server’s time zone, the device fails to
wake up.

Ensure that the Wake-on-LAN on the managed device is not behind the server’s
time zone.

Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7

device taskbar

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

If you assign a bundle to a Windows 7 managed device and choose to place the

bundle shortcut icon in the Quick Launch area of the device, the bundle shortcut
icon is not visible because Quick Launch is disabled by default on a Windows 7
device.

To enable Quick Launch on a Windows 7 device taskbar:

1 Right-click the taskbar and click Toolbars.
2 Click New Toolbar to open the New Toolbar window.

3 In the Folder option, specify the following:
$UserProfile%\AppData\Roaming\Microsoft\Internet
Explorer\Quick Launch.

4 Click Select Folder.
To customize Quick Launch on a Windows 7 device taskbar:

1 Right-click the taskbar and deselect Lock the Taskbar.

2 (Optional) Click and drag the Quick Launch to the desired position on the
taskbar.

3 Right-click Quick Launch and deselect Show Title and Show Text to disable
title or text display.

4 Right-click Quick Launch. Click View > Small Icons to enable small icons.
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Repairing an MSI that is installed on a device might reboot the device even if the
norestart parameter is specified

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

If you run the Install MSI action to repair an MSI that has already been installed
on a device, the device might reboot. This is because /£ option that repairs a
product can reboot the device. For more information, see Microsoft Support Site
(http://support.microsoft.com/kb/961883/EN-US).

Perform the following steps to repair a package without a reboot:

1 In ZENworks Control Center, click the MSI Application Bundle you want to
repair.

2 Click Actions > Install.

3 Click the Install MSI action to display the Edit Action - Install MSI dialog
box.

4 1In the Repair Parameters option, Click [& to display the Repair Parameters
dialog box.

5 In the Command Line Parameters option, specify /i instead of /£, then click
OK.

6 In the MSI Properties panel, add the following properties:
* Name = REINSTALLMODE ; Value = omus
¢ Name = REBOOT ; Value = ReallySupress

7 Click OK.

Unable to install or launch a bundle on a Linux or Macintosh device

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

On a Linux or Macintosh device, if you choose to run the zac command to install
or launch a bundle that has special characters such as @ or $ in its name, the
bundle fails to install or launch on the device.

Run the zac command and use \ \ to escape the special characters in the bundle
name. For example, to install a bundle named mac@, run the command as
follows:

zac bin mac\\@

Unable to import an exported registry file into the Windows registry

Source:

Explanation:

Action:

ZENworks 11; Software Distribution.

On platforms that use non-Western European languages, a registry file exported
by using the ZENworks Registry Edit action might contain values that prevent
the registry file from being imported into the Windows registry.

To export the registry file:
1 In ZENworks Control Center, click a bundle.

2 Click Actions > Registry Edit.
3 Click Export to export the registry file.
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To import the registry file into the Windows registry:

1 Edit the exported registry file to remove values such as £ff£fEfEEFEEFEDO
from the file.

2 Import the file into the Windows registry.

3 Use the Windows Regedit utility to reenter the values that you removed in
Step 1.

For more information on reentering the values, refer to the Registry Edit
Action page of ZENworks Control Center.

The File Upload plug-in does not upload all of the selected files in Internet
Explorer, or the browser is not responsive after files are uploaded in Firefox

Source: ZENworks 11; Software Distribution.

Explanation: When you use the Novell File Upload plug-in to upload multiple files, if a file
name exceeds the maximum limit supported by the browser or the operating
system, the following issues might arise:

¢ Internet Explorer: The long filenames are truncated and some of the files are
not uploaded.

¢ Firefox: The browser becomes un-responsive.

Action: Upload the files in smaller batches using the Novell File Upload plugin.

Unable to use the uninstall option for ZENworks bundle in the start screen on a
Windows 8 machine

Source: ZENworks 11; Software Distribution.

Explanation: On a Windows 8 machine if you right click on the ZENworks bundle shortcut
and choose the uninstall option in the charms bar, the ZENworks bundle
shortcut fails to point at the underlying application or ms1i installer in the add
remove screen of the control panel.

Possible Cause: The uninstall option that is in the charms bar of the start screen on a Windows 8
machine is not supported for ZENworks bundle.

Action: Won't fix.

After the upgrade, unable to uninstall a bundle that is set to uninstall prior to
upgrade

Source: ZENworks 11; Software Distribution.

Explanation: If you have set a bundle to uninstall on unassignment, and after the upgrade the
bundle is unassigned, the bundle might not get uninstalled.

Possible Cause: After the upgrade only the new cache entries are referenced. The old cache
entries of the unassigned items are not referenced.

Action: Won't fix.
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Novell ZENworks File Upload plug-in might crash while trying to perform
advance operations

Source:

Explanation:

Possible Cause:

Action:

ZENworks 11; Software Distribution.

Novell ZENworks File Upload plug-in might crash if it tries to perform advance
operations like third-party imaging support, large file upload, directory upload,
and so on. When the plug-in tries, the operations might be interrupted by a
browser through a warning message because these operations require more time
to complete the task.

The absence of required browser settings configuration.
To avoid this, configure the following settings for the browser:
dom.ipc.plugins.enabled.npZENworksFileUploadPlugin.dll = false

dom.ipc.plugins.timeoutSecs = 300

dom.max script run time =300

NOTE: If the problem continues even after configuring the above browser
settings, increase the time value for the following and try again:

dom.ipc.plugins.timeoutSecs = 300

dom.max_script_run time =300

Bundle distribution fails when you assign a bundle to be launched during Wake-
on - Lan with date specific - schedule

Source:

Explanation:

Possible Cause:

Action:

ZENworks 11; Software Distribution.

When you assign a bundle to be launched on a device during Wake-on-Lan
(WOL) with the date-specific schedule, the contents of the bundle are not
distributed.

By the time the device wakes up (based on the Wake-on-LAN schedule) and
receives the bundle assignment, the scheduled distribution time has passed, so
the bundle is not distributed on the device. The primary cause of this issue is
setting the same time for both the Wake-on-Lan schedule and the bundle
distribution schedule.

When assigning bundles to Wake-on-Lan devices, if you select a Schedule Type
of Date Specific, you also need to enable the Process immediately if device unable to
execute on schedule option. This option forces the bundle distribution to occur
after the device wakes and receives the bundle distribution schedule.

Unable to create a bundle due to internal data model exception

Source:

Explanation:

ZENworks 11; Software Distribution.

When you try to create a bundle or any ZENworks object, the bundle or object
throws the following data model exception:

com.novell.zenworks.datamodel .exceptions.InternalDataModelExcepti
on: org.hibernate.QueryTimeoutException: ORA-01658: unable to
create INITIAL extent for segment in tablespace CCT XA TAB
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Possible Cause: This failure is because the allocated file size for the data file is used and has
exceeded.

Action: Increase the tablespace to ensure sufficient disk space availability for data files in
the tablespace.

An error message is displayed while trying to upload files or directories using
ZENworks File Upload plug-in

Source: ZENworks 11; Software Distribution.

Explanation: When you start uploading files or directories using ZENworks File Upload plug-
in, an error message is displayed.

Action: Stop the agent and try uploading again.

Bundle icons are not visible on the desktop when the desktop folder is redirected
to a network share for agents running on Windows 7 and Windows 2008

Source: ZENworks 11; Software Distribution.

Explanation: When the desktop folder for a ZENworks Configuration Management Agent
running on Windows 7 or Windows 2008 is redirected to a network share, the
shortcut icons for ZENworks Configuration Management bundles do not

appear.

Action: To create the shortcut icons for bundles:

1 Open the Registry Editor.
2 Go to HKLM\Software\Novell\ZCM\NAL.
3 Create a DWORD called SetIconOnDesktop and set the value to 1.

4 Reboot the workstation.

Bundle shortcut icon is not visible in the Start Menu of a Windows 7 device

Source: ZENworks 11; Software Distribution.

Explanation: After assigning a bundle to a Windows 7 managed device, if you choose to place
the bundle shortcut icon in the Start Menu of the device, the bundle shortcut icon
is not visible.

Possible Cause: The Remove User's folders from the Start Menu GPO setting is enforced on a
Windows 7 device.

Action: Disable the Remove User's folders from the Start Menu GPO setting on a Windows 7
device:

1 Run gpedit.msc

2 Click User Configuration > Administrative Templates > Start Menu and Task Bar.
3 Double click Remove user'’s folders from the Start Menu.

4 In the Remove User’s folders from the Start Menu dialog, select Disabled.

5 Click Apply > OK.
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In arebootless scenario, sometimes NALShell.dll causes Windows Explorer to
crash after an upgrade

Source: ZENworks 11; Software Distribution.

Explanation: When you apply a system update to a Windows device from ZENworks11.2.x to
11.3 in the rebootless scenario, Windows Explorer sometimes crashes and
ZENworks 7 icons appear in place of bundle icons after the upgrade.

Possible Cause: Nalshell.dll is the cause of this crash.

Action: To avoid a crash from recurring and to make the bundle shortcuts show the right
icons:

1 Restart Windows Explorer.
2 Log off and then log in to the device again.

On a Windows device, NAL icons are not displayed even after enabling the
disabled bundle management

Source: ZENworks 11; Software Distribution.

Explanation: If you log in to a Windows device for which bundle management is disabled, the
NAL explorer shell extension (NalShell.dll) that is required for enabling
bundle explorer icons is not loaded by Windows Explorer. As a result, even if
you enable bundle management on the device, the NAL explorer icons do not
get enabled.

Possible Cause: NAL explorer shell extension (NalShell.dl1l) is not loaded by Windows
Explorer.

Action: To restart the explorer.exe, which loads Nalshell.dll, logoff, and then log in
to the workstation again.

When a Mac patch policy bundle fails, the xauth messages that are launched are
not terminated

Source: ZENworks 11; Discovery, Deployment, and Retirement

Explanation: If you launch a Mac patch policy bundle several times, the policy fails each time
with a pop-up message to install xauth. These xauth messages are not
terminated even after the bundle error messages disappear. This is because X11
is no longer included as a default install, starting with OS X Mountain Lion
10.8.3.

Action: Before upgrading a ZENworks agent to an OS X Mountain Lion 10.8.3 (or later)
device, or before installing ZENworks agent on an OS X Mountain Lion 10.8.3
(or later) device, you need to install the X11 application.

When you select either the Sandbox or an old version of a bundle or policy, the
status is not displayed in the summary page of the bundle or policy

Source: ZENworks 11; Discovery, Deployment, and Retirement
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Explanation: After assigning a bundle that has the sandbox and the published versions to a
device, if you select either an old version or a sandbox version of the bundle, the
Bundle Status information is not displayed in the summary page of the bundle or
policy.

Action: There is no workaround.
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F1

F1.1

Novell ZENworks File Upload Plug-
N

The software included with a bundle is uploaded to the ZENworks Server repository. This enables
the ZENworks Server and ZENworks Adaptive Agent to distribute the software without requiring
access to any other network locations. This process is made easier with the ZENworks File Upload
plug-in. If you have not installed this plug-in on your device, you need to install it before you can
browse for file paths and upload files.

After installing the Novell ZENworks File Upload plug-in, you do not need to perform this
procedure again on this device to upload files. However, an update to the Novell ZENworks File
Upload plug-in, in the subsequent release requires you to reinstall them on the device. For more
information, see Section F.3, “Reinstalling the Novell ZENworks File Upload plug-in,” on page 252.

NOTE: You can use only a 32- bit browser to install Novell ZENworks File Upload plug-in on a
device. This plug-in is not supported for 64-bit browsers.

¢ Section F.1, “Installing the Novell ZENworks File Upload Plug-in,” on page 249
¢ Section F.2, “Uninstalling the Novell ZENworks File Upload plug-in,” on page 252
¢ Section F.3, “Reinstalling the Novell ZENworks File Upload plug-in,” on page 252

Installing the Novell ZENworks File Upload Plug-in

The Novell ZENworks File Upload plug-in must be installed on the device before you can browse for
file paths and upload files.

¢ Section F.1.1, “On Windows Devices,” on page 249

¢ Section F.1.2, “On Linux Devices,” on page 250

¢ Section F.1.3, “Supported Features,” on page 250

¢ Section F.1.4, “Browser Configurations,” on page 250

On Windows Devices

To install the Novell ZENworks File Upload plug-in:

1 Click Install Novell ZENworks File Upload plug-in. A pop-up displays the following message:

Do you want to continue downloading and Installing the Novell ZENworks File
Upload plug-in? For the plug-in to work, restart the browser after
Installation.

2 Click OK.
3 Click Save file to save the ZENworks File Upload Plug-in.msi file.
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4 Click OK.
5 Click Install Now, then restart the Web browser.

6 Perform the required browser configuration. For details, see Browser Configurations (page 250).

F.1.2 On Linux Devices

Perform Stepl and Step 2 in the On Windows Devices section.

Click Save file to save the novell zenworks fileupload plugin.rpm file.
Click Continue Anyway.

Click Install to install the rpm file.

a b~ W N P

In the Authentication pop-up, enter the password for root.

NOTE: On Linux devices, only the root user can install the plug-ins.

6 Click Authenticate.
7 Browse for the installed rpm file, then click OK.

8 Perform the required browser configuration. For details, see Browser Configurations (page 250).

NOTE: Close and open all browsers after installing the Novell ZENworks File Upload plug-in. This
is applicable for both Linux and Windows devices.

F.1.3 Supported Features

Novell ZENworks File Upload plug-in supports the following features:

On Linux Devices
+ Install Files
¢ Install Directory
On Windows Devices

¢ Install Directory
Install Files

*

*

Icon Extraction

*

MSI Properties Extraction

*

Third Party Imaging support

For details about third party imaging, see the “ZENworks 11 SP3 Preboot Services and Imaging
Reference.”

F.1.4 Browser Configurations

This section provides browser-specific information:
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Firefox

Configure the following settings for the browser to allow the Novell ZENworks File Upload Plug-in
to perform advance operations such as third party imaging support, large file upload, and directory
upload:

dom.ipc.plugins.enabled.npZENworksFileUploadPlugin.dll = false
dom.ipc.plugins.timeoutSecs = 300
dom.max script_run time =300

dom.ipc.plugins.enabled = false

NOTE: Without the browser settings listed above, the Novell ZENworks File Upload plug-in might
crash. For more information, see mozillaZine (http://kb.mozillazine.org/Plugin-container_and_out-
of-process_plugins.) The dom.ipc.plugins.enabled.npZENworksFileUploadPlugin.dll = false setting
is not applicable for Linux devices.

Adding or Modifying Configuration Settings
To add or modify the configuration settings of the Novell ZENworks File Upload Plug-in:

1 Open Firefox, then type about : config in the address bar. The following warning message is
displayed:

Changing these advanced settings can be harmful to the stability, security and
performance of this application.You should only continue if you are sure of
what you are doing.

2 Click I'll be careful, I promise.

3 Type in one of the following Firefox browser settings in the search bar:
dom. ipc.plugins.enabled.npZENworksFileUploadPlugin.dll
dom. ipc.plugins.timeoutSecs
dom.max_ script run_time

If one of the settings listed above is available, modify the required value for the same. If it is not
found, add them.

NOTE: Increase the time value of the following to perform imaging operations or if the performance
of the PC is low:

dom. ipc.plugins.timeoutSecs

dom.max script run time

Microsoft Internet Explorer

The Novell ZENworks File Upload Plug-in will not work for Microsoft Internet Explorer 9 and later
versions if there is no proper ActiveX filtering and third- party plug-in setting.

To enable the Novell ZENworks File Upload Plug-in to work in Internet Explorer:

1 Go to Tools, then uncheck ActiveX Filtering if it is enabled.
2 Click Internet Options.
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F.2

F2.1

F.2.2

F.3

3 Click the Advanced tab

4 Under Browsing, check Enable third-party browser extension.

Uninstalling the Novell ZENworks File Upload plug-in

To uninstall the Novell ZENworks File Upload plug-in:

¢ Section F.2.1, “On Windows,” on page 252
¢ Section F.2.2, “On Linux,” on page 252

On Windows

1. Go to Control Panel
2. Click Uninstall a program.

3. Right- click Novell ZENworks file upload plug-in, then click Uninstall.

On Linux
1. Log in as root.
2. Open the console, then type the following command:

rpm -e novell-zenworks-fileupload-plugin

Reinstalling the Novell ZENworks File Upload plug-in

To update the Novell ZENworks File Upload plug-in that is already installed on the device that is
running in ZENworks Control Center:

1 Uninstall the Novell ZENworks File Upload plug-in.

For more information, see Section F.2, “Uninstalling the Novell ZENworks File Upload plug-in,’
on page 252.

7

2 Install the File Upload plug-in. You are prompted to install the latest Novell ZENworks File
Upload plug-in the next time you use ZENworks Control Center to browse for file paths and
upload files. Follow the prompts to install the Novell ZENworks File Upload plug-in. For more
information, see Section F.1, “Installing the Novell ZENworks File Upload Plug-in,” on
page 249.
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Documentation Updates

This section summarizes the significant changes made to the Software Distribution Reference since the
initial release of ZENworks 11 SP3.

July 2014: System Update (11.3.1) for ZENworks 11SP3

Location Change

Section 6.21, “Action - Launch Added a note for the Environment Variables about using a new

Executable,” on page 117 predefined variable (ZENPREDEF REDIRCTSTANDARDOUTPUT) to
redirect the standard output of a variable to a location you specify.

Section 9.1, “Assigning Existing Added a note to clarify how the Launch Schedule interacts with the If

Bundles to Devices,” on page 179 Install Immediately after Distribution and Launch Immediately after

Installation options.

Section 9.5, “Copying the Relationships Added this section to explain how to copy the Bundles, Policies and
of a Device to Other Devices, Folders, Group relationships of a device to other devices, folders, and groups.
and Groups,” on page 190

Section 10.1.1, “Filter Conditions,” on  For the Registry Key Value filter condition, included information about
page 193 a new IP Address value that can be used.
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